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Autodesk Revit Architecture as one of BIM applications has shown recent improvements in
creating complex forms in conceptual design phase. These improvements have been published
lately in reports (Autodesk 2010; Autodesk 2009) and books (Krygiel et al. 2010). The presented
abilities were introduced within a general scope, and they were not examined in detail with
various generative design approaches. The generalization and the ambiguity of these publications
lead designers to avoid using Revit in conceptual design phase, and use other 3D modeling
softwares that are more compatible with their way of thinking. This thesis examines the abilities
and limitations of this application in a particular design approach called Generative Geometric
Design Approach (GGDA). This approach depends on the creation of geometric shapes as a
generator in the conceptual design phase.

The awareness of these abilities and limitations in achieving GGDA renders the reliability of
Revit for designers who use that approach, and provides the architectural educational systems
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with an overview about the software. Additionally, the knowledge of Revit's limitations will
contribute to the development of the software in future versions (Odeh and Adwan 2009, 1067;
Fadezean 1999, 503).

The appropriate methodology for this examination is dependent on a multi-method tactic. The
multi-method tactic is divided to: main method and confirmation method. They depend on a
series of experiments that are conducted by the author in the main method, and by a number of
students in the confirmation method.

Conclusively, the examination has shown that Revit Architecture has abilities and limitations in
working on the first stage of GGDA, which makes it premature to depend on it entirely.
Otherwise, it is recommended for the future studies about the compability of BIM applications
with generative design approaches to avoid the limitations of this research and the experiments,
and evaluate Revit Architecture in creating more complex geometries.
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Chapter 1. Introduction

Autodesk Revit Architecture is one of a range of BIM applications available today. It is
considered the most used and popular BIM tool in the Architecture, Engineering and
Construction (AEC) industry in the U.S (Eastman et al. 2008, 57). It has been used
widely since its appearance in 2002 by Autodesk Company (Eastman et al. 2008, 57). In
its latest versions, Revit shows improvements (Autodesk 2010; Autodesk 2009) in design
thinking at the conceptual design phase. These improvements are demonstrated through
Autodesk reports (Autodesk 2007), training books (Krygiel et al. 2010), and YouTube
videos1. These publications and materials present new abilities of Revit, and focus on
creating more complex forms that were difficult and even impossible in previous
versions.

However, Revit's interface and modeler are still ambiguous and unclear, because the new
modeling abilities are usually presented in a general way that studies them slightly in
terms of their compability with different ways of thinking of the designers and their
generative design approaches. The fact that the generative design process is a
"subjective" process (Groat and Wang 2002, 104) and has no defined rules or boundaries;
leads each designer to follow his/her own approach (Abdelhameed 2004, 91). Designers
usually choose approaches that suit their architectural background, design program, and
personal knowledge (Abdelhameed 2004, 92). Thus, designers tend to use softwares that
suit their generative design approaches. This thesis explores and evaluates more about the
1

YouTube. http://www.youtube.com/
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abilities and limitations of Revit in the conceptual design phase specifically within in an
approach called Generative Geometric Design Approach (GGDA). This examination
attempts to clarify part of the ambiguity about Revit by presenting its suitability with this
approach, and investigates its reliability.

The understanding of the abilities and limitations of Revit Architecture by designers who
use GGDA provides them with the fact about the compability of the software with their
approach in conceptualizing their geometric design ideas. This fact helps them to decide
their use of Revit in the conceptual design phase. The use of Revit in the conceptual
design phase has a significant impact on the work flow of the design process. The
workflow will be accelerated and be more efficient, if these designers use Revit in all
design phases without interruption. In this case, they will avoid the process of importing
and exporting files and models from other 3D modeling softwares. The process of
importing and exporting files may cause technical difficulties and impair developments,
if designers decided to make modifications in the design concept at advanced stages of
the design process. As a result, the workflow will be interrupted, which could negatively
affect the timetable of the project (Autodesk 2007, 1).

In addition, this study is considered to be an extension of previous academic studies
about BIM. There are few academic studies have addressed the feasibility of BIM
applications in the conceptual design phase, and most of recent studies have evaluated
BIM applications in certain design phases including: information gathering, preparation
of documents and schedules, collaboration, budget (Avila 2009), and structural
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integration (Meadati 2007). For instance, a Master student in California Polytechnic State
University (Avila 2009) studied the benefits of BIM in the programming and in the
conceptual design phase. The study focused on specific stages in the design process;
gathering information, preparing design program, timetable, and detailed drawings,
whereas it disregarded the stage of conceiving the design concept. This research
concentrates on the conceptual design phase by studying the compatibility of Revit with
the generative design approach GGDA.

1.1. Generative Geometric Design Approach (GGDA)
GGDA is a design method in the conceptual design phase. It is adopted by some
designers and architects to generate the design concept. Generative design approaches in
the conceptual design phase are subjective and intuitive processes: they have no rules or
boundaries to define them accurately. GGDA is a technique with the same merit.
Therefore, this technique has to be defined precisely to proceed with propositional
components of Research Activity (Groat and Wang 2002, 105). As a result, GGDA is
classified with three main stages (Mallasi 2007, 708-710): that rely mainly on the initial
shapes and geometries, to conceive the design concept. The following few points discuss
the three key stages of this approach:

1. Initial Geometry Preparation (IGP) stage: (Mallasi 2007, 708) As a start point of
GGDA, the designer in this stage converts his/her idea or sketch to basic or complicated
geometry. He/she begins the configuration of the design concept with 2D shape or 3D
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geometry, whether it was sketched previously or not yet conceived. Figure 1 shows the
creation process of tetrahedron geometry in Revit Architecture by the author. To create
tetrahedron in Revit, the geometry was abstracted to three prism geometries.

Figure 1: Starting with prism geometry as a step in creating tetrahedron geometry.

2. Geometry Configuration and Transformation (GCT) stage: (Mallasi 2007, 709-710)
The primary form is developed in that stage. This development process varies upon the
goal of the designer. In that development process, a number of CAD operations could be
applied on the basic form to develop it. These operations include; Boolean operations
(union, subtraction...), Editing operations (cloning, rotation...), NURBS operations
(editing control points), and different other operations: they are provided in the design
software. At the end of this stage, a clear and interpreted form of the concept is obtained.
Figure 2 illustrates the experiment of creating tetrahedron geometry in the second stage
of GGDA. Three identical prisms were developed to three pyramids in the first stage. At
last, these three pyramids were joined to create the tetrahedron.
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Figure 2: Developing the prism geometry to a quarter of tetrahedron.

3. Final Form Recognizability (FFR) stage: (Mallasi 2007, 710) In this stage, designers
transform the design form to a real building. In this transformation, designers add
different components in BIM application to the forms. These components include walls,
windows, curtain walls, floors, ceiling, and so on. The components differ upon the used
BIM application. Figure 3 presents the result of the transformation process of tetrahedron
geometry to a real building in Revit Architecture.

Figure 3: Applying Revit's components on tetrahedron to transform it to a real building.

6

1.1.1. Architects used GGDA
This section introduces examples of architects who used GGDA in some of their design
projects. These architects include Peter Eisenman and Bruce Goff.

1.1.1.1. Peter Eisenman
This approach has been used by well-known architects in creating the design concepts of
some of their buildings. Peter Eisenman followed that approach in designing Aronoff
Center of Design and Arts in University of Cincinnati in 1989. He used two shapes to
configure the mass of that building; a segmented rectangular and a zigzag as shown in
Figure 4. The last shape was derived from the pre -existing building. He applied several
editing operations on these two geometries, such as; torquing, overlapping and oscillating
operation (Jencks 1997, 172). This process helped the designer to achieve a remarkable
form.

Figure 4: Eisenman used initial shapes in conceiving the design concept form (Jencks 1997, 170).
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1.1.1.2. Bruce Goff
Self-similarity concept in mathematics depends on fractals as its generative basic
principle. Fractals originate from nature (Jencks 1997, 43). The essential units of their
compositions are initial 2D shapes. Bruce Goff achieved the self-similarity in his projects
before the emergence of this concept. His design of Joe Price Studio in 1956 is a good
example of this achievement. The design concept of Studio’s building consists of various
initial shapes; triangulars, hexagons, and trihexes (Jencks 1997, 42-44). They were
copied and linked mathematically, which helped the architect to generate a creative and
novel idea for his time as illustrated in Figure 5.

Figure 5: Joe Price Studio, Oklahoma, 1956 (Jenkes 1997, 42).
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1.2. Why Revit Architecture?
Several BIM applications are available today, and they are used broadly in AEC industry.
Each application has its own advantages and disadvantages. No design application is free
of defects and has the full options to accomplish all the design objectives (Eastman et al.
2008, 14).

The table in Appendix A presents a comparison between most popular BIM applications
at the present: Autodesk Revit, Bentely, ArchiCAD, Digital Project, AutoCAD, AllPlan,
and DProfiler. This comparison reviews the fundamental properties and features for each
application (Devon et al.2007, 229). It also presents the main advantages and
disadvantages of each software. The goal of this comparison is to clarify the reasons of
choosing Revit Architecture among these BIM applications to be studied in that thesis.

It is noted that each of the comparative application has its advantages and disadvantages.
However, conceptual massing abilities are the notable features in this table because these
abilities apply most directly to GGDA. According to the comparison, Bentley and Digital
Project applications have powerful abilities in creating complex forms and geometries.
Bentley has the similar design powers of creating forms as Sketchup has (Khemlani
2009), while Digital Project is being used by Frank Gehry in creating his organic
buildings (Eastman et al. 2008, 60). It is the same case with Allplan application which
has a considerable capacity of creating organic shapes (Khemlani 2008) since its previous
versions, whereas DProfiler has limitations in spite of its equivalent power with Sketchup
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in 3D modeling method (Khemlani 2008). On another hand, Revit (Eastman et al. 2008,
58) and ArchiCAD (Khemlani 2009) have limited abilities in creating complex
geometries among the other BIM applications, even though the massing tools and
methods of Revit have been enhanced recently(Krygiel et al. 2010).

Although both Revit and ArchiCAD have limitations in creating complex forms, Revit
Architecture was chosen as the main topic for this thesis for the following reasons:

1. According to a survey was conducted in 2010 (Ben Lashihar 2010, 4), Revit is has
shown to be the most used BIM application among the students of both
architecture and interior design departments in the University of NebraskaLincoln (UNL) as shown in Chart 1.

Architecture Student

Interior Design student

Chart 1: The results of the survey: "What is your favorite software?" for UNL's students and faculty
members (Ben Lashihar 2010, 4).
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2. Revit is considered the current market leader and the most used BIM application
in the U.S industry (Becerik-Gerber and Rice 2010, 191). Chart 1 and Chart 2
provides the final statistics of the most used BIM application in U.S industry.

Chart 2: Shows the most used BIM applications in U.S industry in 2010
(Becerik-Gerber and Rice 2010, 191).

Chart 3: Shows the most used BIM applications by registered subscribers
of AECbytes in 2007 (Khemlani 2007).
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3. Some firms and designers, who adopted Revit in their design process, still believe
that Revit Architecture has limitations in creating complex forms. Therefore, they
use other 3D modeling softwares in creating the design concept.

4. Preliminary geometric forms still dominate most of the design concepts of several
design projects for well-known firms that work on Autodesk Revit.

12

Chapter 2.

Literature Review

Research papers and reports are published annually about BIM applications. They
demonstrated many benefits of BIM during its use in the design process. The studies
include: Autodesk reports (Autodesk 2011; Autodesk 2009; Autodesk 2007), academic
studies (Avila 2009; Christenson 2006; Meadati 2007), books (Eastman et al. 2008;
Krygiel et al. 2010), etc. These studies praised the valuable contribution of BIM in terms
of time manner, cost reduction, and error diminishing. Conversely, comprehensive
studies about the effectiveness of BIM applications in the conceptual design phase are
few and rare to find.

In the case of Revit Architecture, recent publications such as the book “Mastering
Autodesk Revit Architecture 2011” (Krygiel et al. 2010), demonstrate the ability in
creating complex geometries. The evaluation in these publications shows the positive side
of Revit in conceptualizing the design ideas. For instance, an Autodesk report claimed
that the new enhancements in Revit support the designers' ways of thinking "Autodesk
Revit Architecture 2010 software works the way architects and designers
think..."(Autodesk 2009). The report has no concrete evidence or objective study to prove
this fact. Therefore, the availability of academic studies that explore the compatibility of
Revit as a design thinking tool, are necessary.
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The main purpose of this thesis is to benefit the users of Revit. It does not aim to profit
the software's makers. The thesis aims to study the feasibility of Revit Architecture by
exploring its abilities and limitations in the conceptual design phase, using GGDA.

The literature review chapter presents previous studies about BIM, Revit and generative
design approaches. These studies include research papers, reports, white papers, and
books. The review of these studies confirms the previous discussion for the need of
detailed studies about the compatibility of Revit with different ways of design thinking.
As well, it illustrates the excessive focus of these studies on the benefits of BIM
applications in particular design phases.

2.1. Studies about Generative Design Approaches
The definition of Generative Geometric Design Approach GGDA in this thesis was
derived from a research paper presented by Zaki Mallasi "Applying Generative Modeling
Procedure to Explore Architectural Forms" (Mallasi 2007). This paper studied a process
of creating design concepts depending on primary shapes and geometries. The paper
showed how primary shapes and geometries can be developed to complex masses
through different editing operations, such as copying, rotating, mirroring, etc. The author
derived the process from a mathematical technique that formulates Spirolateral shapes
(Mallasi 2007, 700). This technique relies on developing initial 2D and 3d shapes as
shown in Figure 6. In addition, the author of this paper developed a computer program
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that is compatible with the process. This program is called ArchiGen, and it is embedded
within ArchiCAD software.
Accordingly, the presented technique and its stages were adopted, and named with
GGDA because Mallasi considered this process as a generative design language in
general. The main goal of this paper also was developing a program called ArchiGen that
can be compatible to this process. The development of this program was probably a result
of prior belief by the author that this process cannot be applied on ArchiCAD. In contrast,
the main goal of this thesis is to apply this process on one of BIM applications which is
Revit Architecture to explore the compability of this software with the approach. In
addition, the methodology of the paper was carried out by the author, and there were no
variables that were analyzed or included to the methodology. Furthermore, the author
classified the used shapes in the methodology to three different categories depending on
the availability of these shapes in ArchiCAD, whereas the classification of the used
geometries in my thesis was depending on the complexity standard.
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Figure 6: The main steps that were configured by Mallasi in creating Spirolateral shapes
(Mallasi 2007, 702).

In 2007, Abdelhameed and Kobayashi (Abdelhameed and Kobayashi 2007) presented a
design approach in conceptual design phase. The approach was called Keep It Simple and
Stupid (KISS) Modeling. This approach depends on a space layout as a basic unit of its
process. According to the author, that approach is simpler than other traditional design
approaches. He stated that KISS Modeling approach follows a technique of one step for
each time period. That technique helps designers to recognize the changes in the form
during modeling. In other approaches, these changes cannot be observed until the end of
the process. In KISS Modeling application, space layouts are saved as KISS files as
shown in Figure 7. Then, they are imported to 3Ds Max to develop them (Abdelhameed
and Kobayashi 2007, 751).
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The process of KISS approach seems simple and similar to GGDA, despite the difference
of using spatial units instead of basic geometries. Additionally, the researcher developed
a system that is compatible with the approach "KISS modeling system" and did not apply
it on existed design softwares. The further goal of introducing this paper is to emphasize
on the diversity of generative design approaches, and to illustrate some examples of
studies about these approaches.

Figure 7: The methodology of KISS modeling approach (Abdelhameed and Kobayashi 2007, 750).

In another study, Boeykens and Nueckermans (2006) introduced a different design
approach in "Improving Design Workflow in Architectural Design Application" paper.
The purpose of this paper is to present an approach that achieves a flexible design
process. Designers in the flexible design process have the ability to transit back and forth
between the design phases easily without obstacles or technical problems.
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The approach works on three main design phases; sketch design, preliminary design, and
construction design phase as displayed in Figure 8. Each of these phases is divided to
three Scale Levels; Masterplan, Block and Space Scale Level (Figure 9). The main
function of the approach is to accomplish a flexible transition between these scales and
phases. Efficient transition provides designers with the ability to make design changes,
whether in the concept phase or in detailed drawing phase. The approach was evaluated
on three BIM applications include: Autodesk Architecture Desktop, ArchiCAD, and
Autodesk Revit. The evaluation proved that the approach cannot be applied to the three
BIM applications easily. The paper concludes that these BIM applications have no
flexibility to work back and forth in the design process. They are only one way design
applications (Boeykens and Nueckermans 2006, 12). The users of these applications
cannot make any design improvement at advanced phases in the design process.
This paper also demonstrates a new design approach that is different from GGDA with its
stages. The goal of Boeykens and Nueckermans is to fund an approach that facilitates the
design process and makes it more flexible. The common point of this study with that
thesis is the process of applying the new design approach on three existed design
softwares which are two of them are BIM applications. "Improving Design Workflow in
Architectural Design Application" paper is equivalent to the thesis in the content and in
the methodology. Therefore, that thesis can be considered an extension study for this
paper by applying a different approach on one of the used BIM applications.
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Figure 8: The possible transitions between phases and Scales (Boeykens and Nueckermans 2006, 11).

Figure 9: The three scale levels that each phase is divided to. (Boeykens and Nueckermans 2006, 11).

2.2. Studies about the benefits of BIM
As mentioned before, several studies have focused on BIM and its benefits. "BIM
Handbook: A Guide to Building Information Modeling" Book (Eastman et al. 2008) is
one of these studies. It includes precious information about BIM; current applications,
benefits, problems, instructions for every disciplines, and case studies at the end of the
book (Eastman et al. 2008, 57, 16, 319).
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The book studied the use of BIM in all design phases, whereas it did not address
completely the problems of BIM applications. Also, it presented the conceptual design
phase briefly, and it does not contain examples of buildings with complicated forms that
were designed by BIM. Most of the case studies in the book have very basic geometric
buildings, except for Beijing National Center (Eastman et al. 2008, 375) which building
was formulated by using Microstation VBA scripts, and Rhino (Eastman et al. 2008,
379). The book could be more informative and valuable if it discussed both positive and
negative aspects of BIM. Concisely, the conceptual phase was not discussed widely in
this book.

"Programming and Conceptual Design using building information modeling
programming"(Avila 2009) is one of the theses that has the same topic. The main
purpose of this thesis was to investigate the benefits of BIM in the programming and the
conceptual design phases. The author focused considerably on the benefits of BIM in
terms of efficient collaboration between the design members, the automatic preparation
of documents and schedules, and the effective analysis of both project's information and
the model. In the author’s review of thesis, the conceptual massing phase was not
examined at all. The main concentration of this thesis was just on the environmental
analysis, cost, and time saving. In addition, the case studies of the thesis were building
with simple forms, which can be easily modeled by BIM applications. If the author of
that thesis analyzed complicated mass buildings in the conceptual design phase, the
results probably will be different.
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SmartMarket report (Young Jr et al. 2009) is another study about BIM. It was prepared
by McGraw-Hill Construction 2009. The report addresses the benefits of BIM in terms of
Return of Investment value (ROI), collaboration, and communication. Furthermore, it
studies the adoption rate of BIM to date. In general the report focuses on evaluating the
benefits and problems of BIM and its effects on ROI value, cost, and budget issues in
order to develop and enhance the productivity in future. The authors used a survey in
which covered industrial professionals and firms. In addition to the survey, they
presented a series of study cases to testify the addressed benefits and problems and their
effects on design members.
The report generally has focused on the certain aspects: ROI, collaboration, and
communication in its study. As mentioned before, the authors concentrated their study on
economic and financial effects of BIM on the projects and on the members of design. In
brief, the report didn't analyze the conceptual design phase. As a consequence, this thesis
will be considered as a complementary study of that report and other similar studies.

A PhD engineering student at the University of Nebraska prepared a dissertation called
"Integration of Construction Process Documents into Building Information Modeling"
(Meadati 2007). The student had raised in his research a problem of BIM that concerns
the structural design phase. The problem is based on the lack integration between the
structural BIM model and the structural documentations. The method that was employed
in this research had achieved the integration. The author developed a 4D as-built in three
BIM applications; Autodesk, Bentley, and ArchiCAD. Then, he scripted a link connects
each of these models to Microsoft Access. That process helped to produce structural
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reports and time schedules for the structure design phase. This dissertation has
contributed effectively in providing a solution for BIM problem in the construction
design phase. Such studies will certainly help to raise the productive level of BIM in the
design process.

2.3. Studies about Revit
The abilities and limitations of Revit were evaluated in a paper (Christenson 2006) by a
faculty member in university of Maryland. The professor employed one of his courses in
the evaluation process. The evaluation focused on the phase of construction
documentation. Therefore, the students of the course are demanded to prepare the
construction details of a simple rectangular building by using Revit. During the
preparation of details, the students are required to submit an evaluation of the observed
abilities and obstacles that they noticed during their working.
In brief, the paper presented a similar topic to that thesis on a different design phase. The
researcher has concluded many benefits and abilities and few limitations of using Revit in
construction documentation phase. It should be noted that the simple form of the course
project has a great role in the results of the evaluation. Revit has shown difficulties
despite the simplicity of the building form, which arise out that question; what the results
will be if the chosen project in that course have more complicated forms? The results
certainly will be different. The students will face greater challenges, and they will have
different their reviews.
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2.4. Projects with Revit Use
2.4.1. Meraas Tower
Meraas Tower project in Dubai is one of the projects that Revit has been used in their
designs. Revit in this project was used in preparing the detailed drawings, whereas
Rhinoceros and Grasshopper were used in creating the conceptual mass (Peronto et al.
2009, 163-164) which has elliptic cone geometry (Figure 10). The question is; why these
firms did not use Revit in creating the mass which has not a high level of complexity?

Figure 10: The workflow that was followed in designing Meraas Tower (Peronto et al. 2009, 165).
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2.4.2. World Trade Center, Tower I
In 2003, SOM firm adopted Revit to use it in the design process of WTC. At first, the
company decided to use Revit only in the analyzing process of the project's site. During
the process of analyzing, designers found that Revit is easy to use, which encouraged
them to design the entire building by Revit (Figure 12). They justified their employment
of Revit in the entire design process that it helped them to design the tower in shorter
time. That benefit persuaded SOM to use Revit in the design process of its future project
(Architectural Transformations via BIM 2009, 52).

Figure 11: The new TWC by SOM firm

Figure 12: The diagram shows the design phases that Revit was

(Architectural Transformations via BIM

used in (Architectural Transformations via BIM 2009, 42).

2009, 45).

The mass of the tower is originated from prism geometry with square base as shown in
Figure 11. The edges of the prism were chamfered (Architectural Transformations via
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BIM 2009, 44). That process led to obtain a mass with a square plan for the first floor, a
triangular plan for the roof floor, and octagonal plans in between. It can be noted, that the
mass was created by using GGDA, and Revit proved its ability to create it.

2.4.3. Lotte Super Tower
Lotte Tower in Korea in Figure 13 is also designed by SOM firm. The building is
expected to be the tallest tower in Asia in 2014 (Architectural Transformations via BIM
2009). In the design process of this project, different design softwares were used to create
the design concept and to analyze it. These softwares include 3Ds Max, Sketchup,
Ecotec, and NavisWorks (see Figure 14). Revit was only employed in the design
development phase, whereas Rhinoceros helped in the transferring process of the mass.

Figure 13: Lotte Tower in Korea by SOM

Figure 14: The diagram shows the design phases that

(Architectural Transformations via BIM

Revit was used in (Architectural Transformations via

2009).

BIM 2009).
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The mass of the building can be formulated using GGDA by editing cone geometry with
some Boolean operations. However, other 3D modeling softwares were used to generate
the mass for non-mentioned reasons.

2.5. Autodesk Reports about Revit Architecture
In a report that was prepared by Autodesk company (Autodesk 2008), five common
fallacies about BIM were addressed and reviewed. One of these fallacies that is related to
the topic of this thesis was the accessibility. Accessibility is considered one of obstacles
that lead design firms to not adopt BIM. The problem lies in the unfamiliarity of BIM
applications by CAD users. CAD users believe that it takes long time to be familiar with
BIM tools, and probably these tools are not compatible with their ways of thinking.
Autodesk stated that Revit, as one of BIM applications, is easy to learn, and it suits all
ways of design thinking. The report cited some case studies for design companies that
found no difficulties in adopting Revit quickly. Martinez + Cutri Corporation is one of
these firms. That firm trained three of its employees to use Revit for two-week session.
That training enabled the company to adopt Revit quickly and work on it in a real project.
The report cited that example to prove that Revit has an easy interface to deal with, which
led Martinez + Curti Corporation to adopt in just two weeks. But, the question is; can that
example be circulated on all other design companies? Do other design companies follow
the same generative design approach that followed by that corporation?
If we analyze the mass of the building that shown in Figure 15 according to GGDA, we
can notice that the mass is consisted of a set of prisms. And if we assume that the
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designers of that project follow GGDA in modeling the mass, and they choose to work on
tetrahedron instead of prism. Will they find Revit that easy to be adopted quickly?

Figure 15: Martinez + Curti's project with BIM (Autodesk 2008, 4).

Another misconception about BIM concerns this research was addressed in that report. It
is about the negative effects of BIM on the workflow of the design process. The report
confirmed by a web survey that 82% of BIM users have no problem with the continuity
of their workflow. Moreover, BIM has contributed significantly in the success of the
workflow of many projects. Glotman-Simpson Company emphasized that BIM played a
significant role in designing the Mixed-use Tower project in San Diego (Figure 16). In
this project, BIM improved the workflow between the designers and the drafters. This
improvement helped in achieving a successful design.
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Figure 16: The mixed-Use Tower by Glotman-Simpson (Autodesk 2008, 5).

The mixed-Use Tower project as the Martinez + Curti project cannot be circulated on all
design firms. The simple forms of these buildings could be resulted easily by using
GGDA. The mass here can be generated from basic prism geometry. But in the case that
the designers chose Octahedron geometry instead of Prism as the basic unit of their
concept, would that affect the workflow more greatly?

In additional report "Build Better World" (Autodesk 2008), Autodesk presented the
abilities of its BIM products by introducing some companies that have successful projects
with BIM. HOK was one of these companies, which is considered one of the largest
design companies in the world that adopted Revit in 2005. The report presented the
history of HOK's adoption of BIM with reviewing a list of its successful projects by
Revit.
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Figure 17: JVC Culture, Convention, and Business Center in

Figure 18: 5 Churchill Place project at

Guadalajara, Mexico. Courtesy of HOK (Autodesk 2008).

Canary Wharf (HOK 2011).

Figure 19: Veterinary Medicine Research Facility at
University of California2. Geometry: prism > simple.

Figure 20: Emory University Psychology
Building (HOK 2011)
Geometry: prism > simple.

Figure 21: Sheraton Ulaanbaatar Hotel, Mongolia (Autodesk

Figure 22: Hailey bury School, Almaty

2008) Geometry: Cuboids + Polyhedron > semi-complicated.

(HOK 2011) Geometry: Hyperbolic
Cylinder > complicated.

2
Flinco Constructive Solutions, “University of California Davis, Veterinary Medicine 3A Building,” (2009),
http://www.flintco.com/experience/education/university-of-california-davis,-veterinary-medicine-3a-building.aspx
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The presented projects in that report were analyzed by the author of this thesis according
to GGDA. In the previous figures, each building was analyzed to its initial origin
geometry. The results show a variation in the complexity of the resulted initial
geometries, but the simple geometry dominates most of these buildings. This domination
explore the difficulties that HOK firm might face in creating buildings with more
complicated geometries by Revit, which lead the company to prefer simple forms for its
projects.

A tutorial Book about Revit Architecture 2011 (Krygiel et al. 2010) has been published
by Autodesk. This book had covered all design process phases, including a special
chapter (Krygiel et al. 2010, 255) for conceptual massing method. The authors introduced
this chapter by creating different kinds of geometries "solids and surfaces" with various
levels of complexity. This chapter was presented as a confirmation for the great abilities
of Revit Architecture in creating any complicated mass that the designer wants.
The modeling and massing chapter in this book has studied some of the geometries that
will be accomplished in this thesis. However, these geometers will be generated
according to GGDA, as well as to other geometries that were not included to this book
which all of them will be examined in depth.

2.6. Studies about Experiments and Interface Evaluation
“Is VR an effective communication medium for buildings design?” (Calderon et al.
2000) is one of the studies that helped the researcher of this thesis to prepare the
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experiments of the thesis’s methodology, and to arrange the questionnaires that were
answered by the participants in the confirmation method before and after the
experiments. This study included a development of an experiment were used to assess the
performance of the virtual reality VR in the early stages of construction projects .The
study aims to explore the promising technologies of VR in the field of visual cognition as
a future alternative of the common 2D presentations. To achieve the evaluation process,
ASSET application was developed to determine the abilities of VR in the briefing design
phase (Calderon et al. 2000, 3). The researchers had identified the variables of the
experiment and the executive parts of the evaluation process which were adopted for this
thesis to evaluate Revit Architecture. The evaluation process include three main parts: the
first part aims to identify the technical and human factors that might affect the
experiment. The human factors were determined by using a questionnaire was answered
by the participants of the experiments. This questionnaire gave a profile about each
participant in terms of: psychological and health status, age, weekly hours of using
computer, and previous experience. The technical specifications of the used computers in
the experiments were determined to ensure the smooth performance of the experiments.
In the second part of the evaluation process, the participates asked to work on a set of
tasks. These tasks were explained to the participants before they start work on the tasks.
Another questionnaire was also filled out by the participants in the third part of the
process. This questionnaire concerned an evaluation by the participants about their tasks
(Calderon et al. 2000, 5).
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“A Proposed index of Usability: a Method for Comparing the Relative Usability of
Different Software Systems” (Lin et al. 1997) is a study that presents a method of
evaluating any software’s interface. This method was used by the researcher in this thesis
in the evaluation process of both Revit architecture and Rhinoceros interfaces. This
method depends on eight human factors for the evaluation process. These factors include:
compatibility, consistency, flexibility, learnability, minimal action, minimal memory load,
perceptual limitation, and user guidance (Lin et al. 1997, 270). For each of these factors,
a number of questions should be answered to obtain the level that the interface has for
each factor. In Appendix D, the researcher followed that method by answering these
questions about the interface of both Revit and Rhinoceros. The researcher also used
another study “Guidelines for Designing User Interface Software” (Smith and Mosier).
This study explains the questions that are included in the previous study
comprehensively; the researcher used this study because of the difficulty of
understanding some of computer’s science terminology. Some of these questions were
also used in preparing the questions of the post-questionnaire that the participates of the
confirmation method were answered after the experiment to evaluate the interface of
Revit Architecture.

Through this chapter, it can be noted the multiple studies about different design
approaches, which illustrates the awareness of the researchers of the importance to study
these approaches extensively, and affirms the diversity of the generative design
approaches. One of these studies had been addressed the GGDA (Mallasi 2007) and
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applied it on a developed application by the author of the study, whereas this thesis
applies GGDA on available design software which is Revit Architecture.
This chapter also presented studies that concentrate on the benefits of BIM applications
in the design process, but these studies have not focused comprehensively on the benefits
of BIM applications in the conceptual design phase, and did not study the compability of
these applications with different generative design approaches. In addition, the chapter
reviewed some examples of firms that used Revit in their projects whether Revit was
used t in all design phases or some of the design phases. The masses of the buildings of
these examples were analyzed to their initial geometries to conceive the level of
complexity that Revit Architecture is able to achieve.
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Chapter 3.

Methodology

The major goal of this thesis is to evaluate the abilities and limitations of Autodesk Revit
Architecture in working on Initial Geometry Preparation (IGP) stage in Generative
Geometric Design Approach (GGDA). The question of the thesis is; can the designers,
who use GGDA, depend on Revit Architecture to work on IGP stage in GGDA?

In this thesis, designers who use GGDA will be aware of the compatibility of Revit
Architecture with their approach. The knowledge of this compatibility helps them to
know the design software that best suits their method of working. If the compatibility of
GGDA is proved, it can positively affect the workflow of design process, because
designers will be able to use Revit in all design phases without the involvement of other
3D modeling software. Working on Revit in all design phases achieves successful
projects which are characterized by their commitment to the timetable and budget.

The methodology of this thesis examines focuses on the IGP stage of GGDA. This stage,
as defined previously, is based on Initial geometries in configuring the design concept.
The main reasons of concentrating on this stage are:

First, the IGP stage is the starting point of generating the design idea whether the idea
was not sketched before, or was formulated in the designer's mind or his/her sketch.
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Second, geometry is the basic unit for any design concept (Pottman et al. 2007, I). Figure
23 shows a three dimensional parametric model. That 3D model is based on the geometry
of cube in its composition. While in Figure 24, the hexagon shape is the initial geometry
for that deformed construction.

Figure 23: Cubic is the basic geometry of this

Figure 24: Hexagon shape is the initial geometry for

parametric model3.

this parametric deformed model4.

Third, Revit doesn't have the default geometries that most 3D modeling softwares
provide in their interfaces, such as 3Ds Max (Murdock 2009, 134-154) and Rhinoceros as
well. This feature helps the designers with GGDA to save time and start working on GCT
stage immediately without thinking of how these geometries can be created in that
software.

3

Ben Gray, “Rose Window- A 3D Parametric Model in Processing,” Peer Produced Space, October 19, 2008,
http://michalpiasecki.com/2008/10/19/rose-window-a-3d-parametric-model-in-processing/
4
David Fano, “3Ds Max Tutorial - Modeling a Hexagon Screen,” Design Reform, February 2, 2009,
http://designreform.net/2009/02/3ds-max-tutorial-modeling-a-hexagon-screen/
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Figure 25: 3Ds Max software's primitive

Figure 26: Rhinoceros software's basic objects.

geometries (Murdock 2009, 139).

3.1. The Process of Thesis's Methodology
The process of the thesis to achieve its goals is based on simulating of the IGP stage. This
simulation process has two methods; Main method, and Confirmation method. In the
main method, the researcher works on a series of experiments that create a selected set of
geometries (solids and surfaces)5. In each experiment, one geometry is created. A
selected number of the created geometries will be examined in the next stages of GGDA;
GCT, and FFR. This examination contributes in testing the reliability of Revit in the
entire process of GGDA. In the confirmation method, four volunteered students in
Architecture College in University of Nebraska-Lincoln (UNL) create three selected
geometries as a simulation of IGP stage only.

The next diagram shows the entire process of the simulation method of GGDA:

5

See page 41.
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Diagram 1: The diagram shows the stages of GGDA that are followed in the main method.
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3.2. Hypothesis
The hypothesis of the thesis is depending on the simulation process of the three stages of
GGDA. Accordingly, the hypothesis is divided to four main steps. Each of these steps is
split to a number of mini-steps. For example, the first step in the Table 1 is concerned to
examine Revit with the first stage of GGDA. This step has six mini-steps that are
concerned to create six categories of the selected geometries. If all these categories are
created successfully in Revit Architecture, then this software is considered a reliable to
work on IGP. This mechanism is applicable on the other three steps of the hypothesis.
The validity of the hypothesis of this thesis is relies on the validity of each mini-steps.
The hypothesis includes the following:
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Hypothesis

Result

Autodesk Revit Architecture is able to create:
• Preliminary solids.
• Preliminary surfaces.
• Secondary solids.
• Secondary surfaces.
• Complex solids.
• Complex surfaces.

Autodesk Revit Architecture has the
ability to work on Initial Geometry
Preparation stage in GGDA.

Autodesk Revit Architecture is able to create all solids in:

Autodesk Revit Architecture has Great
ability to work on Initial Geometry
Preparation stage in GGDA.

•
•

Shorter time than Rhino and ArchiCAD.
Fewer steps and clicks than Rhino and
ArchiCAD.

Autodesk Revit Architecture is able to create all
surfaces in:
• Shorter time than Rhino and ArchiCAD.
• Fewer steps and clicks than Rhino and
ArchiCAD.
Autodesk Revit Architecture has the ability to create
compound geometries.

Autodesk Revit Architecture is reliable
to work on Geometry Configuration &
Transformation Stage in GGDA.

Autodesk Revit Architecture has the ability to apply its
components on all solids and surfaces.

Autodesk Revit Architecture is reliable
to work on Form Recognizability Stage
in GGDA.

Autodesk Revit Architecture is reliable to work with GGDA.

Table 1: The hypothesis is depending on the simulation process of the three stages of GGDA.
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3.3. Thesis Possible Outcomes
If the hypotheses of this thesis are proved, then valuable outcomes will arise. These
outcomes will have a significant impact on the workflow of the design process, and on
the designers who follow GGDA. The outcomes include the following:

Designers who use GGDA will believe in the reliability of Revit Architecture in
configuring their conceptual ideas >This belief leads them to use Revit in all design
phases> Using Revit in all design phases will significantly accelerate and smooth the
work flow of the design process.

Conversely, if the hypotheses are not proved, other outcomes can be concluded:

•

Revit Architecture is not compatible with GGDA> The designers who use that
approach will look for other 3D softwares suits their way of thinking.

•

The abilities of Revit Architecture are limited in limited generative design
approaches.

•

Revit Architecture has limitations, and more developments are needed for this
software to overcome these limitations.
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3.4. The Elements of Methods' Experiments
The main and the confirmation methods of the simulation process in the methodology of
this thesis have important and shared elements. These elements build the structure of the
experiments that are implemented in the both methods. They are presented in the
geometries that are created in the experiments, and the variables are considered before
and after the experiments. These elements should be clarified and explained to the readers
first before the sections of the main and confirmation methods, because they are shared
between the two methods and should be understood by the readers carefully. The
elements include the following:

3.4.1. The Geometries
The chosen geometries are based on complexity standard: preliminary, secondary and
complex geometries. The selected geometry in this thesis, were divided into two main
categories: Solids, and Surfaces.
Each category is split into three subcategories. For instance, solid category is divided to:
preliminary solids, secondary solids, and complex solids.
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3.4.1.1. The Selected Geometries:
a) Solids:
Preliminary solids:
Sphere
Cone

Torus

Prism

Pyramid

Cylinder

Ellipsoid

Anti-Prisms

Truncated
Cone

Elliptic
Cone

Elliptic
Cylinder

Truncated
Cube

Tetrahedron

Secondary Solids:
Dodecahedron
Octahedron

Oblique
Circular Cone

Right Circular
Cone

Oblique
Circular
Cylinder

Truncated
dodecahedron

Truncated
Tetrahedron

Cub
Octahedron

Truncated
Icosahedron

6

6

6

Complex Solids:
Ices
Dodecahedron

6
Truncated
Octahedron

Truncated Icosi
dodecahedron

7

6

6

6

Rhombi cub
Octahedron

6

Snub
Dodecahedron

8

Truncated
Cub
octahedron

6

Snub Cube

6

Craig Kaplan, "Symmetrohedra," University of Waterloo, February 6, 2005,
http://www.cgl.uwaterloo.ca/~csk/projects/symmetrohedra/ (accessed December 11, 2010).
7
George W. Hart, "Zonohedrification," Georgehart, http://www.georgehart.com/zonohedra/zonohedrification.html
(accessed December 11, 2010).

9
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b) Surfaces:
Preliminary Surfaces:
Hyperboloid
Hyperboloid
One Sheet
Two Sheet

Paraboloid

Catenoid

Helical Surface

10

Secondary surfaces:
Hyperbolic
Hyperbolic
Paraboloid
cylinder

11

Complex surfaces:
Enneper
Scherk
Surface
Surface

Parabolic
Cylinder

Elliptic
Paraboloid

12

13

Klein Bottle

Trefoil Knot

10

Helicoid

14

Mobius Strip

19
15

8

16

17

18

Eric Weisstein, "Snub Dodecahedron," Wolfram MathWorld, 2011,
http://mathworld.wolfram.com/SnubDodecahedron.html (accessed December 11,2010).
9
Eric Weisstein, "Snub Cube." Wolfram MathWorld, 2011, http://mathworld.wolfram.com/SnubCube.html
10
Francisco Martin, "Classical minimal surfaces," Granada University, http://www.ugr.es/~fmartin/dibujosclasicos.htm (accessed December 11,2010).
11
Department of Mathematics, Asheville-Buncombe Technical Community College,
http://abtech.edu/as/mat/default.asp (accessed December 11,2010).
12
Kevin P. Rice, "Are Cylinders Round?" 2011, http://freightyard.net/papers/cylinder/ (accessed December 11,2010).
13
Eric W. Weisstein, "Elliptic Paraboloid," Wolfram MathWorld,
2011, http://mathworld.wolfram.com/EllipticParaboloid.html (accessed December 11,2010).
14
"Helicoid," Wikipedia, http://en.wikipedia.org/wiki/Helicoid (accessed December 11,2010).
15
"The Enneper surface," Indiana University, http://www.indiana.edu/~minimal/maze/enneper.html (accessed
December 11,2010).
16
Eric W. Weisstein, "Scherk's Minimal Surfaces." Wolfram MathWorld, 2011,
http://mathworld.wolfram.com/ScherksMinimalSurfaces.html (accessed December 11,2010).
17
Davide P. Cervone, "Glass Klein Bottle," Union College, September 8, 2001,
http://www.math.union.edu/~dpvc/professional/art/Asaro.html (accessed December 11,2010).
18
"Trefoil knot," Wikipedia, http://en.wikipedia.org/wiki/Trefoil_knot (accessed December 11,2010).
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Secondary geometries are the children of the preliminary geometries, and have an
increased level of complexity. They are consisted of one to more of preliminary
geometries and have specific names in mathematics, such as Octahedron. Complex
geometries are composed of preliminary and secondary geometries, and have also certain
names in mathematics, such as Icosi dodecahedron.

3.4.2. The Variables:
It is important for research to clearly identify and carefully study the appropriate
variables, especially the researches that contain experiments. Variable is defined as:" any
entity that can take on different values." (Social Research Methods 2006, Variables).
In other words, variables are any factor that has different quantities or qualities. Variables
are divided into two types: Independent variables, and Dependent variables. More
discussion and details about the variables can be found in the next sections.

19

"Hair Band clip art," Clker, http://www.clker.com/clipart-24184.html (accessed December 11,2010).
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Diagram 2: The correlation between the independent variables and the dependent variables.

3.4.2.1. Independent Variables:
The independent variable (IndV) is defined as "what you (or nature) manipulates -- a
treatment or program or cause." (Social Research Methods 2006). In this thesis, there
are four categories of the independent variables:
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a) User's variable:
•

Previous experience

•

Attitude

•

Psychological and physical statue,

•

Expectation.

b) The environment of workplace.
c) Technical variables:
•

Computer's capabilities

•

Software’s interface.

d) Faced difficulties.
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Diagram 3: The correlation between independent variables and the Success/Failure of the experiments.
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3.4.2.1.a. User's variables:
i.

User Experience (Despont-Gros et al. 2004, 251): The experiences of using
computers in general and the use of particular softwares have an impact on the
success and the work speed within the experiments. This experience ranges to: the
general experience of using computers, the general experience of using specific
design softwares, the user's experience of using these softwares in conceptual
design phase, and finally the user's experience of using them with GGDA (See
Diagram 4).

Diagram 4: The levels of experience.

The correlation between user's experience and the success of the experiment is a
positive correlation. If the user has good experience in using the softwares, the
potential of the experiment's success increases. While the correlation between the
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experience and experiment's time is negative. Users with high level of experience
spend less time working on the softwares. These correlations are tested in the
simulation process in this thesis.

ii.

User's Attitude (Despont-Gros et al. 2005, 251): The attitude of the user means
her/his willingness of using the software. This attitude can be determined by the
way that the user learned how to use the software: Did s/he want to learn it? Or
was s/he required to learn it by individual, college or company? Other way to
determine the user's attitude is the extent of using the software: Does s/he use it
only to work on assignments or job's tasks? Or does s/he use it most of the time
and achieve personal business? The correlation between the experiment's success
and user's attitude is positive correlation as well.

iii.

Psychological and Physical Statue of the User: The physical and psychological
aspects also have an impact on user's performance. If the user is tired, exhausted
or frustrated in the time of the experiment, her/his performance will be negatively
affected. It reduces the concentration of the user on her/his work which might
cause long time to accomplish the task. It might also cause a decrease in her/his
attitude. These results could lead to the failure of the experiment.

iv.

User's Expectations (Despont-Gros et al. 2005, 252): The expectation of the user
is considered one of the variables that affect the results. The optimistic feeling
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towards the results of the experiment will help to achieve the goals of the user. It
also applies to the negative feelings.

v.

Work Place's Environment (Despont-Gros et al.2005, 250): The surrounding
environment of work place also affects the performance of the user and the
success of the experiment. A work place with good lighting (Chiemeke et al.
2007, 3), proper temperature, convenient space (Despont-Gros et al. 2005, 251),
comfortable colors, and quiet atmosphere has a positive impact on the
psychological and physical aspects of the user.

3.4.2.1.b. Technical Variables:
i.

Computer Capabilities: The technical specifications of the used computer in the
experiment play a significant role in user's performance and the success of the
experiment (Vanier1985, 10). These specifications include the capacity of the
memory, computer's speed, computer's brand, mouse's brand, screen resolution
and screen display colors (Vanier1985, 10; Calderon et al. 2000, 5). High-tech
specifications will positively affect the performance of the user, the software, the
speed and the success of the experiment. Here are the standard specifications
(College of Architecture, 2011) of computers that could be used for design work:
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Hardware Specifications (PC)

Hardware Specifications (MAC)

•

CPU: Intel or AMD 2.33ghz Core 2 Duo or
faster.

•

CPU: MacBook Pro 2.33ghz Core 2 Duo
or faster.

•

Display: 15" WXGA+ minimum
(1440x900 minimum).

•

Display: 15" WXGA+ minimum
(1440x900 minimum).

•

RAM: 4 GB minimum.

•

RAM: 4 GB minimum.

•

Disk Storage: 250 GB minimum.

•

Disk Storage: 250 GB minimum.

•

External Mouse: 3-button with scroll wheel
required Video Card: 256mb DirectX 10
supported adapter from the following
series:

•

External Mouse: 3-button with scroll
wheel required.

•

Video Card: 256mb DirectX 10
supported adapter from the following
series:

ATI Radeon HD 37xx NVidia GeForce 8800
ATI Radeon HD 48xx NVidia GeForce 9400.
ATI Radeon HD 56xx NVidia GeForce
470M.
ATI FireGL series NVidia Quadro Series.

-

•

- ATI Radeon HD 37xx NVidia GeForce 8800
- ATI Radeon HD 48xx NVidia GeForce
9400
- ATI Radeon HD 56xx NVidia GeForce
470M
- ATI FireGL series NVidia Quadro Series.

Operating System: MS Vista or Windows 7
Enterprise/Ultimate required
•

Operating System: OS X 10.5/6 w/ Vista
Enterprise BootCamped

Table 2: The standard specifications of Architecture College in UNL (College of Architecture, 2011).

ii.

Software's Interface (Despont-Gros et al. 2005, 252; Odeh and Adwan 2009,
1061): The interface has an important impact on the performance of the user, and
the ease of using the software. Poor user interface is considered a constraint in
working on the software. For instance, the long command sequence and the
ambiguity of icons and commands increase the number of work hours and disable
the work flow. The basic elements that characterize software's interface are:
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terminology, screen design, navigation, (Despont-Gros 2005, 249) customization,
input, help information, training, command sequence and colors.

3.4.2.1.c. Faced difficulties:
In each creating experiment, there are difficulties that might be faced. These difficulties
could affect the time and number of steps and clicks of the experiment. They could lead
also to the failure of the experiment, which might be considered a limitation in the
software.

3.4.2.2. Dependent Variables:
The dependent variable (DepV) is defined as "what is affected by the independent
variable - your effects or outcomes."(Social Research Methods 2006). For these
experiments, the dependent variables are: Steps, Clicks, Time, Number of created
geometries (Devon et al. 2007, 229), Failed tries, and Possible strategies.

a) The Results of the Experiment: The result of the experiment is the most
important DepV that be observed. The number of successful experiments affects
the result of the thesis by confirming the ability of Revit Architecture in creating
the geometries in IGP stage (Despont-Gros et al. 2005, 246), and that applies also
on the failed experiments. IndV should be considered in the analysis of
experiment's results. For instance, if the experiment was failed, the IndVs are
regarded to figure out if they might affected the experiment's results negatively,
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and leaded to the failure. According to this process, the final decision about the
result of each experiment can be taken.

b) Time (Devon et al. 2007, 229; Vanier1985, 20): is counted and recorded as:
hours, minutes, seconds by using a digital stop watch (Figure 27), and the
software recorder. The time of creating each geometry in Revit is compared with
the time spent on other two different softwares. These two softwares are discussed
in detail in the comparative tools section. Time of experiment is affected by all
independent variables listed before. These variables are considered in time
comparing process to ensure accurate results.

Figure 27: Used digital Stopwatch.

c) Steps of Creation Process: The commands that the user follows in each
successful experiment of creating geometries are counted and documented. The
process of geometry's creation is recorded using a software recorder (Figure 28).
The recording helps in defining the main steps in creating each geometry.
The recorder software records all experiments whether they are successful or
failed. Only successful experiments will be counted and documented.
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Figure 28: The used Software Recorder.

d) Clicks of Creation Process (Zulch and Stowasser 2000, 4; Odeh and Adwan
2009, 1064): The number of clicks that a user makes during the experiment is also
counted. They are counted using RUI application (Figure 29) which counts key
strokes and mouse clicks and moves. There are several factors that impact the
resulted number of clicks. These factors include: user's experience of using the
software, the physical and psychological state of the user, software's interface, the
surrounding environment, computer's technical specifications and geometry's
complexity. These factors are taken into account in data analyzing phase to avoid
bias and inaccurate results.

Figure 29: Software counter of clicks.
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e) Number of Created Geometries: The number of created geometries is an
important factor to judge the software. If a large number of geometries were
created in Revit comparing with other two softwares, then Revit is capable to
work on the IGP stage. The percentage is calculated at the final stage of the
methodology.

f) Number of Trials (Odeh and Adwan 2009, 1064-1065): Trial means in this
thesis the attempt that the user tries to create the geometry in the experiment, and
it could be successful or failed, whereas Experiment means the process of
creating one geometry in one software. For instance, the creation process of
generating the sphere in Revit is considered an experiment. The experiment may
contains more than one trial, and the number of trials is important in the analysis
process because it demonstrates the difficulties that the user faced during the
experiment and also displays the time that was spent to finish the experiment.
Diagram 5 illustrates the table of the collected data in Appendix B, and explains
the function of each column and row in that table.
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Diagram 5: This is an explanation of methodology criteria table in Appendix B.
This table contains all data of the experiments.

3.4.2.3. Comparative Tools (Softwares)
The comparative tools are the factors that help in analyzing the results. There are two
comparative tools in the sub-methods: Rhinoceros and Graphisoft ArchiCAD. The two
softwares are examined as well with the same experiments. The experiments have the
same variables and the same geometries. The selected softwares were chosen depending
on specific aspects, to achieve a fair comparison, and avoid prejudice and bias. These
aspects include: Category, Massing abilities, Popularity and Produced Company. Table 3
shows these aspects.
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Software

Category

Rhinoceros

Not BIM
application.
BIM application.

ArchiCAD

Massing Abilities
Known massing
abilities.
Unknown massing
abilities.

Popularity

Company

Popular in
USA.
Not Popular in
USA.

Not Autodesk.
McNeel Co.
Not Autodesk.

Table 3: Shows the aspects of the selected softwares.

Graphisoft Co.

57

3.5. Main Method
In the main method, the researcher simulates the three stages of GGDA on the entire set
of geometries on Page 41. This simulation is done by the three softwares: Revit
Architecture 2011, Rhinoceros 4.0, and ArchiCAD 14.
The following table shows the used hardwares and softwares in the main method:
Hardware
•
•

•
•
•
•
•
•
•
•
•
•

Software

Hardwares and softwares for
Recording the process of
Experiment

• Autodesk Revit
• Web Camera:
Computer model:
HP Pavilion dv7 Notebook
Architecture 2011 x64,
HP MediaSmart Webcam
PC
2010 (Student version).
2.1.1.11.24
Processor:
• Rhinoceros 4.0 SR5b, 2009 • Speakers & Microphone:
Intel (R) Core (TM) Quad
(Educational).
IDT High Definition Audio
CPU Q 9000 @ 2.00 GHz
CODEC.
•
ArchiCAD
14.0.0
x86
2.00 GHz
(Educational).
•
Camtasia Studio 6.0.3,
Display:
1600X900
2009.
Memory:
• Stopwatch application.
6.00 GB
Disk Storage:
450 GB
System type:
64-bit Operating System
Window Edition:
Window Vista Home
Premium
Web Camera:
HP MediaSmart Webcam
2.1.1.11.24
Video Card:
Generic PnP monitor
ATI Mobility Radeon HD
4650
ATI Radeon Graphics
Processor (0X9480)
Speakers & Microphone:
IDT High Definition Audio
CODEC
Mouse driver:
Synaptic PS/2 Port
TouchPad
Mouse brand:
Microsoft and Logitech
3-button with scroll wheel.
Table 4: Shows the used hardwares and softwares in main method.
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3.6. Hypothesis of the Main Method
The methodology examines Revit Architecture, Rhinoceros and ArchiCAD, in order to
verify the hypothesis of the thesis progressively. The hypothesis of the main method
examines the softwares in all stages of GGDA20.
Hypothesis

Result

Autodesk Revit Architecture is able to create:
• Preliminary solids.
• Preliminary surfaces.
• Secondary solids.
• Secondary surfaces.
• Complex solids.
• Complex surfaces.

Autodesk Revit Architecture has the
ability to work on Initial Geometry
Preparation stage in GGDA.

Autodesk Revit Architecture is able to create all solids in:

Autodesk Revit Architecture has Great
ability to work on Initial Geometry
Preparation stage in GGDA.

•
•

Shorter time than Rhino and ArchiCAD.
Fewer steps and clicks than Rhino and
ArchiCAD.

Autodesk Revit Architecture is able to create all
surfaces in:
• Shorter time than Rhino and ArchiCAD.
• Fewer steps and clicks than Rhino and
ArchiCAD.
Autodesk Revit Architecture has the ability to create
compound geometries.

Autodesk Revit Architecture has the ability to apply its
components on all solids and surfaces.

Autodesk Revit Architecture is reliable
to work on Geometry Configuration &
Transformation Stage in GGDA.
Autodesk Revit Architecture is reliable
to work on Form Recognizability Stage
in GGDA.

Autodesk Revit Architecture is reliable to work with GGDA.

20

See pages 3-5.
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Diagram 6: Shows hypothesis's steps to discover the abilities and limitations of Revit Architecture.
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3.6.1. Autodesk Revit Architecture 2011
3.6.1.1. Initial Geometry Preparation Stage in Revit Architecture
This section describes the steps that were followed to work on Revit in IGP stage in
GGDA. In this stage, a set of initial geometries is created gradually that is included on
page 41. The methodology first, examines the creation of solid geometries with its
different categories: preliminary, secondary and complex solids. In the next step,
surface's categories are created.

During these experiments, time, steps and clicks are counted in creating each geometry.
Stopwatch software and Camtasia Recorder software are used in time counting and steps
recording. Clicks are counted manually in all experiments in the main method because
the researcher couldn't obtain a counter clicks software in the first period of the research.
The time, steps and clicks are documented with detailed comments in the Appendix B.
The appendix includes a table that documenting the repeated experiments for each
geometry, and the difficulties that the researcher faced during each experiment. This
chapter explains some of these experiments in details for each used software.

3.6.1.2. About Autodesk Revit Architecture 2011
Autodesk Revit was issued in 2002 (Eastman et al. 2008, 57) by Autodesk company. It is
considered Building Information Modeling (BIM) software. It specializes in AEC
industry. It has three main products: Revit Architecture, Revit Structure, and Revit MEP.
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Revit Architecture 2011 is the latest version; that version is evaluated in this thesis. New
enhancements (Kygriel et al. 2010, 255) have been added to this version especially for
creating design ideas.

3.6.1.3. New families
New family's files have been added to the original massing file Conceptual Mass Model
Family (MMF). These families include: Adaptive Component Family (ADF), Generic
Model Family (GMF). In the ADF file, the user can modify the shape of curtain wall
edges after she/he applies it to a mass. GMF file has other generic files. The main GMF
file is specialized to create special forms and geometries. These forms are created by
using special operations in Forms panel that MMF doesn't have. The panel includes
Extrusion, Blend, Revolve, Sweep, Blend, Swept Blend, and Void Forms operations. The
created forms in that file can be loaded to Project File (PF) and MMF file not vice versa.
Also, the masses are created in MMF file can be loaded only to PF file and not vice versa.
Edit Family option in Model panel is used to edit any loaded family in PF file and MMF
file.

The forms that were created in GMF file can be loaded to PF file directly, but they are
useless there. These forms are considered generic models in PF file. Generic models
cannot be used as Mass models in PF file. The user can only apply wall, roof, and curtain
wall components on the Generic models but cannot apply Mass. The only way to use
GMF forms, is to load them first to MMF, then load them to PF. This loading process
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will cost more time in the design process. Diagram 7 demonstrates the loading process
among Revit Architecture’s files.

Diagram 7: The hierarchy of loading different files in Revit Architecture.

The main method focuses on three main files: PF, MMF, and GMF files. The basic units
for all experiments in that method are meters. Using meter unit creates masses that have
real building scale. To modify the unit system of any Revit file, follow the path
described: Manage tab> Project units.

3.6.1.4. The Experiments of Solid geometries in Revit Architecture
This section illustrates some examples of solid geometries experiments in Revit
Architecture. It cannot contain the explanation of all the experiments. Therefore,
Appendix B on page 173 includes all the information about them.
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3.6.1.4.a. Preliminary Solids in Revit Architecture
3.6.1.4.a.i. Sphere
Sphere as defined mathematically in Wolfram MathWorld is: "the set of all points in
three-dimensional Euclidean space

that are located at a distance

(the "radius")

from a given point (the "center"). Twice the radius is called the diameter, and pairs of
points on the sphere on opposite sides of a diameter are called antipodes."21 (Weisstein
2011)

Figure 30: Sphere in Revit.

In Revit, the sphere was created successfully in two different families with two different
methods (Figure 30). It was created in MMF, and GMF. The two resulted spheres can be
loaded to Project File (PF). However, it is preferable in Revit to create the mass on MMF,
because it saves time according to long loading process from GMF to PF. In addition,
GMF has limited options. It misses some of MMF options such as 3D snapping, Create
Form, etc. Therefore the created geometry in that file may need more improvements in
MMF file before loading it to PF.

21 Eric Weisstein, "Sphere," Wolfram MathWorld, 2011, http://mathworld.wolfram.com/Sphere.html
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The experiment was achieved in fifteen steps at a time of no more than fifty three
seconds.
3.6.1.4.a.ii. Prism
SpringerLink mathematical encyclopedia defined Prism as: "a polyhedron for which two
sides are -gons (the bases of the prism), while the other

sides (the lateral sides) are

parallelograms. The bases are congruent and located in parallel planes. A prism is
called direct if the planes of the lateral sides are orthogonal with the planes of the bases.
A direct prism is called regular if its bases are regular polyhedra. A prism is called
triangular, rectangular, etc., depending on whether the bases are triangular, rectangular,
etc.... The volume of a prism is equal to the product of the area of one of its bases and its
height (the distance between the bases)." 22 (SpringerLink 2001)

Figure 31: Prism in Revit Architecture.

Prism was created successfully in MMF (Figure 31). It was created twice with the same
method and steps. The reason of repeating the experiment is to determine the effect of the
first experiment on the speed of the second experience. It was observed that the second

22

Encyclopedia of Mathematics, “ Prism,” SpringerLink, 2001, http://eom.springer.de/P/p074830.htm
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trial was faster than the first, because of the prior knowledge of the steps. Here are the
times of the 1st and 2nd experiments:
1st trial: (Time= 00:01:16)
2nd trial: (Time = 00:00:42)
The first experiment was completed in fourteen steps at a minute and sixteen seconds,
whereas the second trial was achieved in fourteen steps, thirty four clicks and forty two
seconds.

3.6.1.4.a.iii. Cylinder
Wolfram MathWorld defined Cylinder mathematically as: "a solid bounded by a closed
generalized cylinder, and two parallel planes."23(Weisstein 2011)

Figure 32: Cylinder in Revit.

Cylinder was created twice successfully in Revit, with the same method (Figure 32).
Unfortunately, the first trial wasn't recorded, and cannot be repeated. The time can be
guessed approximately as minute, whereas the second trial lasted for only twenty four
seconds.

23

Eric Weisstein, "Cylinder," Wolfram MathWorld, 2011, http://mathworld.wolfram.com/Cylinder.html
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The experiment of creating a cylinder was done in MMF in fourteen steps and twenty
one clicks. It has the similar steps of creating the sphere as shown in Appendix B, except
the last step where Revit gives two options; cylinder, and Sphere as shown in Figure 33.
Cylinder option is chosen this time.

Figure 33: The two option that Revit offers.

Figure 34: The resulted Cylinder in MMF.

3.6.1.4.a.iv. Cone
Cone as defined mathematically is: “a geometric figure swept out by a line (generator)
that joins a point moving in a closed curve in a plane, to a fixed point (vertex) outside the
plane. In a right circular cone, the vertex lies above the centre of a circle (base), and the
cone's generators join the vertex to points on the circle.”24

Figure 35: Cone in Revit.

24

"Cone." World Encyclopedia, http://www.encyclopedia.com/topic/cone.aspx#3
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Cone was created four times in Revit (Figure 35). The first trial was in GMF file. It was a
failed trial and took thirteen minutes of time. The second trial was also in GMF. It was a
successful and lasted three minutes and fifty five seconds with about ten steps. On the
other hand, the third trial was created in MMF. It was also successful, and lasted a
minute and thirty seconds with seventeen steps and forty seven clicks .Although, the
last trial was successful and the fastest one in time, the created geometry was useless in
PF file. The geometry was created as mesh. Mass Floors option in PF file works only on
solid geometries to create floors not on meshes. Figure 36 and Figure 37 shows the final
step of creating the cone and the resulted geometry in Revit Architecture.

Figure 36: The two options that Revit offers in
MMF.

Figure 37: The resulted cone in MMF.
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3.6.1.4.b. Secondary Solids in Revit Architecture
3.6.1.4.b.i. Anti-Prism
SpringerLink mathematical encyclopedia defined Anti-Prism as: "a semi-regular
polyhedron in which two parallel faces are congruent regular, while the remaining faces
are regular triangle."25 (SpringerLink 2001)

Figure 38: Anti-Prism in Revit.

Anti-Prism was created four times in Revit Architecture. The researcher spent about three
hours work on the first two tries, but they were unsuccessful. The third try was successful
(Figure 38). It lasted only thirty one minutes and forty three seconds with fifty seven
steps and 1382 clicks. The researcher in that third try used options that she didn't use
before as Add Edge command in Form Element panel in Modify/Form tab as
illustrated in Figure 39. That command made the process of creating Anti-prism easier.
The fourth try was an experiment to determine the effect of the third successful
experience on the time of the fourth one.

25

Encyclopedia of Mathematics, “ Anti-prism,” SpringerLink, 2001, http://eom.springer.de/A/a012680.htm
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Figure 39: Add Edge command and Drag vertexes helped in creating Anti-Prism geometry.

3.6.1.4.b.ii. Octahedron
Octahedron as defined in SpringerLink mathematical encyclopedia is: "a solid figure
having eight triangular faces, twelve edges and six vertices, with 4 faces at each vertex. If all
edges have the same length, it is one of the five regular polyhedra (Platonic Solids)." 26

(SpringerLink 2001)

Figure 40: Octahedron in Rhinoceros.

The only one experiment of creating octahedron in Revit was unsuccessful in spite of its
successful beginning. The experiment lasted about an hour and half with 1640 clicks.
26

Encyclopedia of Mathematics, “Octahedron,” SpringerLink, 2001, http://eom.springer.de/O/o068100.htm
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Octahedron can be created by joining two identical pyramids. At the first 40 minutes of
the experiment, the researcher was able to create a pyramid. The pyramid was created by
joining four quarter pyramids. Void forms were part of the creation process. The problem
started when the two pyramids were joined. The void forms showed up and made the
geometry has illogic look as shown in Figure 41.

Figure 41: The final result of Octahedron geometry in Revit.

3.6.1.4.c. Complex Solids in Revit Architecture
3.6.1.4.c.i. Icosahedron
Sphere as defined mathematically in SpringerLink mathematical encyclopedia is: "one of
the five regular polytopes. An icosahedron has 20 (triangular) faces, 30 edges and 12
vertices (at each of which 5 edges meet). The regular polytopes are also called the Platonic
solids."27 (SpringerLink 2001)

27

Encyclopedia of Mathematics, “Icosahedron,” SpringerLink, 2001, http://eom.springer.de/I/i050020.htm
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Figure 42: Icosahedron in Rhinoceros.

The experiment of creating Icosahedron in Revit has the same problems of creating
Octahedron geometry. The experiment was failed and lasted about an hour. Icosahedron
can be created by joining two pyramids with anti-prism as seen in Figure 43. The
researcher was able to create the pyramids and the anti-prism, but the joining process was
not successful because of the appearance of void forms.

Figure 43: The geometries (pyramid and anti-prism) that Icosahedron is consisted of.
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3.6.1.5. The Experiments of Surface geometries in Revit Architecture
This section illustrates some examples of surface geometries experiments in Revit
Architecture. It cannot contain the explanation of all the experiments. Therefore,
Appendix B in page 173 includes all the information about them.

3.6.1.5.a. Preliminary Surfaces in Revit Architecture
3.6.1.5.a.i. One Sheet Hyperboloid
Wolfram MathWorld defined hyperboloid mathematically as: "a quadratic surface which
may be one or two-sheeted. The one-sheeted hyperboloid is a surface of
revolution obtained by rotating a hyperbola about the perpendicular bisector to the line
between the foci, while the two-sheeted hyperboloid is a surface of revolution obtained by
rotating a hyperbola about the line joining the foci."28 (Weisstein 2011)

Figure 44: Hyperboloid one sheet in Revit Architecture.

28

Eric Weisstein, "Hyperboloid," Wolfram MathWorld, 2011, http://mathworld.wolfram.com/Hyperboloid.html
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Hyperboloid was created twice. The first experiment was not created according to the
mathematical rules. Therefore, the resulted shape cannot be considered a hyperboloid.
The second experiment was more accurate and based on the mathematical equation of
hyperbola curve. The experiment was done in MMF and was successful (Figure 44). It
took forty three minutes and forty seconds to draw the hyperbola curve, and about
fifteen minutes to create the one sheet hyperboloid geometry with more than 2400 clicks.
Figure 45 shows the options that Revit Architecture provided to create the hyperboloid.

Figure 45: The final step of creating one sheet hyperboloid. Revit offers two options
when using Create Form command, one of these options is the hyperboloid.

3.6.1.5.b. Secondary Surfaces in Revit Architecture
3.6.1.5.b.i. Elliptic Paraboloid
The elliptic paraboloid is:" shaped like an oval cup and can have a maximum or
minimum point. It is a paraboloid of revolution: a surface obtained by revolving
a parabola around its axis."29 (Wikipedia 2011).

29

"Paraboloid," Wikipedia, March 13, 2011, http://en.wikipedia.org/wiki/Elliptic_Paraboloid#cite_ref-0
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Figure 46: Elliptic Paraboloid in Revit Architecture.

The experiment of creating elliptic paraboloid was successful from its beginning (Figure
46). The researcher created it once and spent ten minutes and twenty nine seconds to
create the parabola curve mathematically with eighteen steps. To create the elliptic
paraboloid geometry, the experiment took an additional thirteen minutes and twenty
eight seconds and an extra twenty steps. One of difficulties that the researcher faced
during the experiment was the only option that Revit provide to draw the ellipse shape.
Ellipse can only be created in Revit by specifying its center as illustrated in Figure 47. In
other softwares, ellipse has more different options to draw, such as specifying its
diameter, its corners, etc. These options are important sometimes in creation process.

Figure 47: Drawing an ellipse in Revit.
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3.6.1.5.c. Complex Surfaces in Revit Architecture
3.6.1.5.c.i. Mobius Strip
The definition of Wolfram MathWorld of the mobius strip is: "a twisted cylinder (Henle
1994, p. 110), is a one-sided non orientable surface obtained by cutting a closed band
into a single strip, giving one of the two ends thus produced a half twist, and then
reattaching the two ends."30 (Weisstein 2011).

Figure 48: Mobius strip in Revit Architecture.

Mobius strip was created twice in Revit (Figure 48). The first experiment was not
recorded. Therefore, the researcher tried to create it again. The experiment was done in
twenty one minutes and fourteen seconds. The researcher created the geometry in
thirty three step and 1629 clicks.

30

Eric Weisstein, "Mobius Strip," Wolfram MathWorld, 2011, http://mathworld.wolfram.com/MoebiusStrip.html
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3.6.1.6. Geometry Configuration and Transformation Stage and Final Form
Recognizability stage in Revit Architecture
This section illustrates an experiment that simulates the process of GCT stage and FFR
stage in Revit Architecture. As defined in the introduction chapter31, Geometry
Configuration and Transformation (GCT) is the second stage of GGDA. In this stage, the
created geometry from IGP stage is developed. A number of operations such as Boolean,
editing, NURBS, and other kinds of CAD operations, are applied on these geometries to
create the final mass form of the design concept. On the other hand, FFR stage is the third
and final stage of GGDA. In this stage, the final mass that is generated in the second
stage of GGDA is transformed to a real building by applying Revit architecture's
components on it such as walls, doors, curtain walls, etc.

Time, steps and clicks are also counted in this experiment, and the same softwares are
used for time counting and steps recording. The results of the experiment are also
documented and attached to the appendices of the thesis.

3.6.1.6.a. The finalizing of a Mass Form in Revit Architecture
The experiment of creating a concept mass in Revit Architecture as a simulation process
of GCT stage was successful as shown in Figure 50, and lasted about nineteen minutes
with 1104 clicks. In that experiment, a number of preliminary solids were chosen to
create the mass form. These solids include: prism, cube and pyramid (Figure 49). The
31

see page 4.
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geometries were combined using Join command in Geometry panel in Modify tab. This
command is similar in function to one of Boolean operations which is the union.

Figure 49: Adding a half of a pyramid

Figure 50: The final mass concept.

to the form.

3.6.1.6.b. From a Mass form to a real building in Revit Architecture
The experiment of transforming the concept mass in Revit Architecture to a real building
is a simulation process of FFR stage (Figure 52). This experiment was successful and
fast. The operation of loading the mass from MMF to PF lasted no more than thirty
seconds with nine steps and seventeen clicks. Once the mass is exported to PF as seen in
Figure 51, the components such as walls, windows, floors, etc. can be applied easily and
quickly on it. This experiment was the best experiment in Revit Architecture pursuant to
time, steps, clicks and the ease of the operation.
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Figure 51: The loaded mass from MMF in PF.

Figure 52: Mass is transformed to a real building in
Revit Architecture
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3.6.2. Rhinoceros 4.0
3.6.2.1. Initial Geometry Preparation Stage in Rhinoceros
Rhinoceros is one of the two design softwares in the comparative tools that are chosen to
compare its abilities with Revit Architecture in working on GGDA. The experiments of
examining Rhinoceros in IGP stage were similar to the experiments that examined Revit
Architecture and ArchiCAD. They have the same variables, recording softwares and
geometries.

3.6.2.2. About Rhinoceros
Rhinoceros software was first released in 1992 (McNeel Wiki 2011) by McNeel
Company. It is considered one of NURBS Modeling softwares. It is able to create any
geometry for any purpose. Therefore, it has been used in several design areas; it is used in
product design, marine design, car design, architecture design, and jewelry design. Rhino
has the ability to deform solids, surfaces, and meshes, the ability to draft and illustrate,
the ability to render, and the ability to prototype (Rhinoceros 2010).
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3.6.2.3. Solid Experiments in Rhinoceros
A number of solid geometry experiments are demonstrated in this section. The selected
examples explain the method that all other experiments have followed. Appendix B in
page 173 includes all information about these experiments.

3.6.2.3.a. Preliminary Solids
Rhinoceros software provides most of the preliminary solids that are listed in the
methodology chapter. Therefore, most of the experiments of creating these geometries in
Rhinoceros have been done in a shorter time than Revit Architecture. The default
preliminary solids that Rhinoceros provides are: cube, sphere, ellipsoid, cone, pyramid,
cylinder, tetrahedron, and Torus (Figure 53). Prism is the only preliminary solid in the list
on page 41 that is not a default object in Rhinoceros. Thus, its creation will be explained
in this section.

Figure 53: Default preliminary solids in Rhinoceros.
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3.6.2.3.a.i. The Creation of Default Preliminary Geometries in Rhinoceros
The time that was spent in the experiments of creating each default preliminary solid in
Rhinoceros did not exceed more than two minutes as maximum. Most of these
experiments have the same steps, but they differ only in the parameters that characterize
each geometry. For example, the creation process of sphere geometry in Rhinoceros
needs to determine the center of the sphere and its radius, whereas the creation process of
cone geometry in Rhinoceros needs to specify the center of the cone's base, diameter, and
its height. Figure 54 illustrates the sphere and the cone geometries in Rhinoceros.

Figure 54: Sphere and cone in Rhinoceros.

On other hand, Rhinoceros offers different options to create each geometry. For instance,
Rhinoceros provides seven options to create a sphere as shown in Figure 55; it can be
created by determining its center and radius, by selecting three points, by determining its
diameter, etc. These options give the user more freedom in the creation process to enable
her/his design strategy.
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Figure 55: Creation options provided by Rhinoceros for Cube, Sphere, and Ellipsoid.

a. Sphere in Rhinoceros
The experiment of creating the sphere in Rhinoceros has similar steps of creating other
default preliminary solids. This experiment was done successfully in forty three seconds
and no more than seven steps and twenty three clicks.
Other default preliminary solids in Rhinoceros are created with the same method of
sphere creation. The following figures in Table 5 show the generated geometries of these
experiments and the time that was spent to achieve them.
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Sphere
00:00:13

Cylinder
00:00:10

Cone
00:00:07

Pyramid

Ellipsoid
00:00:07

Torus
00:00:07

00:00:10

Table 5: Shows preliminary solids that are default in Rhinoceros, and the time was spent

3.6.2.3.a.ii. The Creation of Non-Default Preliminary Solids in Rhinoceros
(Tetrahedron)
The experiment of creating tetrahedron in Rhinoceros is similar to the previous
experiments of default preliminary solids. However, the tetrahedron needs some
calculations before starting the creation process. Therefore, the users have first to know
the mathematical definition of the tetrahedron. Wolfram MathWorld defined tetrahedron
geometry as: "a polyhedron with four sides...The regular tetrahedron, often simply called
"the" tetrahedron, is the Platonic solid with four polyhedron vertices, six polyhedron
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edges, and four equivalent equilateral triangular faces..."32 According to this definition,
the tetrahedron consists of four equilateral triangulars. The edges of the tetrahedron
should have the same length, and the triangulars should have three equal 60o angles
(Figure 56).

60o

60o

60o

Figure 56: The mathematical rules of tetrahedron.

The tetrahedron was created twice successfully in Rhinoceros, with two different
methods (Figure 57). In the first trial, the researcher did not know that the default
pyramid option can help to create the tetrahedron geometry. Therefore, the tetrahedron
was created by using the basic shapes such as lines, surfaces, etc. and took about seven
minutes to be finished. While in the second experiment, the tetrahedron was created by
using default pyramid geometry. This method lasted about two minutes and twenty two
seconds with nineteen steps and 135 clicks.

32

Frank Jackson and Eric W. Weisstein. "Regular Tetrahedron." Wolfram MathWorld, 2011,
http://mathworld.wolfram.com/RegularTetrahedron.html
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Figure 57: Tetrahedron in Rhinoceros.

3.6.2.3.b. Secondary Solids in Rhinoceros
3.6.2.3.b.i. Dodecahedron
SpringerLink mathematical online encyclopedia defined Dodecahedron as: "one of the
five types of regular polyhedra. A dodecahedron has 12 (pentagonal) faces, 30 edges and
20 vertices (with three edges meeting at each vertex)."33 (SpringerLink 2001)

Figure 58: Dodecahedron in Rhinoceros.

33

Encyclopedia of Mathematics, “Dodecahedron,” SpringerLink, 2001, http://eom.springer.de/D/d033750.htm
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Dodecahedron was created once in Rhinoceros as shown in Figure 58. It was created by
joining a cube with six identical modified triangular prisms (Figure 59). The experiment
took more than fourteen minutes with fifty one steps and 727 clicks.

Figure 59: Creating dodecahedron by joining a cube with six identical triangular prisms.

3.6.2.4. The Experiments of Surface Geometries in Rhinoceros
This section reviews two examples of surface geometries experiments in Rhinoceros. The
full details of other experiments can be found in Appendix B in page 173.

3.6.2.4.a. Preliminary Surfaces in Rhinoceros
3.6.2.4.a.i. Paraboloid
Wolfram MathWorld defined Paraboloid mathematically as: "the surface of revolution of
the parabola... It is a quadratic surface which can be specified by the Cartesian equation
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z = b (x2 + y2)."(Weisstein 2011)34

Figure 60: Paraboloid in Rhinoceros.

The paraboloid surface was created once in Rhinoceros. The experiment was successful
and lasted only twelve seconds as seen in Figure 60. The default Parabola curve option in
Rhinoceros was the reason for achieving the experiment with that short time (Figure 61).
The creation process also was done using seven steps and twenty two clicks.

Figure 61: Default parabola curve in Rhinoceros.

34

Eric Weisstein "Paraboloid." Wolfram MathWorld, 2011, http://mathworld.wolfram.com/Paraboloid.html
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3.6.2.4.b. Secondary Surfaces in Rhinoceros
3.6.2.4.b.i. Hyperbolic Cylinder
The hyperbolic cylinder as defined mathematically in SpringerLink mathematical online
encyclopedia is: "a straight cylindrical surface of the second order with a hyperbola as
directrix ..."35 (SpringerLink 2001)

Figure 62: Hyperbolic Cylinder in Rhinoceros.

The experiment of creating hyperbolic cylinder in Rhinoceros was successful as
illustrated in Figure 62. It lasted about four minutes with 85 clicks. In the first three
minutes of the experiment, the researcher was able to create a hyperbola curve by using
the default hyperbola curve option. Then, the curves were extruded using Extrude Closed
Planar Curve command.

35

Encyclopedia of Mathematics, “Hyperbolic Cylinder,” SpringerLink, 2001, http://eom.springer.de/H/h048240.htm
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3.6.2.5. Geometry Configuration and Transformation Stage and Final Form
Recognizability Stage in Rhinoceros
This section introduces two experiments that were carried out in the main method to
simulate the GCT and FFR stage in Rhinoceros. In these experiments, the IndVs and
DepVs were considered, and time, steps and clicks were counted. The results of these
experiments are documented and attached to the appendices of the thesis.

3.6.2.5.a. The Finalizing of a Mass Form in Rhinoceros
The experiment of creating a mass form in Rhinoceros is a simulation process of GCT
stage. The geometries that were used are the same geometries that used in Revit
Architecture. These geometries are preliminary geometers, and include: prism, cube and
half of a pyramid as seen in Figure 63. The experiment was successful and lasted about
eleven minutes with 677 clicks. The time of the experiment and the number of clicks
were less than the time and clicks in Revit Architecture's experiment.
The geometers were united by using the Boolean Union operation that is available in the
toolbars on the interface of Rhinoceros.
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Figure 63: The final mass concept in
Rhinoceros.

3.6.2.5.b. From a Mass Form to a Real Building in Rhinoceros
The process of transforming the mass in Rhinoceros to a real building has two options,
because Rhinoceros has no default components that can be applied on the form. The first
option is represented in creating the components individually on the mass directly. This
process takes a long time to configure each component. The second option is exemplified
by exporting the mass to Revit Architecture and applies the components in the PF file.
The experiment that simulates FFR stage in Rhinoceros in this thesis followed the second
option. The created mass in Rhinoceros was exported to the PF file in Revit Architecture
successfully. This process lasted about four minutes with eighteen steps and 120 clicks.
We can notice the obvious difference in the time and the number of steps and clicks of
this process with the results of the same experiment in Revit Architecture36. The exported
mass from Rhinoceros to PF was employed as a mass that was created in Revit
36

See Appendix B.
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Architecture (See Figure 64). The components were applied on the mass easily and
smoothly. Figure 65 shows the results of FFR stage on the mass that was created in Revit
Architecture and the mass that was created in Rhinoceros.

Revit Architecture

Rhinoceros

Figure 64: The loaded mass

Figure 65: Comparing the results of FFR experiment

from Rhinoceros to PF file in

between Revit Architecture and Rhinoceros.

Revit Architecture.
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3.6.3. ArchiCAD 14
3.6.3.1. Initial Geometry Preparation Stage in ArchiCAD
This section explains a number of the experiments in ArchiCAD that explored its abilities
in the IGP stage. These experiments are similar to the previous experiments in Revit
Architecture. The same procedures are followed; counting time, recording steps and
clicks using the same softwares.
However, the created geometries in IGP stage are examined early in the FFR stage in
ArchiCAD. This examination shows that ArchiCAD components as walls, doors, curtain
walls, etc. cannot be applied to the created geometries. The software cannot transform
them into real buildings. The geometries can only be used in ArchiCAD to create other
components such as furniture, roofs, doors, and etcetera. As a conclusion, GGDA is not
applicable in ArchiCAD because of the unfeasibility to work on FFR stage. Therefore,
the researcher eliminates ArchiCAD as a comparative tool.

3.6.3.2. About ArchiCAD 14
ArchiCAD was established for the first time in 1984 (Goldberg 2005) by Graphisoft
company. It is considered at present, one of the oldest and most important BIM
applications. It is specialized like Revit in AEC industry. However, ArchiCAD does not
have multiple products like Revit has. There is no special product or file for each
discipline. All disciplines can work on the same version and all designs whether
architectural or structural are created in the same type of file. For instance, geometries
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and detailed drawings can be created in the same type of ArchiCAD file (.pln*) as shown
in Figure 66.

Figure 66: Mass modeling and detailed building in the same file in ArchiCAD.

3.6.3.3. The Experiments of Creating Geometries in ArchiCAD
This section illustrates some examples of solid and surface geometries experiments in
ArchiCAD. The description of all experiments cannot be included. Appendix B in page
173 includes all the experiments in details.

3.6.3.3.a. Solids in ArchiCAD
Most of the preliminary and secondary solids that are listed in this thesis are available in
the ArchiCAD library. This library provides the designer with most of these geometries
and offers the ability to modify their parameters before adding them to an ArchiCAD file.
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The default preliminary and secondary solids that are available in ArchiCAD are: cube,
cone, cylinder, sphere, prism, pyramid, ellipsoid, truncated cone, oblique circular cone,
right circular cone, and oblique circular cylinder. The following section provides
examples of the experiments.

3.6.3.3.a.i. The Creation of Sphere in ArchiCAD
The process of creating the sphere in ArchiCAD is similar to the process of creating other
default solids. The difference lies in the number of parameters that characterize each solid
within Object Default Setting. The sphere for example has two parameters: center and
radius, whereas the pyramid has six parameters.
The sphere in ArchiCAD was created once as seen Figure 67. The experiment lasted two
minutes and nineteen seconds with about seven steps.

Figure 67: Sphere in 3D view in ArchiCAD.

The previous steps in creating the sphere in ArchiCAD are the same steps to create other
default preliminary solids. Table 6 illustrates the final results of these solids.
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Prism

Cylinder

Cone

Ellipsoid

Pyramid

Tetrahedron

Truncated Cone

Oblique Circular Cone

Oblique Circular Cylinder

Table 6: preliminary and secondary solids that are default objects in ArchiCAD.

Due to the early conclusion about the unfeasibility of ArchiCAD to work with GGDA,
the number of clicks of the previous experiments were not counted and included in the
Appendix B. Furthermore, the experiments of creating other geometries were cancelled
and removed from the comparison process between Revit, Rhino, and ArchiCAD.
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3.6.3.4. The Generative Design Approach of ArchiCAD
According to the previous experiments in ArchiCAD, GGDA is not the suitable approach
to work on it. This conclusion is a result of examining the previous geometries in the FFR
stage. In these experiments the researcher tried to apply components such as walls, doors,
etc. on the faces of the geometries. These trials were unsuccessful as shown in Figure 68
and proved that geometries in ArchiCAD can only be used to create other components
such as furniture, windows, etc.

Figure 68: The experiment of applying the FFR stage on geometries in ArchiCAD.

As a result of several experiments of finding the suitable generative design approach for
ArchiCAD, it was found that a designer who uses ArchiCAD has to build their design
concepts directly using BIM components. The conceptual design phase was abandoned in
the software. The designers have to plan for their design concepts before starting work on
ArchiCAD. They can prepare these concepts in manual sketches, using design software,
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or using the default geometries in the ArchiCAD library. The manual sketches and the
masses that are created in other softwares have to be translated again with the
components of ArchiCAD. Graphisoft Company provides training videos that show the
way to create conceptual masses in ArchiCAD as seen in Figure 73, but it doesn't explain
the possibility to develop these masses to real buildings. Figure 69, Figure 70, Figure 71,
and Figure 72 show the results of creating some surfaces by using ArchiCAD
components.

Figure 69: Curtain Wall with Hyperbolic Cylinder

Figure 70: Roof with Parabolic Cylinder

geometry.

geometry.

Figure 71: Creating complex geometry curtain wall.

Figure 72: Complex shape of curtain wall.
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Figure 73: Graphisoft video shows how to create conceptual mass in ArchiCAD (Graphisoft).
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3.7. Confirmation Method
In the confirmation method, five students in the college of Architecture in UNL worked
on two experiments. These experiments have the same procedures, variables, and tools of
the main method's experiments. This method explores the possible effects of the user,
computer's capabilities and the surrounding environment on the abilities of Revit
Architecture in creating the geometries on page 41. The goal of the confirmation method
is to confirm the validity of the main method's results, and to avoid any possible bias in
them to strengthen the internal validity37 of the research.

3.7.1. The Hypothesis of the Confirmation Method
The hypothesis of the confirmation method is concerned only on the first stage of GGDA
(IGP), because the experiment of this method examined only this stage. The hypothesis is
presented in the following table:
Hypothesis

Result

Autodesk Revit Architecture is able to create: Autodesk Revit Architecture has the
• Preliminary solids.
ability to work on Initial Geometry
• Preliminary surfaces.
Preparation stage in GGDA.
• Secondary solids.
• Secondary surfaces.
• Complex solids.
• Complex surfaces.

37
Internal Validity is” the approximate truth about inferences regarding cause-effect or causal relationships. Thus,
internal validity is only relevant in studies that try to establish a causal relationship.” (Social Research Methods 2006,
Internal Validity)
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It was difficult for the researcher to examine all the stages of GGDA in the confirmation
method due to the constraints of the experiment’s time. The time of the experiment was
limited only in two hours and a half, this limitation is a result of the coming reasons:
•

The researcher determined the time of the experiment to three hours maximum to
encourage the students to volunteer for the experiment. If the time of the
experiment was more than three hours, the students will avoid the participation
because of their preoccupation with their studies and classes.

•

The difficulties that the researcher faced to find a computer lab to carry out the
experiment.

•

The experiment was carried out in a computer lab that has busy time schedule.
The lab was reserved most of the days of the week which was difficult for the
researcher to find an enough open suitable time for the experiment which also
suits the time schedules of all participants.

•

The experiment was operated in a very belated time in the schedule of the
research. It was carried out a month before the deadline of the final submission of
the research. This lateness is due to some administrative obstacles that the
researcher faced: the delay of obtaining the approval from the Institutional
Review Board (IRB) to work on the experiment, the delay of acquiring a
permission to use the computer lab, the long process of coordinating between the
suitable time for the participants and the open time of the lab, and the slow
process of installing the softwares of the experiment to the computers of the lab.

101

These reasons also are prevented the researcher to examine the other stages of GGDA,
and to work on additional confirmatory experiments.

Obtaining an approval from the Institutional Review Board (IRB) before working on the
confirmation method was necessary. The routing process of IRB lasted more than a
month, and was approved on the 15th of February 2011. The process included an online
Collaborative Institutional Training Initiative (CITI) course, and a detailed form about the
experiments and their goals. In the detailed form, the researcher submitted all the
documents about the experiments: the questionnaires and the informed consent. These
documents are attached in Appendix H on page 267.

3.7.2. Confirmation's Experiments
The participants of the experiment of the confirmation method are five male students in
Arch 511, Arch 611 courses. They volunteered after they listened to oral announcements
by the researcher in their classes. The researcher announced her need of volunteers to
work on her thesis's experiment. She explained the overall objective of the experiment
without in-depth details to avoid bias in the results. The announcement speech is included
in Appendix H.2 on page 267.

On the 25th and 26th of February in 2011, the participants worked on two experiments.
Each experiment took about half an hour of time, and was carried out in New Media
Center (NMC) in the college of Architecture. Before the participants began to work on
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the experiments, they were asked to read and approve their agreement on an informed
consent paper38. They were also asked to fill out an online pre-questionnaire39 created
with a survey website. The pre-questionnaire includes questions that are derived from the
independent variables40 that might affect the results of the experiments. These questions
are concerned about the personal demographic of the participant, and their previous
experience in using Revit Architecture and Rhinoceros. They are also concerned about
the attitude of the students and their psychological and physical states on the day of the
experiment. Collecting this information about the participants is important for the
analysis process, because it is considered the IndVs of the participants.

In the two experiments, the students created three geometries among the geometries that
are listed on page 41. The three selected geometries for the confirmation method are:
triangular prism, right circular cone, and mobius strip as shown in Table 7. The
researcher chose these three geometries because the participant’s should create
geometries with different levels of complexity and these geometries should be a mixture
of solid and surface categories; the prism is a preliminary solid, whereas mobius strip is
complex surface.

38

See Appendix H.1.
See Appendix G.1.
40
See page 44.
39
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Triangular Prism

Right Circular Cone

Mobius Strip

Table 7: The three geometries that were created in the confirmation method’s experiments.

The five students examined Rhinoceros in the first experiment to create the three
geometries, whereas they examined Revit Architecture in the second experiment to create
the same geometries. The decision of working on Rhinoceros in the first experiment is
due to the inflexibility of Revit architecture which might lead the participants to get tired
early and to feel bored immediately if they worked on Revit first. These feelings have a
significant effect on the results of the experiments, and might drive the students to leave
the experiment before completing the creation process.

An additional online questionnaire41 was answered by the participants directly after
completing their work on both experiments. This post-questionnaire helped the
participants to evaluate their second experiment with Revit Architecture. They were
asked about their satisfaction with the results of the experiment, their evaluation of the
interface of Revit and other personal views about the software and the experiment. The
entire process of the confirmation method lasted about an hour and a half.

41

See Appendix G3.
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The following table shows the hardware and softwares that are used in the confirmation
method:

Hardware and software for

Hardware

Software

Recording the process of
Experiment

•

•

•
•
•
•
•

•
•

•

•
•

Computer model:
MacBook Pro 2009 
Processor: Intel (R) Core
(TM)2 Duo T9550@ 2.66
GHz 2.66 GHz
Display:1920X1200
Memory: 4.00 GB 
Disk Storage: 296 GB 
System type: 64-bit
Operating System
Window Edition:
Windows 7 Interprise
2009
Web Camera:
-----------------Video Card:
NVIDIA Geforce 9600 M
GT 8.15.11.8684
Speakers & Microphone:
Realtek High Definition
Audio 6.0.1.5936
Mouse driver: HIDcompliant mouse.
Mouse brand:
- Logitech
- Microsoft
3-button with scroll
wheel.

•

•

Autodesk Revit Architecture
2011 x64 , 2010 
Rhinoceros 4.0 SR5b, 2009.

•
•

•
•

Video Digital Camera
Speakers & Microphone:
Realtek High Definition
Audio
6.0.1.5936
Camtasia Studio 2.0.0.47,
2010.
Mousetron 6.1

Table 8: Shows the used hardwares and softwares in confirmation method.
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Chapter 4. Analysis Process

This chapter presents the data that were collected in the methodology. The methodology
is composed of two sub-methods: main method, and confirmation method as shown in
Diagram 8. In the main method, the researcher was the only participant in the simulation
process of GGDA, whereas five students in the college of Architecture in UNL were the
participants in the confirmation method.

Simulation
Process

Main Method

Confirmation
Method

Researcher

Students

Diagram 8: The diagram shows the methods of the simulation process,
and the participants of each method.

The analysis process of the collected data is the same for both methods. Independent
variables on page 44 were considered significantly in the analysis process. These
variables differ in each method and also differ for each participant. They have a great
impact on the results. In the next sections, the analysis process of each method is
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explained in detail, and the obtained data are available in the appendices at the end of this
thesis.

4.1. Analysis Process of the Main method
In the main method, the researcher conducted 91 trials42 of 50 experiments43 of creating
geometries. The process took five months to be ended; it started in September 19, 2010,
and ended in February19, 2011.

Researcher's Experiments

Revit Architecture

Rhinoceros

Total
Number of

Number of

Geometry

Successful

Failed

Successful

Failed

experiments

Geometries

Preliminary solids

8

8

0

8

0

16

Secondary solids

9

7

2

9

0

18

Complex Solids

1

0

1

1

0

2

Preliminary Surfaces

3

3

0

3

0

6

Secondary Surfaces

3

3

0

3

0

6

Complex Surfaces

1

1

0

1

0

2

Total

25

22

3

25

0

50

Table 9: Shows the number of successful and failed experiments
that were done by the researcher for each software

It is observed that Revit Architecture has succeeded in 88% of the experiments by
creating 22 geometries of the total 25, whereas Rhinoceros achieved 100% of the
geometries. A slight difference can be noticed in the results of the number of successful
42
Trial is the attempt that the user tries to create the geometry in the experiment; and it could be successful or failed
trial. See Diagram 5 on page 55.
43
Experiment means the process of creating one geometry in one software. See Diagram 5 on page 55.
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experiments, and the good achievement of Revit in creating the geometries. On other
hand, the Table 9 illustrates different results in the comparison between the number of
successful and failed trials:
Researcher's Trials

Revit Architecture

Total

Rhinoceros

number of

Geometry

Successful

Failed

Successful

Failed

Preliminary solids

19

12

10

0

Secondary solids

15

7

10

0

Complex Solids

1

1

2

0

Preliminary Surfaces

3

0

3

0

Secondary Surfaces

3

0

3

0

Complex Surfaces

1

0

1

1

Total

42

20

29

1

Time spent

7:24:38

16:28:29

2:33:23

0:31:58

Trials

41
32
4
6
6
3
91

Table 10: Shows the number of successful and failed trials
that were done by the researcher for each experiment.

The Table 10 demonstrates the number of successful and failed trials that were conducted
by the researcher. It is noticeable that the researcher worked on 62 trials in Revit to
achieve 22 successful experiments (Table 9) in approximately 23 hours of time.
However, she worked on only 30 trials in Rhino to achieve the 25 successful experiments
(Table 9) in estimated three hours of time. It is also obvious that the researcher spent
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about 16 hours working on 20 unsuccessful trials in Revit Architecture, whereas she
worked on 42 successful trials in about seven hours. This means that for each failed trial
in Revit Architecture, there are two successful trials with rate of 50 minutes of wasted
time to 20 minutes of productive time in Revit Architecture.
In the case of Rhino, the researcher spent half an hour on one failed trial, while she
worked on 29 successful trials in two hours and a half. Accordingly, for each failed trial
in Rhino there are 29 successful trials with rate of 30 minutes of wasted time to 150
minutes of productive time in Rhinoceros.

In Table 9, the results showed the significant achievement of Revit Architecture in
creating 88% of the listed geometry. Whereas in Table 10, the results demonstrate the
difference in the ratio between the wasted and productive time, and illustrate the
considerable distinction in the ratio between the failed and successful trials.

Number of Trials & Experiments

The Number of of Trials & Experiments in the Main Method
45
40
35
30
25
20
15
10
5
0

Successful

Failed

successful

Revit Architecture

Failed

Rihnoceros

Trials

42

20

29

1

Experimets

22

3

25

0

Chart 4: The number of successful & failed trials and experiments in Rhino and Revit Architecture.
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The Time of Trials in the Main Method
19:12:00

Time hh:mm:ss

16:48:00
14:24:00
12:00:00
9:36:00
7:12:00
4:48:00
2:24:00
0:00:00

Successful

Failed

successful

Revit Architecture

Failed

Rihnoceros

Time of Trials

7:24:38

16:28:29

2:33:23

0:31:58

Time per Trial

0:10:35

0:49:25

0:05:17

0:31:58

Chart 5: Shows the difference in the time of trials between Revit Architecture and Rhinoceros.

Therefore, the independent variables that are listed and explained in the methodology
chapter on page 33 should be considered in the analysis process to identify the possible
impacts of them on the results.

4.1.1. The Independent Variables in the Main Method
The independent variables (IndV) are important factors in the analysis process of the
thesis's methodology. They are different from one participant to the other and from
experiment to another experiment. For that reason, the researcher specified these
variables in the methodology chapter before starting the analysis process. The
independent variables for the main method are divided in the following table:
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Constant IndV

Changeable IndV

Work place Environment

Good Environment

Computer’s Capabilities

Good Capabilities

Software Interface

Rhino

Revit

Useful

Moderate

Interface

Interface

Psychological &
Physical Aspects

Poor

User Attitude

Poor attitude

Previous Experience

Not Enough

Not Enough

Yes

Yes

Attitude

Previous Use in

User Expectations

Architectural Design

Table 11: demonstrates the IndVs in the main method.

With regard to the interface evaluation in the previous table, a comparison between the
interfaces of Revit Architecture and Rhinoceros was done by the researcher44. This
comparison is dependent on a criteria was accomplished by Han X. Lin, Yee-Yin
Choong, and Gavriel Salvendy (Lin et al. 1997, 276-277) to compare the usability of
different softwares. The comparison also was based on guidelines for interface comparing
by Sidney L. Smith and Jane N. Mosier (Smith and Mosier). The comparison found that
Revit's interface is superior with some factors on the interface of Rhinoceros. These
factors include the consistency, memory load, perceptual limitations and other options.
On other hand, Rhinoceros exceeds Revit with some other factors, for example the
compability, the flexibility and other factors are shown in Table 12. According to this

44

See Appendix D.
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comparison, Rhinoceros proved that its interface has the most factors that make it better
than the interface of Revit Architecture. This result was approved in the analysis process
of both methods: main and confirmation methods. The next table shows the final results
of the comparison.
Usability Evaluation Factor

Revit Architecture

Rhinoceros

(MMF)
Compability

2.545

3

CONSISTENCY

20

17.5

FLEXIBILITY

8.5

9.5

LEARNABILITY

0.5

3

MINIMAL ACTION

5.5

6

MINIMAL MEMORY LOAD

5

5

PERCEPTUAL LIMITATION

4.5

4

3.5

5

13.5

13

USER GUIDANCE
Other Options

Table 12: illustrates the results of the comparison between the interface
of Revit and the interface of Rhinoceros.

The next diagrams illustrate the constant variables for the user in the main method. These
constant variables cannot be changed in any of the experiments as long as it is the same
user in all of them. They include work place environment and computer's capabilities.
While User Attitude, Previous Experience and Interface are changeable variables
according to the used software as well as the user.

45

These number are the number of Yes answers in the table of the comparison in Appendix D on page 202.
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Diagram 9: Shows the correlation between the IndVs of the researcher in Revit Architecture.
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Diagram 10: Shows the correlation between the IndVs of the researcher in Rhinoceros.
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4.1.2. Analysis Strategy of the Main Method
The collected data from the experiments are the DepVs that are listed in the methodology
chapter46. These data were analyzed using the IndVs as shown in the Diagram 1147. The
primary data are gathered and collected in a table in Appendix B. They include: Steps,
Clicks, Time and difficulties for each experiment.

Diagram 11: explains the table that contains the collected data, and the results of the main method.

In the analysis process of the collected data in Diagram 11, the successful or failed result
of the experiment is the first DepV that is observed. Time, steps and clicks are considered
after ensuring the success of both experiments for the same geometry. If one of the
experiments failed, then these variables are not considered in the analysis process.

46
47

See page 51.
See Appendix E.
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Independent Variables are considered at the final step of the analysis process. They lead
to the reasons of the experiment's failure or success. The following diagrams are
examples of the strategy that was followed in analyzing the collected data, and can be
found in Appendix C.1.

Diagram 12: Illustrates the strategy that was used in analyzing the results of each experiment.
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The previous diagrams illustrate five types of result: Revit is Incredible, Revit is Great,
Revit is Good, Revit is Poor and neutral result. Each of these results is depending on
specific criteria as follows:

•

Revit has Incredible ability: means that Revit is able to create the geometry
much better than Rhino. Revit in that case excelled Rhino in the success of the
experiment, or excelled Rhino in creating the geometry in less time with fewer
steps and clicks in spite of the poor IndVs that the participant or the experiment
has.

•

Revit has Great ability: means that Revit is able to create the geometry with
equivalent abilities with rhino or better. Revit in that case exceeded Rhino in the
success of the experiment in spite of the equality of the IndVs for the two
softwares, or it succeed in the experiment as well as Rhino despite the poor IndVs
that the participant or the experiment has during the work on Revit.

•

Revit has Good ability: means that Revit is able to create the geometry, but not
better than Rhino. In that instance, Revit exceled Rhino in the success of the
experiment or achieved the experiment in less time with fewer steps and clicks
because of the good IndVs that the participant or the experiment has in the both
cases.

•

Revit has Poor ability: means that Revit is not able to create the geometry. In
that case Revit did not succeed in the experiment in spite of the good or equal
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IndVs that the participant or the experiment has in comparing with the IndVs
during the work on Rhino.
•

The neutral result: means that the researcher cannot judge Revit because the two
softwares were not able to create the geometry.

The next table summarizes the previous criteria and the strategy that was followed in the
analysis process:

118

Step 1

Step 2

Observe the

If two experiment are

If one of the experiment are

If two experiments

experiment result

successful

failed

are failed

Compare time, steps and

Ignore time, steps and clicks.

clicks.

Consider the independent

Consider the independent

variables.

(Successful/ Failed).

Step 3

NA

variables.

Step 4

If Revit has Shortest time,

If Revit Succeeded +

Fewest steps and clicks +

Revit has Good

Better IndV

ability in IGP

Better IndV
If Revit has Longest time,
More steps and clicks + Better

Good ability

IndV
If Revit has Shortest time,
Fewest steps and clicks +
Worse IndV

If Revit Succeeded + Worse
IndV

Incredible ability

If Revit has Longest time,
More steps and clicks +Worse

Great ability

IndV
If Revit has Shortest time,
Fewest steps and clicks +
Equal IndV

If Revit Succeeded + Equal
IndV

Great ability

If Revit has Longest time,
More steps and clicks + Equal

Good ability

IndV
If Revit Failed + Equal IndV

Poor ability

If Revit Failed + Better IndV

Poor ability

If Revit Failed + Worse IndV

NA

Table 13: The strategy of the analysis process in the main method.
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4.1.3. Results of the Main Method
In this section, the results of the main method are presented and explained in detail. The
qualitative data was analyzed using the analysis strategy that was described in the
previous section. In addition, the quantitative data was analyzed using Descriptive
statistics. Descriptive Statistics "are used to describe the basic features of the data in a
study. They provide simple summaries about the sample and the measures. Together with
simple graphics analysis, they form the basis of virtually every quantitative analysis of
data."(Social Research Methods 2006). It was also used in the analysis process because
only six people are participated in both methods: main and confirmation method.
In the descriptive statistics analysis process, the Mean time and the Mean number of steps
and clicks were calculated to identify the average value for each software's experiment in
each geometry category. Standard Deviation is also calculated to confirm the validity of
mean values.

The Table 14 shows the final results of the main method's experiments. The results
demonstrate the success of Revit Architecture in most of the experiments of IGP. Revit
Architecture software was able to achieve 84% of the selected geometries. It succeeded in
creating preliminary solids, secondary surfaces, and complex surfaces, but it failed in
generating some secondary solids, and the complex solid. It can be noticed also that Revit
Architecture showed a Good ability in IGP stage with more than 50%, and proved Great
and Incredible abilities in more than 30% of the experiments.
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Ability Level

Geometry

Total
Incredible

Great

Good

Poor

NA

Preliminary solids

8

0

2

6

0

0

Secondary solids

9

3

1

2

2

1

Complex Solids

1

0

0

0

1

0

Preliminary Surfaces

3

0

1

2

0

0

Secondary Surfaces

3

0

0

3

0

0

Complex Solids

1

0

1

0

0

0

Total

25

3

5

13

3

1

Percentage

100

12

20

52

12

4

Table 14: demonstrates the abilities that Revit Architecture showed in the experiments of the main method.

The next chart illustrates the ability of Revit Architecture in creating each category of
geometries. These categories are arranged in the chart according to the chronology of the
creation process. It can be noticed that Revit Architecture showed good ability in creating
the preliminary solids, whereas it showed difficulties in creating the secondary and
complex solids. The success of Revit in the first category is related to the simplicity of
the preliminary solids. However, its failure in creating some of secondary and complex
solids is due to the lack of user's experience in using Revit Architecture.
The apparent success in the rest of the geometry categories is probably related to the
experience of using Revit that was gained by the researcher during the methodology
process which enabled her to discover new abilities in Revit Architecture.
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The Number of the Experiments that showed the ability

The Abilites of Revit Architecture in the Main Method
7
6
5
4

Incredible
Great

3

Good
2

Poor
NA

1
0
Preliminary Secondary
solids
solids

Complex
Solids

Preliminary Secondary
Surfaces
Surfaces

Complex
surfaces

The Geometry's Categories
Chart 6: shows the ability of Revit Architecture in creating each category of geometries.

4.1.3.1. Time, Steps & Clicks Results
Despite the obvious success that Revit Architecture achieved in creating about 88% of
selected geometries, Rhinoceros proves its superiority on Revit. Not only because it
created 100% of the selected geometries, but also because of the short time that was spent
in achieving this percentage. The experiments in Revit Architecture lasted about 23 hours
to achieve the 88% of the geometries, while in Rhino the experiments took approximately
three hours to create the entire list. Additionally, one failed trial confronts two successful
trials in Revit, whereas one failed trial parallel 29 successful trials in Rhino. This
concludes that the probability of a failed experiment occurrence in Revit Architecture is

122

1:2, which is a high proportion if compared with the same probability in Rhinoceros
which is 1:29.
In the case of time, 50 minutes of wasted time in Revit confronts 20 minutes of
productive time in the same software, whereas 30 minutes of wasted time in Rhino
parallel 150 minutes of productive time in the same software as seen in Chart 7. The
researcher worked on Rhinoceros about 1/3 of time that was spent to work on Revit. In
addition, 60% of the time that was spent on Revit was in the failed trials. No time was
wasted on the creation process of the surface geometries, because of the progression of
the user's experience in using Revit Architecture during the research period.

The Comparison of Wasted and Productive time in Revit & Rhino
16:48:00

16:28:29

Time (hh:mm:ss)

14:24:00
12:00:00
9:36:00
7:24:38
7:12:00
4:48:00
2:30:00 2:33:23

2:24:00

0:50:00
0:20:00

0:30:00 0:31:58

0:00:00
Revit Architecture

Rhinoceros

Wasted Time per trail

Productive time per Trial

Total Wasted time

Total Productive Time

Chart 7: illustrates the difference of wasted and productive time in Revit & Rhino.
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The next tables illustrate the comparison between Revit Architecture and Rhinoceros in
the total and the average of time, steps, and clicks. In the case of the total time
comparison, it was found that the total time of Rhinoceros's trials was less by one-third
of the total time of Revit's trials as well as the case of the average time.
Total Values

Revit Architecture

Rhinoceros

Geometry

Time

Steps

Clicks

Time

Steps

Clicks

Preliminary solids

7:11:20

203.00

2582.00

0:11:40

73.00

248.00

Secondary solids

11:57:16

191.00

5510.00

1:01:24

181.00

2853.00

Complex Solids

0:52:47

0.00

0.00

0:23:26

66.00

1208.00

Preliminary Surfaces

2:04:59

89.00

5367.00

0:24:45

74.00

276.00

Secondary Surfaces

1:25:31

86.00

3722.00

0:19:22

64.00

590.00

Complex Solids

0:21:14

33.00

1629.00

0:44:44

34.00

605.00

Total

23:53:07

602.00

18810.00

3:05:21

492.00

5780.00

Table 15: illustrates the comparison between Revit Architecture and Rhinoceros
in the total of time, steps, and clicks

Average Values

Revit Architecture

Rhinoceros

Geometry

Time

Steps

Clicks

Time

Steps

Clicks

Preliminary solids

0:14:52

25.38

184.43

0:01:10

9.13

31.00

Secondary solids

0:34:09

27.29

612.22

0:06:08

20.11

285.30

Complex Solids

0:26:23

0.00

0.00

0:05:51

33.00

604.00

Preliminary Surfaces

0:41:40

29.67

1789.00

0:08:15

24.67

92.00

Secondary Surfaces

0:28:30

28.67

1240.67

0:06:27

21.33

196.67

Complex Surfaces

0:10:37

33.00

1629.00

0:14:55

34.00

605.00

Total

0:26:02

24.00

909.22

0:07:08

23.71

302.33

Table 16: illustrates the comparison between Revit Architecture and Rhinoceros in the average of time,
steps, and clicks
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In the comparison process between the total and the average number of steps between
Revit and Rhinoceros, the secondary and complex solids categories were excluded as
illustrated in both Table 15 and Table 16 with red colored cells, because of the three
failed experiments in these categories. In the instance of failed experiments, the steps are
not documented and counted, so the result would have been inadequate if these categories
were involved in the comparison. According to the comparison of results, the total
number of steps in Rhino's experiments is 7:9 the total number of steps in Revit. A
similar ratio which is 6:7 was also found in comparing the average number of the steps in
the both software. This means that Rhinoceros needs the three-quarters of Revit's steps to
perform the same tasks. At the same conditions, it was detected that Rhinoceros
consumed the quarter number of clicks that were used in Revit. Chart 8, Chart 9, Chart 10
and Chart 11 demonstrate the comparisons between the total and the average number of
steps and clicks between Revit and Rhino. The dashed bars indicate to the eliminated
solid categories from the comparisons.
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The Comparison of Grand Total Number of Steps between Revit & Rhino
2500.00

Total Number of Steps

2000.00

1500.00

1000.00

500.00

0.00

Preliminary
Solids

Secondary
Solids

Complex
Solids

Preliminary
Surfaces

Secondary
Surfaces

Complex
Surfaces

Steps in Revit

2030.00

1910.00

0.00

890.00

860.00

330.00

Steps in Rhino

730.00

1810.00

660.00

740.00

640.00

340.00

Chart 8: The comparison of grand total number of Steps between Revit Architecture and Rhinoceros.

The Comparison of Average Number of Steps between Revit & Rhino

Average Number of Steps

2500.00

2000.00

1500.00

1000.00

500.00

0.00

Preliminary
Solids

Secondary
Solids

Complex
Solids

Preliminary
Surfaces

Secondary
Surfaces

Complex
Surfaces

Steps in Revit

253.75

272.86

0.00

296.67

286.67

330.00

Steps in Rhino

91.25

201.11

330.00

246.67

213.33

340.00

Chart 9: The Comparison of Average Number of Steps between Revit Architecture and Rhinoceros.

126
The Comparison of Grand Total Number of Clicks between Revit & Rhino
6000.00

Total Number of Clicks

5000.00

4000.00

3000.00

2000.00

1000.00

0.00

Preliminary
Solids

Secondary
Solids

Complex
Solids

Preliminary
Surfaces

Secondary
Surfaces

Complex
Surfaces

Clicks in Revit

2582.00

5510.00

0.00

5367.00

3722.00

1629.00

Clicks in Rhino

248.00

2853.00

1208.00

276.00

590.00

605.00

Chart 10: The comparison of grand total number of clicks between Revit Architecture and Rhinoceros.

The Comparison of Average Number of Clicks between Revit & Rhino
6000.00

Average Number of Clicks

5000.00

4000.00

3000.00

2000.00

1000.00

0.00

Preliminary
Solids

Secondary
Solids

Complex
Solids

Preliminary
Surfaces

Secondary
Surfaces

Complex
Surfaces

Clicks in Revit

184.43

612.22

0.00

1789.00

1240.67

1629.00

Clicks in Rhino

31.00

285.30

604.00

92.00

196.67

605.00

Chart 11: The Comparison of Average Number of clicks between Revit Architecture and Rhinoceros.
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4.2. Analysis Process of the Confirmation Method
In the confirmation method, the five participants worked on 33 trials of 12 experiments in
Revit Architecture as well as in Rhinoceros.

Student's
Experiments
Geometry
Preliminary
Solids
Secondary
Solids
Complex
Surfaces

Total

Revit Architecture
Number of
geometries

Successful

SemiSuccessful

1

4

0

1

1

1
3

Rhinoceros

Total
Number of
Experiments

Successful

SemiSuccessful

0

4

0

0

8

1

2

4

0

0

8

0

2

2

2

1

1

8

5

3

4

10

1

1

24

Failed

Failed

Table 17: Shows the number of successful and failed experiments that were done
by the students for each software.

It is noticeable the significant difference in the achievement of the students in creating the
three selected geometries as shown in Table 17. In Revit, the students succeeded in more
than 41% of the experiments, while in Rhinoceros they accomplished more than 80% of
the experiments. In other words, Revit Architecture made the half achievement of
Rhinoceros in confirmation method.

In the case of comparing between successful and failed trials in the Table 18, it can be
observed that the students worked on 16 trials in Revit Architecture. They only
succeeded in 31% of these trials to achieve the five successful experiments in
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approximately two hours and a half, whereas they worked on 17 trials to accomplish the
80% of the experiments in about an hour and a half. This indicates that for each failed
trial in Revit Architecture, there is one successful trial with rate of 12 minutes of wasted
time to 6 minutes of productive time. On other hand, one failed trial in Rhinoceros
confronts three successful trials with the rate of 9 minutes of wasted time to 2.5 minutes
for productive time. It is also worth mentioning that the students took an average time of
9 minutes to work on each trial in Revit, whereas they spent an average of 4 minutes in
each trial in Rhinoceros.

Student Trials

Revit Architecture

Rhinoceros

Semi-

Geometry

Successful

Semi-

Failed

successful

Success

Failed
Success

Preliminary solids

4

0

0

4

0

0

Secondary solids

1

1

2

4

0

0

Complex Surfaces

0

2

6

4

1

4

Total

5

3

8

12

1

4

0:20:53

0:28:01

1:35:13

0:28:38

0:03:12

0:35:06

Time spent

Table 18: compares between successful and failed trials in the confirmation method.

In the next chart, it is remarkable that Rhinoceros has more trials than Revit Architecture.
However, the participants of that method spent half of the Revit's time on the 17 trials in
Rhinoceros, and succeed in more than 80% of the experiments.

129

Number of Trials & Experiments

The Number of of Trials & Experiments in the Confirmation Method
14
12
10
8
6
4
2
0

Successful

Semi-Succ

Failed

successful

Revit Architecture

Semi-Succ

Failed

Rihnoceros

Experiments

5

3

4

10

1

1

Trials

5

3

8

12

1

4

Chart 12: shows the difference in the number of the trials and experiments between Revit Architecture and
Rhinoceros in the confirmation method.

The Time of Trials in the Confirmation Method
1:40:48

Time hh:mm:ss

1:26:24
1:12:00
0:57:36
0:43:12
0:28:48
0:14:24
0:00:00

Successful

Failed

successful

Revit Architecture

Failed

Rihnoceros

Time of Trials

0:48:54

1:35:13

0:31:50

0:35:06

Time per Trial

0:06:07

0:11:54

0:02:27

0:08:47

Chart 13: Shows the difference in the time of trials between Revit Architecture and Rhinoceros.

In order to obtain an accurate judgment and an explanation of the results in the
confirmation method, IndVs should be considered as were considered in the main
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method. The pre-questionnaire48 that the students answered before they work on the
experiments in the confirmation method provided the researcher with the IndVs of the
experiments. The consideration of these IndVs validates the results of the confirmation
method.

4.2.1. The Independent Variables in Confirmation Method
The independent variables in the confirmation method are also divided into constant
IndVs and changeable IndVs. The constant IndVs are the same for all participants and
cannot be changed, such as work place environment, computer's capabilities and software
interface. On another hand, changeable IndV are different from one participant to
another. Table 9 lists these variables in the confirmation method:
Constant IndV
Work place
Environment
Computer’s
Capabilities

Software Interface

Changeable IndV
Good Environment

Psychological & Physical Aspects

Good Capabilities

User Attitude

Rhino

Revit

Previous Experience

Useful
Interface

Moderate
Interface

Previous Use in Architectural Design
User Expectations

Table 19: shows the IndVs in the confirmation method

The next diagrams illustrate all the IndV of the confirmation method, and demonstrates
the relationship between these variables. It also shows the constant and the changeable
48

See Appendix G.1.
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variables, and the possible results of each one. For example, user's attitude has two
possible outcomes. If the user desired to learn Revit/ Rhino, and was enjoying the use of
it, then s/he has a good attitude towards the software. The good attitude affects positively
on the performance of the user. This positive effect contributes effectively to the result of
the experiment.
User Attitude (Wanted to learn the software+ Enjoys using it) >
Good attitude > Successful Result
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Diagram 13: The IndVs in the confirmation method and the correlation between these variables and the
possible results of the experiments in Revit Architecture.

133

Diagram 14: The IndVs in the confirmation method and the correlation between these variables and the
possible results of the experiments in Rhinoceros.

134

According to the results of the pre questionnaire49, the participants in the confirmation
method do not have good experience in using Revit Architecture, while they consider
themselves experts in using Rhinoceros. The good experience in using Rhinoceros might
have effects on the results of the experiments. It can be noticed that the student
accomplished good achievements in Rhino experiment. This experience provides the
students with previous knowledge about the techniques that might help to create the
geometries. This previous knowledge makes them work faster in the experiments of
Rhino than in the experiment of Revit. The next chart illustrates the difference in the
experience of the students in Revit Architecture and Rhinoceros depending on the prequestionnaire's results that included in Appendix G.2.

Students's Experience in Revit & Rhino
Number of answers

6
5
4
3
2
1

Did you
use?

How often?

How many hours?

Revit Architecture

You are….

No

Yes

Expert

Moderate

Beginner

More

10

4

2

0

Never

Sometimes

Rarely

always

No

Yes

0

Created
Geometries

Rhinoceros

Chart 14: illustrates the difference in the experience of the students in Revit Architecture and Rhinoceros
depending on the pre-Questionnaire's results.

49

See Appendix G.2.
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In addition to the participant's experience, the ambiguous interface of Revit and the poor
attitude of the participants towards Revit might have an effect also on the time. The
following chart clarifies the difference of student's attitudes and their expectations
towards both softwares according to the pre-questionnaire.

Students's Attitude & Expectations
16

Number of Answers

14
12
10
8
6
4
2

How did you learn?

What do you use it for?

Revit Architecture

Never

Difficult

Moderate

Easy to create

Everything

NA

Job

College Assignment

Other

By myself

Trainign Books

Training Videos

Private Training

College Course

0

Expectations

Rhinoceros

Chart 15: clarifies the difference of student's attitudes and their expectations towards both softwares
according to the pre-questionnaire.
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4.2.2. Analysis Strategy in the Confirmation Method
The same strategy of analyzing the collected data in the main method has been followed
in the analysis process of the confirmation method. This strategy is dependent on
analyzing the IndVs for each participant. These IndVs include: psychological and
physical aspects, attitude, previous experience and expectations of the participant.
Diagram 15 explains the table that included in Appendix F. This table contains the
collected data in the confirmation method, the IndVs of the participants and the result of
the analysis process.

Diagram 15: explains the table that contains the collected data, and the results of the confirmation method.

In the analysis strategy of the IndV in the confirmation method, participants are divided
into four categories dependent on the IndV as shown in Diagram 16. These categories
include:
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a) All IndVs are positive category: In this category, the IndVs of the participant are
all positive. For instance, a participant who: has a good previous experience in
Revit, feels comfort, used Revit in conceptual design phase, used Revit in creating
geometries for design concept, feels optimistic about the results of the experiment,
and has a good attitude belongs to this category because s/he has all positive
variables in that case.
b) One negative IndV category: One negative variable makes the participant
belong to this category. An example of this participant: has a good previous
experience in Revit, feels discomfort, used Revit in conceptual design phase, used
Revit in creating geometries for design concept, feels optimistic about the results
of the experiment, and has a good attitude.
a) Two or three negative IndVs category.
b) Four or more negative IndVs category.
c) All IndV are negative category.
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Diagram 16: illustrates the structure of the analysis process for the collected data
in the confirmation method.

The analysis process of the collected data is the same process in the main method. The
result of the experiment is the first step of the analysis. In the second step, the DepVs:
time, steps and clicks are considered in the case that both experiments in Revit and Rhino
for the same geometry are successful. The consideration of IndVs is the final step of the
analysis process. The participant in that step is identified to which category s/he is
belonging to. The following diagrams are examples of the strategy that was followed in
analyzing the collected data, and can be found in Appendix C.2.
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Diagram 17: shows two of the diagrams that were used in analysis the results of
the confirmation method’s experiments.
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The next table summarizes the strategy that was followed in the analysis process of the
confirmation method:
Step 1

Step 2

Observe the

If two experiment are

If one of the experiment are

If two experiments

experiment result

successful

failed

are failed

Compare time, steps and

Ignore time, steps and clicks.

clicks.

Consider the independent

Consider the independent

variables.

(Successful/ Failed).

Step 3

NA

variables.

Step 4

If Revit has Shortest time,

If Revit Succeeded +

Fewest steps and clicks +

Revit has Good

Better IndV

ability in IGP

Better IndV
If Revit has Longest time,
More steps and clicks + Better

Good ability

IndV
If Revit has Shortest time,
Fewest steps and clicks +
Worse IndV

If Revit Succeeded + Worse
IndV

Incredible ability

If Revit has Longest time,
More steps and clicks +Worse

Great ability

IndV
If Revit has Shortest time,
Fewest steps and clicks +
Equal IndV

If Revit Succeeded + Equal
IndV

Great ability

If Revit has Longest time,
More steps and clicks + Equal

Good ability

IndV
If Revit Failed + Equal IndV

Poor ability

If Revit Failed + Better IndV

Poor ability

If Revit Failed + Worse IndV

NA

Table 20: The strategy of the analysis process in the confirmation method.
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4.2.3. Results of the Confirmation Method
The analyzing process of the qualitative and quantitative data in the main method is also
pursued for the data of the confirmation method. The analyzing of the qualitative data of
IndV was explained in the previous section, while quantitative data of DepVs are
analyzed using the descriptive statistics.

In the tracking of IndV and DepV of the results in Appendix F, it can be noticed that
Revit Architecture achieved success in creating three different geometries by the
participants. Revit Architecture showed Great ability50 in creating the preliminary
geometry which is the prism, while it proved that it has Good ability in creating the
secondary solid "right circular cone" and the complex surface "mobius strip". The
software displayed 66% of Great and Good abilities50, whereas Poor ability50 had not
been showed in this method. The obvious difference in the results of the Table 17 and
Table 21 proves the significant impact of the IndVs on the final findings.
Geometry

Total

Incredible

Great

Good

Poor

NA

Preliminary solids

4

0

4

0

0

0

Secondary solids

4

0

0

2

0

2

Complex Surfaces

4

0

0

2

0

2

Total

12

0

4

4

0

4

Complex Solids
Preliminary Surfaces

Secondary Surfaces

Table 21: demonstrates the abilities that Revit showed in the confirmation methods experiments.

50

See page 116 for the definition of different abilities.
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The chart confirms the Great ability that Revit showed in creating the preliminary
geometry "the prism". This achievement is related to the simplicity of the geometry.
While Revit displayed Good ability in creating the secondary and complex geometries
"RC cone and mobius strip". Most of the participants did not succeed completely in
creating the mobius strip51, but their IndVs had justified their inability to create that
complex geometry.

Th eNumber of Experiments that showed the ability

4.5
4
3.5
3
Incredible

2.5

Great
2

Good

1.5

Poor
NA

1
0.5
0
Preliminary solids

Secondary solids

Complex Surfaces

Geometry's Categories
Chart 16: illustrates the abilities of Revit in the experiments of each geometry category
in the confirmation method.

4.2.3.1. Time, Steps & Clicks Results
It can be observed in Chart 12 the close number of the trials in both Revit Architecture
and Rhinoceros, but the difference in the time is significant and obvious. The students
51

See Appendix F.
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worked on 16 trials in Revit Architecture in two hours and a half, whereas they worked
on 17 trials in Rhinoceros in about hour and a half. In addition, one failed trial
confronts one successful trial in Revit, while one failed trial in Rhino parallels three
successful trials. Accordingly, the probability of failed experiment occurrence is 1:1 for
Revit Architecture, whereas the probability in Rhinoceros is 1:3. Revit’s probability in
the confirmation method is higher than the same probability in the main method which is
1:2, and Rhino’s probability in the confirmation method is lower than its probability
(1:29) in the main method.

In the case of the productive time that was spent in each software, there are adjacent
values. However, an apparent difference is detectable in the matter of the wasted time in
the two softwares. In Revit Architecture's experiments, the students wasted about one
hour and a half to realize the right ways of creating the geometries, thought they
consumed only half an hour to determine these ways in Rhinoceros. In other words, the
participants had three times the amount of the wasted time in Rhinoceros to configure the
suitable techniques in Revit Architecture. Conversely, different results appeared when the
time data was analyzed with different aspect. It showed that 12 minutes of wasted time
confronts 6 minutes of productive time in Revit with the ratio 2:1, whereas 9 minutes of
wasted time parallels 2.5 minutes of productive time in Rhino with 3.6: 1 ratio as shown
in Chart 17. It is notable from the previous ratios that Rhino has high proportion of
wasted time than Revit Architecture in spite of the good experience that the participants
have in working on Rhinoceros.
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The Comparison of Wasted and Productive time in Revit & Rhino
2:09:36
1:55:12

Time (hh:mm:ss)

1:40:48

1:35:13

1:26:24
1:12:00
0:57:36

0:49:37

0:48:54

0:43:12

0:31:50

0:28:48
0:14:24

0:12:00
0:06:00

0:09:00
0:02:30

0:00:00
Revit Architecture

Rhinoceros

Wasted Time per trail

Productive time per Trial

Total Wasted time

Total Productive Time

Chart 17: shows the difference of the time between Revit and Rhinoceros in the confirmation method.

The total and the average time of the experiments in the confirmation method are
exemplified in Table 23 and Table 23. Additionally, the total and average number of
steps of these experiments is included. In the case of click counting, the process did not
succeed due to technical problems during the experiment day. Therefore, the clicks
number analysis is eliminated from the analysis process.
In the case of the comparison of the total time, Rhinoceros showed superiority in time
saving. It saved about 40% of the time that was consumed in working on Revit. In the
case of the average time for each experiment, the results demonstrate that the average
time to finish an experiment in Rhino equals 44% of the average time for an experiment
in Revit. These results also contradict with the results of the comparison between the
wasted and productive time for each software.
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Total Values
Geometry Category

Revit Architecture

Rhinoceros

Time

Steps

Time

Steps

Preliminary solids

0:08:31

45.00

0:04:07

33.00

Secondary solids

0:27:13

66.00

0:03:40

67.00

Complex Surfaces

1:48:23

69.00

1:13:40

77.00

Total

2:24:07

180.00

1:21:27

177.00

Table 22: shows the difference between Revit and Rhino in accordance of the total values of time and steps
of the experiments of the confirmation method.

Average Values
Geometry Category

Revit Architecture

Rhinoceros

Time

Steps

Time

Steps

Preliminary solids

0:02:08

11.25

0:01:02

8.25

Secondary solids

0:06:48

16.50

0:00:55

16.75

Complex Surfaces

0:13:33

13.80

0:08:11

15.40

Total

0:07:30

13.85

0:03:23

13.47

Table 23: shows the difference between Revit and Rhino in accordance of the average values of time and
steps of the experiments of the confirmation method.

In the instance of comparing the total and average number of steps for each experiment in
the confirmation method, it is recognizable the clear proximity in the results. Despite of
the contradicted results in the total and average time that was spent in Revit and Rhino,
the total and the average number of steps is almost equal in both softwares. The equality
in the number of the steps in both softwares is due the lack of experience that the students
have in using Revit, and the good experience that they have in using Rhinoceros. The
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good experience in using Rhinoceros provides the students with previous knowledge
about the steps that might help to create the geometries. Chart 18 and Chart 19 illustrate
the comparisons between the total and the average number of steps in Revit Architecture
and Rhinoceros in the confirmation method.
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The Comparison of Grand Total Number of Steps between Revit & Rhino
90.00

Total Number of Steps

80.00
70.00
60.00
50.00
40.00
30.00
20.00
10.00
0.00

Preliminary solids

Secondary solids

Complex Surfaces

Revit Steps

45.00

66.00

69.00

Rhino Steps

33.00

67.00

77.00

Chart 18: The comparison of grand total number of steps in Revit Architecture and Rhinoceros.

The Comparison of Average Number of Steps between Revit & Rhino
90.00

Average Number of Steps

80.00
70.00
60.00
50.00
40.00
30.00
20.00
10.00
0.00

Preliminary solids

Secondary solids

Complex Surfaces

Revit Steps

11.25

16.50

13.80

Rhino Steps

8.25

16.75

15.40

Chart 19: The Comparison of average number of steps in Revit Architecture and Rhinoceros.

148

Chapter 5.

Conclusion

The purpose of this thesis as stated earlier is to investigate the capabilities of Revit
Architecture as one of BIM applications with a specific design approach GGDA. This
study examines the reliability of Revit Architecture, and awares the architects and
designers who adopted GGDA of the compability and reliability of the software. This
awareness provides them with explicit idea about the software and enables them to judge
its appropriateness with their ways of thinking.
The investigation of Revit Architecture's abilities and limitations in GGDA was based on
two methods. In the main method, the researcher explored Revit Architecture in all of
GGDA stages in comparing with Rhinoceros, whereas in the confirmation method, five
students examined Revit in the first stage of GGDA which is IGP stage.

5.1. The Conclusion of the Main Method
The final conclusion of the thesis can be obtained by applying the results of each method
on the hypothesis of the thesis. For the main method, the agreement of results with the
hypothesis is demonstrated in the next table:
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Hypothesis

Result

Autodesk Revit Architecture is able to create?

Incredible

Great

Good

Preliminary solids. 

20%

75%

Preliminary surfaces.

33%

67

11%

22%

Secondary solids.

33%

Secondary surfaces.

Poor

NA

22%

11%

100%

Complex solids.

100%

Complex surfaces.

100%

• Revit Architecture didn't create all the geometry categories.

Autodesk Revit Architecture has the ability of

• Revit has the ability to create all surface categories.

78% to work on Initial Geometry Preparation

• Revit has limitations in creating secondary and complex

stage in GGDA with limitation in work on solid

solids.

geometries.

• Complex solid and surface categories only included one
geometry, whereas secondary solids category included
nine geometries.
Autodesk Revit Architecture is able to create all solids in?

Autodesk Revit Architecture has limited ability to

• Shorter time than Rhino.

work on Initial Geometry Preparation stage in

• Fewer steps and clicks than Rhino.

GGDA.

Autodesk Revit Architecture is able to create all surfaces in:
• Shorter time than Rhino.
• Fewer steps and clicks than Rhino.
Autodesk Revit Architecture has the ability to create

Autodesk Revit Architecture is reliable to work

compound geometries.

on Geometry Configuration & Transformation
Stage in GGDA.

Autodesk Revit Architecture is able to create compound

Autodesk Revit Architecture has limited ability to

geometries in shorter time than Rhino.

work on Geometry Configuration &
Transformation Stage in GGDA.

Autodesk Revit Architecture has the ability to apply its

Autodesk Revit Architecture is reliable to work

components on all solids and surfaces.

on Form Recognizability Stage in GGDA.

Autodesk Revit Architecture is able to create apply the

Autodesk Revit Architecture has Great ability to

components in shorter time than Rhino.

work on Geometry Configuration &
Transformation Stage in GGDA.

Autodesk Revit Architecture 2011 is NOT reliable COMPLETELY to work with GGDA.
It has some limitations in IGP stage.
Table 24: shows the agreement of main method’s results with the hypothesis of the thesis.
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Diagram 18: The applicability of the results with Hypothesis diagram.
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According to the results of the main method and the previous hypothesis table and
diagram, it can be concluded that Revit cannot be reliable completely to work on GGDA
because of some limitations. Although the researcher did not create all the geometries
that are listed on page 41, Revit Architecture showed 78% of Good ability in IGP stage in
a period of five months. The researcher had to choose one geometry in both of the
complex solids and surfaces categories due to time constraints. On other hand, Revit
proves Good ability in GCT stage and Great ability in FR stage in consequence of the fact
that it is a BIM application.
The limitations that have effects on the reliability of Revit Architecture include the time
consumption. Revit Architecture requires long time to achieve the first stage of GGDA.
The results of the main method shows that Revit consumed approximately 24 hours to
show 78% of Good ability, whereas Rhino required four hours as maximum to achieve
100% of the experiments. The results illustrate also that the wasted time in Revit
Architecture is equal to 2.5 of its productive time. Accordingly, Revit Architecture
showed in the main method a limitation in the case of time manner in the first two stages
of GGDA which they are IGP and GCT.

The other limitation that contributes to the low reliability of Revit Architecture is the
insufficient flexibility and the ambiguity of its interface. The interface of Revit
Architecture showed low rate of compability, flexibility, and learnability when compared
with Rhinoceros's interface in Table 1252and Appendix D. For these low rates, the
number of steps and clicks are affected and increased, and more time is consumed. Low
52

See page 114.
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rate of learnability is related to the different format of Revit's interface from the standard
format of design software's interfaces. This difference makes it difficult on the user to
remember the places of the commands, the tabs and the icons on the interface. This
imperfection advances time consumption problem.

The creation process of geometries with pointed ends or parts in Revit Architecture such
as pyramid and tetrahedron is difficult to be managed at the beginning and requires long
time to be detected. For instance, the creation process of the pyramid in Revit required
some calculations to determine the appropriate height of the pyramid to the length of its
side. It also required to join four identical pyramids that have two perpendicular surfaces
as shown in Figure 74, and required to add a void prism at the bottom of each joined part
as a subtraction operation. This process lasted about two hours and a half to be
determined.

Figure 74: shows the creation process of pyramid

Figure 75: the pyramid in Revit Architecture.

geometry in Revit Architecture.

In addition to the previous limitations, there are some technical constraints that have an
impact on the flexibility of the work on Revit Architecture. These constraints include the
necessity to specify the work plane of drawing steps. For instance, drawing a vertical line
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in Revit requires a prior determination of a vertical work plane for this line. This process
requires three steps to be achieved. Besides, the levels in Revit that are created by
duplicating the first level whether in elevation, 3d, or section view don not appear
automatically in Project Browser which make switching between these views is difficult.
Therefore, the user should create these levels again in the Project Browser or create them
from the beginning.

5.2. The Conclusion of the Confirmation Method
The same process of acquiring the conclusion of the main method was pursued to obtain
the conclusion of the confirmation method. In this process, the results were applied on the
hypothesis table as follows:
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Hypothesis

Result

Autodesk Revit Architecture is able to create?

Incredible

• Preliminary solids. 

Great

Good

Poor

NA

100%

• Secondary solids. ≈

50%

50%

• Complex surfaces.≈

50%

50%

• Students didn't create all the geometries.

Autodesk Revit Architecture has the ability of 67% to

• All Students were able to create the preliminary

work on Initial Geometry Preparation stage in GGDA

solid "prism".

with limitations in working on the secondary solid and

• Students faced problems in creating the

the complex surface.

secondary solid and the complex surface.
Autodesk Revit Architecture is able to create all

Autodesk Revit Architecture has limited ability to

solids in?

work on Initial Geometry Preparation stage in GGDA

• Shorter time than Rhino.

in Time manner.

• Fewer steps than Rhino.≈
Autodesk Revit Architecture is able to create the

Autodesk Revit Architecture has good ability to

surface in:

work on Initial Geometry Preparation stage in GGDA
in the least possible number of steps.

• Shorter time than Rhino.
• Fewer steps than Rhino.
Autodesk Revit Architecture has the ability to

No Experiments.

create compound geometries.
Autodesk Revit Architecture has the ability to

No Experiments.

apply its components on all solids and surfaces.

Autodesk Revit Architecture 2011 is NOT reliable COMPLETLY
to work on IGP stage.

Table 25: shows the applicability of the results of the confirmation method with
the hypothesis of the thesis.
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Diagram 19: shows the applicability of the results of the confirmation method
with the diagram of the hypothesis.
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The results of the confirmation method and the results of the hypothesis table above
could not prove the hypothesis of the thesis. Some of the participants in the experiment
were not able to create some of the geometries in Revit Architecture especially the
complex surface. They justified these results to some limitation in Revit Architecture and
limitations in the experiment. Here are lists of the both limitations that the participants
mentioned in the post-questionnaire.

The limitations of Revit Architecture by the participants:
•

The ambiguity of Revit's interface makes it difficult for the user to realize the
places of the commands and icons which wastes a lot of time.

•

Revit Architecture offers limited options for the user if compared with the options
that Rhinoceros provides.

•

Revit Architecture has good ability in creating solids, but it has limitations in
creating complex surfaces.

•

Massing the concept in Revit is more difficult and complicated than create them
in other 3D softwares.

•

The only good feature of creating the mass in Revit Architecture is the
deformation process This process provide the user with the ability to drag and
move the corner points and edges of the form.
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The limitations of the experiment by the participants:
•

The geometries in the experiments were complicated and made the participants
feel frustrated, especially the mobius strip.

•

It was difficult for the participants to use the Mac computers during the
experiment, because they are used to work on Pc computers.

Pursuant to the confirmation method's results, Revit Architecture cannot be considered an
entire reliable to work on IGP stage of GGDA. Revit showed in this experiment 60 % of
Great and Good abilities, while other 40% of the result was neutral. On other hand, Revit
demonstrated a Good ability to achieve the successful experiments with fewer steps than
Rhinoceros. At the same time, it displayed a limitation in time manner. The results shows
that the wasted time in Revit is twice the productive time. However, this result is
considered good if compared with the proportion 3.6:1 of the waste time to the
productive time in Rhino. It cannot again be concluded that Revit has the full ability to
work on IGP stage because of the limited number of geometries that were created by the
students in this method as a result of the short time of the research and the limited time of
the experiment. Subsequently, Revit Architecture cannot be dependent entirely to work
on the first stage of GGDA due to a number of failed experiments in creating some of the
selected geometries.
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5.3. The Overall Conclusion
It can be concluded from the results of the main method and the results of the
confirmation method that Revit Architecture has some limitations in working on the first
stage of GGDA, and the users of GGDA cannot depend on it entirely in the conceptual
design phase. However, it showed Good ability to work on that stage with approximate
73%, and this ratio is considered a good result in comparing with other BIM application
such as ArchiCAD. This fact provides an indication of the development of Revit
Architecture application that obtained recently. Revit Architecture proved that it
combines between the abilities of NURBS modeling softwares and BIM applications in
the same time.

It is important to admit the fact that there is no software with the full specifications and
options, but it is also substantial to affirm that Revit Architecture is approximate to be
full and absolute software because it merges between some features of 3D modeling
which they are: solid modeling, surface modeling, and NURBS modeling, and between
the features of building information modeling like: building components, spatial
relationship, quantities and properties. It can be that integrated application if its
limitations has been adjusted and removed.
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Rhinoceros
Design Process

Application

Schematic Phase
Modeling the site

GGDA stages

Site analysis

Conceptual
Design Phase

Initial
Geometry
Preparation
IGP
Configuration
&
Transformation
GCT
Final Form
Recognizability
FFR

Architectural
Drawings
Detailed
Drawings

Autodesk
Revit
Architecture

ArchiCAD



















Excellent in

 Good in

creating solids and
surfaces.

creating solids and
surfaces with
some limitations

Excellent in

Good in

creating
compound
geometries.

creating
compound
geometries.

It doesn't have

Great in

components.

applying
components on the
created forms













 Good in
creating solids
but only for
creating other
components.

Table 26: illustrates a comparison between Rhinoceros, Revit, and ArchiCAD
in the phases of design process.

In the previous table, we can notice that Revit Architecture has most of the features of
both 3D modeling and Building Information Modeling. It has only some limitations in
working on IGP that make it not fully compatible with GGDA. The limitations include:
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Limitations

Explanation

Effect

Recommendation

Confused Interface

It doesn't follow the
standard format.

• Can't remember the
places of commands and
panels.

• The organization of the
tabs should be more
logic.
• Using labels that are
standard and
understandable.
• Adding customization
option to make the
interface more flexible.
• Switching between the
opened files should be
easier.
Make it possible to divide
to add control points on the
faces and make it easier to
drag them to different
directions.
The work plane changes
automatically as in other
3D modeling softwares.

• The user feel distract and
confused.
• Increase time consuming.
• Increase the number of
clicks.

Limited ability of
NURBS and
editing operations.

The user can only move the
corner points or edges, it is
difficult to add point on the
faces and drag them.

Can't create geometries
with pointed end or parts
easily as the pyramid or
the tetrahedron.

Work space is
limited to only one
axis.

The user only can work on
one axis for each step. It is
necessary in Revit to
change the work plane if
the user decided to work on
new axis.

• Time consuming.
• The user feel distract and
confused.
• Increase the number of
steps and clicks.

The levels should
be created in both
Project Browser
and the elevations
or other views.
The constrained
activity for some
commands.

New names and
notion of Boolean
operations.

• Time consuming.
• The user feel distract and
confused.
• Increase the number of
steps and clicks.
• Scale command works on • The user feel distract and
specific objects.
confused.
• Snap, Move, Copy and
• Inflexibility of work.
rotate commands are
• Limit the Intellectual
adhered to the specified
activity of the user.
work plane.
• Limited options of
drawing the polygons and
ellipse shapes.
Boolean operations in Revit • The user feel distract and
Architecture are presented
confused.
by different name. They are • Increase time consuming
presented by Join, Cut
to understand the new
commands in Geometry
notion and commands.
panel. And also presented
• missing the operation of
in Solid and Void options.
intersection which is
important.
• The problem of void
form that it can't be
deleted, it stays
connected with the
geometry and if the user
wanted to add another
form to it appears again,
and can't be hided.

The levels that are created
whether in the Project
Browser or views are added
automatically to all views
and vice versa.
Extend the activities of the
commands and loose their
boundaries.

Using the standard name
and the notion of Boolean
operations make it easier
for the user to find them
and work on them easily
because of his/her previous
background about them in
other 3D modeling
softwares.

Table 27: shows the limitations of Revit Architecture, their effects, and possible solutions for them.
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It is worth mentioning that the conclusion of this study is dependent on accurate results
and well organized analysis and hypothesis, but there were some limitations that might
affected the findings. The limited time of the research is one of these limitations. Seven
months to work on the thesis seems enough, but the late decision to have the confirmation
method’s experiment affected the timetable of the research. Accordingly, the researcher
focused on the first stage of GGDA in the confirmation method and chose to create some
of the geometries on page 41 in order to regulate the time of the experiment to be
compatible with the timetable of the research. Moreover, the preparation process for the
experiment of the confirmation method lasted about two months. The researcher faced
difficulties to find a suitable computer lab for the experiment and difficulties to have
volunteers for the experiment. This is in addition to the administrative obstacles that the
researcher confronted in terms of the delay of obtaining the permission to work on the
experiment, the delay of getting the permission to use the computer lab, and the
complicated procedures to install the softwares to the computers. These constraints
contributed to have the experiments in a late date. The experiments were carried out on
the 25th and 26th of February in 2011, a month before the deadline of the final research
submission, which make the opportunity to have an additional experiment is an
impossible idea.
Furthermore, the small sample of participants that took part in the both methods affected
the analysis process. The few number of participants led the researcher to depend on the
descriptive statistics to analyze the data instead of using more advanced analysis tests.
Ultimately, the psychological and physical aspects of the most participants in the both
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methods were clearly stressful and tired which have an impact on the results of the
experiments. These conditions are considered in the analysis process as one of the IndVs.

Even though this research may not cover all the aspects and may not comprehend all the
issues, this small piece of a study opens more comprehensive future studies about GGDA
and about other different generative design approaches. It is recommended for the future
studies about the compability of BIM applications with different design approaches to
have no limitations in the time of the researches and to have at least two experiments to
confirm the results. These experiments have participates with equal experiences. For
instance, it is advisable for any extended future study to work on a complemented
experiment with participants that have the same experience in working on Revit and
Rhino. The selection of the participants is important to achieve the goal of the
experiments. It is also recommended for the future studies to examine Revit Architecture
with more complex geometries and forms. And explore the compability of this software
with other generative design approaches.
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The Comparison between BIM applications
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Environmental
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Sketch/ drawing
Physical Model
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* eQuest60
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and files
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Structural
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Cost
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*
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*
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$ 5995 59

*
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*
$5,49553+54

NonMicrostation
users :

$6,290 55

Free
educational
version57

Professional
License:

*60
*60
* RSMeans60
*Network
License: $ 7500
+ $1500 annual
fee
*Non
subscription
8
version: $ 5000

$

Microstation

Academic
License:

users:

$ 15058

$1,495

*60
*60
*eQuest60
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Operating systems

Windows

Windows

Company

Autodesk 53

Bentely
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Windows/
Mac53
Graphisoft
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Windows

Windows/
Mac 59

Gehry
Technologies

Nemetschek
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Beck
Technologies60

53+ 58

Latest Version

Revit 2011

Bentley
Architecture
V8i

ArchiCAD 14

Digital
Project V1,
58
R4

Advantages

* Automated
updated
views.55
*New tools in
conceptual
massing.
*Great
enhancement in
interface tools
and menus.
* Good
documentation
abilities.
*Parametric
Modeling.
*Improvements
in display
options.
*New material
library.
* Speed up

* Automated
updated views.
*Sophisticated
abilities in
creating
conceptual
masses which
is considered
similar to
Sketchup
abilities.
*Active
Flexible views.
*Fast
performance.
*Wide-ranging

*automated
and manual
updated views.
*More
developed
collaboration
abilities.57

* Full
parametric
definition.
* Creating
complex and
parametric
53
geometry.
* Part file
storage
method.
* Producing
architectural,
structure, MEP
and
manufacturing
documents.58

53

interoperability.

*Good space
planning
abilities.
*Great

Allplan BIM
200962
*Quick
adoption by
AutoCAD
users/ Easy
learn53

*Create
complex
surfaces and
organic
shapes.59
* Wellorganized tool
and
interface.59
*All
discipliners
meet at the
same
application in
opposite of
other BIM
applications.

59

*Useful for
feasibility
study.53
*Quick
economic
assessment53
*Great in cost
estimation.
*Sketchup
Massing
capabilities.
*Detailed
tutorials.
*Quick and
easy to use.
*Exporting to
another BIM
by IFC.60

Chuck Eastman et al., BIM Handbook: A Guide to Building Information Modeling for Owners, Managers, Designers,
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53+ 54

Disadvantages

56

*Doesn't
Support
complex
curved
surfaces. 53
*Lacks in
conceptual
modeling
abilities in
comparing
with other BIM
applications.
* Complicated
conceptual
massing
interface.
*Minor
enhancements
in dealing with
large projects
and managing
the workflow.
*Poor
collaboration
skills.53+54

Rendering.
*Energy,
Structural, and
construction
analysis.
*Generative
Components
for parametric
design.55
*Parametric
56
Components.
*Difficult to
learn. 53
*Complex
software
interface and
commands.
*Poor Quality
documentatio
ns.55

*Not widely
cooperating
with other
applications.
*no
differentiate
between
Room/Spaces.
*Limited
conceptual
mass
abilities.57

* Complex
user Interface.
53

* High initial
cost.53
*Object library
is limited.5858

Not Parametric
Modeling/
limited
interface/
Slow because
of In memory53

* Multi files for
different
59

views.
*Open new
application for
each new
project.59
*Lack of
59
associativity.
*Poor quality
59
documents.
* Difficult to
learn.
*No tutorial.

59

*3D modeling
constrained.
*Poor room
layout.
*No model
integrity
checks.
*Complicated
cost interface.
*No wall,
window...etc.
tools.
*Difficult for
space
planning.60+61+
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04.12.2010 00:01:30D
18.02.2011

09.11.2010 00:02:19D

ArchiCAD

Revit
Architecture

09.11.2010

Rhino

1st Time

26.10.2010

Date

Revit
Architecture

Software

Comparison
Factor

a. Preliminary solids:

Solids:

Clicks

00:02:22D

00:13:00U
00:03:55D

00:00:43D

47
136

23

2nd Time
00:00:53D 37

Time

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.

Open Revit Architecture.
Choose New Conceptual Mass in families’ files.
Choose Mass in the dialog.
Select Manage tab.
Click on Project Units icon.
Activate Elevation view.
Click on Home tab.
Select Line icon in Draw panel.
Draw a triangular.
Select the vertical side of the triangular.
Press Delete.

GM
GM

10
*Go to elevation
*Select Model line.
*Draw a Triangular
*Go to 3D view
*Set the work plane on Tringular.
*Select Solid Revolve command in Form bar.
*Select boundary lines
*Select axis lines
* Click D sign

Default
Parametric
Sphere

MM

Notes

Default
Parametric
Sphere

* 3D Snapping in Generic Model file.
*cone can't be created in Mass Model, because has no Revolve
command.

Difficulties

* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Sphere in the list.
* Change parameters.
*Click OK.
* Click anywhere in the view.

1. Open Revit Architecture.
2. Choose New Conceptual Mass in families’ files.
3. Choose Mass in the dialog.
4. Select Manage tab.
5. Click on Project Units icon.
6. Modify the units depending on what you want.
7. Activate Level 1.
8. Click on Home tab.
9. Select circle in Draw panel.
10. Draw a circle on the view.
11. Activate 3D view.
12. Select the circle.
13. Click on Create Form>Solid Form.
14. Choose Sphere option that Revit offers.
*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Perspective view.
*Click on Sphere: Center, Radius icon.
*Select the center of the sphere in the view.
*Determine the radius manually or by writing it in command bar.

Steps

Main Method collected Data
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Cone

Sphere

Geometries

Comparison Factor
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09.11.2010 00:00:49

26.10.2010 00:01:16D

ArchiCAD

Revit
Architecture

09.11.2010 00:00:20

09.11.2010 00:01:12

00:35:00U

01:17:00D

27.9.2010

27.9.2010

Rhino

ArchiCAD

Revit
Architecture

11.11.2010

09.11.2010

Rhino

00:00:19D

00:00:42D

00:00:10D

28

34

15

Open Revit Architecture.
Choose New Conceptual Mass in families’ files.
Choose Mass in the dialog.
Select Manage tab.
Click on Project Units icon.
Modify the units depending on what you want.
Activate Level 1.
Click on Home tab.
Select Circumscribed Polygon icon in Draw panel.
Specify 3 in sides bar.
Draw a triangular in Level view.
Activate 3d view.
Select the triangular.
Click on create Form> Solid Form.

26
* Draw Rectangular
*Draw lines divide the Rec to 4 rectangulars.
* Set vertical work plane.

* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Prism in the list.
* Change parameters.
*Click OK.
* Click anywhere in the view.

*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Top view.
*Click on Polyline icon.
*Draw any closed shape.
*Activate Perspective view.
*Select the shape.
*Click on Extrude Planar Closed Curve.
*Specify the height of the prism.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.

*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Perspective view.
*Click on Cone icon.
*Specify the center of cone's base.
*Specify the radius.
*Specify the height.

12. Select line icon.
13. Draw a line that on the same extent of the deleted line but not connecting the endpoints of
the other lines.
14. Activate 3D view.
15. Select all lines.
16. Click on Create form> solid Form.
17. Choose Cone option that Revit offers.

* Only could create facet Pyramid ...not volume one.

* No 3D snapping, make it difficult to snap vertical line to the
horizontal ones.

MM
- Facet Pyramid
- 3D snapping
option

GM

Default
Parametric
Sphere

MM

MM

*Default
Parametric Cone.
*Same steps as
Sphere & Prism.

*Default
Parametric Cone.

Pyramid

Prism

174

04.02.2011 00:40:44D
18.02.2011
00:10:46D

682

*Draw vertical line in Rec center.
* Connect the edge points of Rec to the upper endpoint of vertical line with model lines.
*Select each 3 connected 3 lines to create a surface for the Pyramid.
*After selecting create Form and choose the surface option.
*Redo that step for each face.
*select the Rec and create form too, it will not give surface option, so create a box.
* Select the upper or under surface of the box and copy it.
* Delete the box.
*Move the Rec surface and connect it to other surfaces to create the Pyramid.
*Open Revit Architecture.
*Choose New Conceptual Mass in families’ files.
*Choose Mass in the dialog.
*Activate Lvel1 view.
*Select Manage tab.
*Click on Project Units icon.
* Modify the units depending on what you want.
*Activate Level1.
*Select Home tab.
*Click on Rectangular icon in Draw panel.
*Draw a rectangular 10mX10m for example.
*Select Line icon.
*Draw lines that present the diagonals of the rectangular.
*Click on Measure icon in Measure panel.
*Measure the distance between the half of diagonal.
*write it down.
*Try to calculate the height of the pyramid using Pythagoras theorem.
*activate any elevation view.
*Select Line icon.
*Draw the rectangular that present Pythagoras theorem.
*Activate 3D view.
*Select Line icon.
*Draw a line that connect the midpoints of the rectangular,
*Click on Reference Plane in Draw panel.
*Select the later line to create vertical work plane.
*click on Show in Work Plane panel.
*Select Line icon.
*Draw a vertical line that start from the center of the rectangular with the distance of pyramid's
height.
*Select Line icon.
*Check 3D Snapping.
*Draw lines connect the peak of vertical line with the corner points of the rectangular.
*Select Copy icon in Modify panel.
*The rectangular is divided to four similar triangulars.
*Select one of the triangulars with the vertical line and diagonal lines.
*Select copy icon.
*drag a copy.
*Select the triangular again.
*Click on Create form>Solid form.
*Extrude the upper surface of the prism to reach the peak of the pyramid's height + 1 meter.
*Select the side of Prism that measure 10 meter (The longest one).
*Click on Set icon in Work Plane panel to make it as work plane.
*Select Line icon.
*Draw a line that measure 1 meter vertical on a vertical edge of the previous side.
*Select the upper horizontal edge of that side,
*Drag it down to reach the end point of the vertical line that we draw lately.
*Select the side that remains vertical below.
*Click on Set in Work Plane panel to make it the work plane.
*click on Rectangular icon in Draw panel.
*Draw a rectangular over the remaining side and applicable to it.
*Select that rectangular.
*click on Create Form>Void Form.
*Extend the resulted form.
*Select the previous rectangular.
*enter Delete.
*Activate Level1 view.
*Select all the resulted form.
*Click on Rotate icon in Modify panel.
*Drag the center of rotation to be on the peak of the pyramid.
*Check Copy.
*Rotate the form 900.
*Do the rotation process again to create other two forms which will result a pyramid at the end.
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*Open Revit Architecture.
*Choose New Conceptual Mass in families’ files.
*Choose Mass in the dialog.
*Activate Lvel1 view.
*Select Manage tab.
*Click on Project Units icon.
* Modify the units depending on what you want.
*Select Home tab.
*Select Circle icon in Draw panel.
*Select the center of the circle on the view.
*Specify the radius of the circle.
*Activate 3D view.

*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Perspective view.
*Click on cylinder icon in toolbar.
*Specify the center of the cylinder in the view.
*Specify the radius.
*Specify the height.

MM

*Default
Parametric
Cylinder.
*Same steps as
Sphere & Prism.

MM

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.

Open Revit Architecture.
Choose New Conceptual Mass in families’ files.
Choose Mass in the dialog.
Select Manage tab.
Click on Project Units icon.
Modify the units depending on what you want.
Activate Level 1.
Click on Home tab.
Select circle in Draw panel.
Draw a circle on the view.
Activate 3D view.
Select the circle.
Click on Create Form>Solid Form.
Choose Cylinder option that Revit offers.

*Default
Parametric Cone.

* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Pyramid in the list.
* Change parameters.
*Click OK.
* Click anywhere in the view.

*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Perspective view.
*Click on Pyramid icon in toolbar.
*Specify the number of pyramid's sides to 4 sides in Command bar.
*Press Enter.
*Specify the center of Pyramid/s base.
*specify the circumscribe of the base.
*Specify the height.
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*Open Revit Architecture.
*Choose New Conceptual Mass in families’ files.
*Choose Mass in the dialog.
*Activate Lvel1 view.
*Select Manage tab.
*Click on Project Units icon.
* Modify the units depending on what you want.
*Select Home tab.
*Select Partial ellipse in Draw panel.
*Draw partial ellipse in Level 1 view.
*Select Line in Draw panel.
*Draw a line that can be the axis for the arc.
*Select the line and the arch.
*Click on Create Form in From panel.
*Click on Solid Form icon.
*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Perspective view.
*Click on Ellipsoid; From Center.
*Specify the center point of the ellipsoid.
*Specify the first radius of the first ellipse.
*Specify the second radius of the first ellipse.
*Specify the radius of the second ellipse.

*Select the circle.
*Click on Create Form > Solid Form....in Form panel.
*Select Sphere option that Revit offers.
*Select the upper part of the sphere.
*Click on Edit Profile icon in Mode panel.
*Activate Level1 view.
*Select the arc profile.
*Select Partial Ellipse from Draw panel.
*Draw an ellipse as the profile of the sphere.
*Delete the original profile.
*Click on Finish Edit Mode icon in Mode panel.
*Open Revit Architecture.
*Choose New in families’ files.
*Choose Generic Model in the dialog.
*Activate Ref, Level view.
*Select Manage tab.
*Click on Project Units icon.
* Modify the units depending on what you want.
*Select Home tab.
*Click on Revolve icon in Forms panel.
*Select Partial Ellipse in Draw panel to create Boundary Line.
*Draw partial ellipse.
*Select Line icon.
*Draw a line connects the end points of the ellipse.
*Select Line icon to draw Axis Line.
*Draw a line over the previous line.
*click on finish Edit Mode icon to finish Revolve operation.
*Open New Conceptual Mass file.
*Click on Manage tab.
*Select Project Unit icon in Setting panel.
*Modify the units according to Generic Model file.
* Click on Load into Project icon to load the geometry to Mass file.
*Check the mass file name.
*Click OK.
* Activate Mass. File.
*Select the generic file from the Project Browser.
*Drag the file to the view and place it.
*Click on Load into Project icon.
*Select the project. File.
*Activate Project. File.
*Select the mass file from the Project Browser.
*Drag it to the view.
*Select Place on Work Plane icon in Placement panel.
*The problem of Generic Model that it should be loaded to
Mass. File then to Project. File to work on it. If it load directly
to Project. File then it can be considered there as Generic model
family not as a Mass. Therefore, Floors can't be added to the
geometry.
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*Open Revit Architecture.
*Choose New Conceptual Mass in families’ files.
*Choose Mass in the dialog.
*Select Manage tab.
*Click on Project Units icon.
*Modify the units depending on what you want.
*Click on Home tab.
* Activate Lvel1 view.
*Click on Reference in Draw panel.
*Select Circle icon in Draw panel.
*Draw a circle on Level 1 view.
*Activate 3D view.
*Select Reference again.
*click on Point Element in Draw panel.
*Specify a point on the circle.
*Select the point; a work plane will appear on the point.
*Select that work plane.
*Click on Set in Work Plane panel.
*Click on Show icon in Work Plane panel.
*Click on Model icon in Draw panel.
*Select Circle icon.
*Draw a circle on the work plane which its center is the point element.
*Select the both circles in the view.
*Click on Create Form>Solid Form.
*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Perspective view.
*Click on Torus icon.
*Specify the center of the torus.
*Specify the radius of the torus.
*Specify the second radius of the torus.

* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Ellipsoid in the list.
* Change parameters.
*Click OK.
* Click anywhere in the view.

MM
MM
GM
MM
MM
MM

*Try to create Tetra using lines and create form.
*Try to use Forms operation (Revolve).
*Revolve profile around triangular prism.
*subtract Prism again.
*Use Add Edge option and NURBS operation.

MM
Surface
Tetrahedron
MM

*That is tetrahedron with surfaces doesn't work to create floor
plans inside it.
*Try to create Tetrahedron with subtracting 3 triangular prism
of main triangular prism.
*You have to set Work plane for each step which has
difficulties to set it.
*Try to subtract 3 pyramids from triangular prism.

MM

*Prism Deformation and NURBS operations.

*Default
Parametric Part
of Ellipsoid.

Tetrahedron
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*Open Rhinoceros.
*Choose Meter/inch file.
*Select Line icon.
*Activate Top view.
*Select Line icon in toolbar.
*Draw a line with 30 meter length.
*Calculate the height of tetrahedron with 30 meter side.
*Select Line icon again.
*Draw a line with the height of tetrahedron's height that is perpendicular to the previous line and
starts from its midpoint.
*Draw the other sides of the triangular.
*Select Line icon again.
*Draw lines that connect between the corner point of the triangular with the midpoint of the
opposite site of that point.
*Click Distance icon.
*Calculate the distance between the intersection of the previous lines and one of corner points of
the triangular.
*Activate Perspective view.
*Click on Pyramid icon.
*Specify the number of pyramid's sides to 3.
*Specify the corner point of the pyramid to the previous calculated distance.
*Specify the height of the pyramid.

*Open Revit Architecture.
*Choose New Conceptual Mass in families’ files.
*Choose Mass in the dialog.
*Select Manage tab.
*Click on Project Units icon.
*Modify the units depending on what you want.
*Click on Home tab.
* Activate Lvel1 view.
*Select Line icon in Draw panel.
*Draw Isosceles Triangular with 30 meter side 'length for example.
*Select Line icon again.
Draw lines that divide to three small identical triangulars.
*Select the lines that create one of these three triangulars.
*Select Copy icon in modify panel.
*Drag a copy.
*Activate 3D view.
*Select the triangular.
*click on Create Form> Solid Form.
*Extrude the prism to the height of the tetrahedron + 1 meter.
*Select the largest side of the prism.
*Select Set in Work Plane panel.
*click Show in work Plane panel.
*Select Line icon.
*draw a line on the edge of the largest face that equal to 1 meter.
*Draw other line that connects the previous line with the other side of the face.
*Select the upper side of that face.
*Drag it with the arrow towards the horizontal line that you draw lately.
*Select the remained part of the face that is not slope.
*Select Set in Work plane panel.
*Select Rectangular icon in Draw panel.
*Draw a rectangular that bounder the remained face.
*Select that rectangular.
*click on create Form> Void Form.
*Click outside of the geometry to see the resulted geometry.
*Activate Level 1 view.
*Select the entire geometry with void part.
*Select Rotate icon.
*Move the rotation center towards the inner edge of the pyramid.
*check Copy box in upper bar.
*Rotate one copy.
*Repeat the steps... to create anther copy.
*Activate 3D view.
*Click on Join> Join Geometry.
*Select the three pyramids to joint them.

*Dividing the tetrahedron to three connected pyramids.
*I wasted a lot of time in repeating the same steps in creating
each geometry instead of creating one and copy it to other two
copies and connect them.

*Different way
of creating >
long method.
*Default
Parametric

MM
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Clicks

*Open Rhinoceros.
*Choose Meter/inch file.
*Select Line icon.
*Activate Top view.
*Select Polyline icon.
*Draw a rectangular with 10 meter for its sides.
*Select Line icon.
*Draw lines that present the diagonals of the rectangular.
*Select Line icon again.
*Draw Isosceles Triangular with 10 meter base to specify the height of the pyramid.
*Draw a line that connects between the peak of the triangular and the midpoint of its base.
*Select Vertical Dimension.
*click on the endpoint of the vertical line to get its dimension which represent the height of the
pyramid.
*Select Pyramid from Toolbar.
*Specify the number of pyramid's sides to 4 in command bar.
*Choose circumscribed option in command bar.
*Select the center point of the rectangular as the center point of the pyramid.
*Specify the circumscribe of the pyramid which is equal to the circumscribe of the rectangular.
*Specify the height of the pyramid by writing 10 meter in command bar.
*Select the pyramid.
*Select Copy icon from Toolbar.
*Drag a copy of Pyramid.
*Activate Left view.
*Select Rotate icon from the toolbar.
*Select the second pyramid and rotate it 1800.
*Drag it and connect to the base of the first pyramid.
*Select Union operation from Boolean operations.
*Select the two pyramids.
*Click Enter.

Steps

* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Pyramid in the list.
* Change parameters.
*Click OK.
* Click anywhere in the view.

Difficulties

Notes

*Default
Parametric Part
of Pyramid.

Octahedron

Geometries
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*Open Rhinoceros.
*Choose Meter/inch file.
*Select Line icon.
*Activate Top view.
*Select Polyline icon.
*Draw a rectangular with 10 meter for its sides.
*Activate Perspective view.
*Select Cube icon from Toolbar.
*Draw the base of the cube on the rectangular shape.
*Create cube with specific length.
*Activate Front view.
*Select Line icon.
*Draw a isosceles triangular with 300 on the top of the cube.
*Activate Perspective view.
*Select the triangular.
*click on Copy icon.
*Drag a copy of the triangular to the opposite side of the cube.
*Select Line icon again.
*Draw a line that connects the peak point of the two triangulars.
*Activate Left view.
*Select Line icon from Toolbar.
*Draw a line that starts from the corner of the cube with 600.
*Activate Perspective view.
*Select Line icon.
*Draw two lines that connect the point of intersection between the line of 600 and the horizontal
line and with the corner point of the cube. That will create a sloped triangular with 600 with the
cube.
*Activate Right view.
*Select Mirror icon form Toolbar.
*Select the triangular and mirror a copy of it with center axis of the cube.
*Activate Perspective view.
*Select Line icon.
*Draw a line that connects the peak points of the two triangulars.
*Click on Surface menu> Planar Curve

* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Pyramid in the list.
* Change parameters :
No. of sides: 4
Cone Length: depend on the edge length (specific mathematic rules).
End mode: Custom.
Bottom Angle: 90
*Click OK.
* Click anywhere in the view.
*Copy the pyramid.
*Go to story view.
*Choose Multiply option>Drag.
*Select the new pyramid.
*Change parameters:
Angle to XY Plane: 270.
*Drag the pyramid and connect it with the other one.
*Open Design menu.
*Select solid element Operations.
*Choose Addition operation.
*Get Target.
*Get Operator.
*Click on Execute.
*Used Sphere with dividing its surface, but couldn't find
pentagonal system.
*Try to create the pentagonal system by creating new curtain
panel.
*Try dividing the dodecahedron to many small pyramids and
connect them to bigger pyramids to connect them which will
create dodecahedron.
*Start with cube and adding pyramids to different faces of the
cube.

* No rotation option in elevation view.

*Boolean
operation
method.
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Open Revit Architecture.
*Choose New Conceptual Mass in families’ files.
Choose Mass in the dialog.
Activate Lvel1 view.
Select Manage tab.
Click on Project Units icon.
Modify the units depending on what you want.
Click on Home tab.
Select one of Polygon icon in Draw panel.
To draw a polygon with 10 meter length side, you should calculate the diameter that can create
such polygon.
11. Select the polygon.

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.

*Select the lines of first triangular.
*Click Enter.
*Do the same with the second triangular.
*Click on Surface menu> Planar Curve
*Select Sweep 2 Rail.
*Select the two triangulars and the line that them.
*Click OK.
*Write Join on command bar.
*Select the surfaces of the created roof.
*Activate Left view.
*Select the roof.
*Select Copy icon.
*Drag a copy of the roof.
*Select Rotate icon.
*Rotate the copied roof vertically 90 0 and parallel to one of cube's sides.
*Repeat the process again for each side of the cube.
*Select Union icon.
*Select all Dodecahedron parts.
*Click Enter.
* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Cube in the list.
* Change parameters.
*Click OK.
* Click anywhere in the view.
* Click on Object in Toolbox.
* Select House Model in the list.
* Change parameters:
Width
Side Length
Roof Angle:30
Gutter Height:00
Footing Height:00
* Click on Object in Toolbox.
* Select Cube in the list.
*Rotate the cube to 30.
*Copy the cube by mirror command.
* Copy the House Roof and two cubes and rotate them to each side of the cube.
*On two of the cube sides, the Roof and 2 cubes should be rotated again.
* Make the roof group.
*Make the cubes in one group.
*change roof group to specific layer.
*Change cubes 'group to different layer.
*Open Design menu and select > element operation.
*Select Roofs as Target.
*Select Cubes as operators.
*Select Subtraction operation.
*Click Execute.
*Select Layer Settings in Toolbars.
*Hide Cubes Layer.
*Join all the parts of dodecahedron geometry by addition operation.

*To Draw a polygon in Revit with specific side length, you
should know the diameter first which need calculations and
take time.
*All the sides of Anti prism has same length, therefore you
should calculate the height of Ant-prism to achieve that.

* Connecting two hexagon with Create Form command.
*NURBS operations for Prism.
*Dividing Anti-Prism to small pyramids
*Subtracting pyramids from Prism by using Void forms.

*Long operation and a lot of steps.
*Rotation operation takes long time and a lot of steps.
*Subtraction operation made holes in the geometry.
*The resulted geometry was not perfect to use.

*Boolean
operation
method.

Anti-Prism

182

Rhino

16.11.2011 00:08:57D
Create Anti-prism
with equilateral
triangles faces.

00:13:08D

601

348

Click on Rotate icon in Modify panel.
Modify rotation center to one of corner points of the polygon.
Rotate the polygon to make one of its side is parallel to X axis.
Select Line icon.
Draw lines that connect between the corner point to the midpoint of the opposite side of the
polygon, that will help in specify the center point of the polygon.
17. Activate Elevation view.
18. Select the dashed line that present Level 1.
19. Press Ctrl.
20. Drag a copy of the level (Level 2).
21. Right click on Level 1 in Project Browser.
22. Choose Duplicate View> Duplicate.
23. Name the new level Level2.
24. Click OK.
25. Activate Level 1.
26. Select the polygon and the lines.
27. Click Copy icon in Modify panel.
28. Drag a copy a side.
29. Select the polygon and lines again.
30. In Modify/ Multi Select tab, Select Level 2 in Host bar.
31. Select Rotate from Modify panel.
32. *Place the rotation center on one of polygon's corner points.
33. Rotate the objects to make upper of polygon's side is parallel to X axis.
34. Drag the objects from center point to original polygon's center.
35. Activate 3D view to check that polygons are over each other.
36. Select Line icon.
37. Anti-prism with 10 meter polygon side, should has specific height, Draw a line that connects
two opposite corner points of the two polygons. The length of that line should be 10 meter.
38. If the length of that line is not 10 meter, then you should change the distance between the two
polygons to achieve that, so activate Elevation view.
39. Select the polygon in Level2.
40. Drag up or down depending on the length of the anti-prism side.
41. Activate 3D view.
42. Select the polygon at Level 1.
43. Click on Create Form> Solid Form.
44. Extrude the resulted prism to reach the upper polygon.
45. Select on one of vertical faces of the prism.
46. Click on Add Edge in Form element panel.
47. Draw an edge connect between the midpoint of the upper side of the selected face with the
corner point of the face.
48. Select the resulted largest face on the previous face.
49. Click on Add Edge again.
50. Draw an edge connect between the midpoint of upper side of the face with the other corner
point.
51. Activate Level 2.
52. Click on the point that divides the upper side of the previous face.
53. Drag it to corner point of Level 2 polygon.
54. Repeat the steps (48 - 53) to divide other four vertical faces.
55. In Level2, Select original corner points of the prism.
56. Drag them towards the center of the prism to create a side that connect between the new corner
points of the anti-prism.
57. Repeat the previous step to other four corner points.
*Open Rhinoceros.
*Choose Meter/inch file.
*Select Line icon.
*Go to Top view.
*Select point on the view.
*Specify the length of the line in Command bar.
*Select Polygon: Edge icon.
*Click on the end point of the line to draw the polygon.
*Click on the other end point of the line to complete drawing the polygon.
*Select Line icon.
*Draw lines connects between the midpoints of polygon's sides.
*Select Copy icon.
*Select the polygon.
*Drag a copy of the polygon.
*Select Move icon.
*Select the copied polygon.
*Drag the polygon over the original one.
*Select Rotate icon.
*Select the copied polygon again.

12.
13.
14.
15.
16.
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*Open Revit Architecture.
*Choose New Conceptual Mass in families’ files.
*Choose Mass in the dialog.
*Select Manage tab.
*Click on Project Units icon.
*Modify the units depending on what you want.
*Activate Level 1.
*Click on Home tab.
*Select circle icon in Draw panel.
*Draw a circle on the view.
*Activate elevation view.
*Select Level 1 elevation dashed line.
*Press Ctrl and drag a copy above.
*Activate Level 1 view.
*Right click on Level 1 in Project Browser dialog.
*Select Duplicate View> Duplicate.
*Name it Level 2.
*Activate Level 2 view.
*Select Circle icon.
*Draw a circle that its center is the same center of previous circle with smaller diameter.
*Activate 3D view.
*If the smallest circle is still in Level 1, select it again.
*Select level 2 in Host bar.
*Select both circles.
*Click on Create Form> Solid Form.

*Rotate it 900.
*Go to Front view.
*Select the copied polygon.
*Select Move icon.
*Drag the polygon vertically for about 10 meter.
*select Line icon.
*Draw a line connects faced points in polygons.
*Select Distance icon.
*Measure the distance of the line that connects two points. It should be 10 meters measure.
*If it is not; move one of the polygons to obtain the 10 meter distance Ant-prism side.
*Select Line icon.
*Draw lines connect the other points together to create the skeleton of anti-prism.
*Select surface in menu>Planar Curves.
*Select the first polygon.
*Click enter.
*Do the previous step to create plan for all Ant-prism faces.
*Write Join in Command bar.
*Select the surfaces of the ant-prism one by one.
* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Pyramid in the list.
* Change parameters.
*Click OK.
* Click anywhere in the view.
* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
* Select Pyramid again in the list.
* Change parameters to the same previous Pyramid settings:
Angle to XY plane:270
*Click OK.
*Place the pyramid on the edges of the other pyramid exactly.
*Rotate the pyramid.
*Make each pyramid in different layer.
*Open Design menu and select element operations.
* Select one pyramid as target.
*Other pyramid as operator.
*Select Intersection operation.
*Click Execute.
*Hide the operator pyramid layer.
*Long time to figure out the solution.

MM

MM

*Boolean
operation
method.
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5
*Go too Level
*Draw an ellipse.
*Go to 3D view
*Select the ellipse.
*Create form.

MM

MM

8
* Create an elliptical cylinder 5
*Select the upper or below surface of cylinder.
*Select scale command in modify bar.
*Scale the surface.

*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Top view.
*Click on Ellipse icon.
*Specify the center of the ellipse.
*Specify the radius of first ellipse.
*Specify the radius of second ellipse.
*Activate the Perspective view.
*Select the ellipse.
*open Surface> Planar Curves.
*Click on Extrude Surface Tapered.
*Select the surface.
*Specify the height.

*Default
Parametric Part
of Cone.

* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Cone in the list.
* Change parameters: Top Circular Radius> More than 0.
*Click OK.
* Click anywhere in the view.

*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Perspective view.
*Specify the center of the cone.
*Specify the radius of the cone.
*Specify the height of the cone.
*Specify the radius of the upper circle of the cone.

Elliptical Cylinder
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*Create a cone 10
*Create a polygon or rotated box:
- go to elevation
-Draw any shape can help.
- go to 3D view
-Select the shape.
-Create a form.
* Go to elevations and move the box or polygon to be placed with the cone.
*Go to 3D view
*select the box.
*Change it to void.
*Go to modify bar
*Select Cut Geometry
*Choose geometries to cut each other.
*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Perspective view.
*Click on Cone icon in toolbar.
*Specify the center of the cone.
*Specify the radius of the cone.
*Specify the height of the cone.
*Activate Top view.
*Select Surface menu>Plane> Corner to Corner.
*Draw a rectangular plane that surround the cone.
*Select the plane.
*Activate the Left view.
*Click on Move icon.
*Move the plane vertically to the middle of the cone.
*Click on Rotate icon.
*Specify the first point of rotation.
*Specify the second point of rotation.
*Rotate the plane about 300.
*Click on Boolean Split icon.
*Select the cone as the surface to be split.
*Press Enter.
*Select the plane as the cutting surface.
*Click Enter.
*Select the lower part of the cone and the plane.
*Press Delete.

*Click on Arc in Toolbox.
*Select Ellipse icon on default setting bar.
* Draw Ellipse on any stories view.
* Click on Slab in Toolbox.
*Use Magic Wand to create slab with elliptic shape.
*Click on the slab again.
*Change parameters.
*Open Story view.
*Select the slab.
*Go to: File>Libraries and Objects>Save Selection as.
*Name the object and save.
*Click on Object in Toolbox, you can find that the object was saved.
*Change parameters.
*Click Ok.

*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Top view.
*Click on Ellipse icon.
*Specify the center of the ellipse.
*Specify the radius of first ellipse.
*Specify the radius of second ellipse.
*Activate the Perspective view.
*Select the ellipse.
*open Surface> Planar Curves.
*Click on Extrude Surface icon.
*Select the surface.
*click enter.
*Specify the height.

* 22 steps is the minimum steps, the steps can be more due to
placing process.
* After Cut Geometry process, if we select the Oblique Cone,
the void geometry will appear in x ray mode. That's mean that
the void geometry will be always connected to the resulted
geometry and if deleted the original geometry will appear
again.

GM
GM

Oblique Circular
Cone

186

09.11.2010 00:01:14

19.9.2010 02:11:00
18.02.2011 00:01:53D
18.02.2011

09.11.2010

09.11.2010 00:01.18

26.10.2010
18.02.2011

ArchiCAD

Revit
Architecture

Rhino

ArchiCAD

Revit
Architecture

00:01:40
00:00:50D

00:04:33D

00:02:20D

67

206

186
201

6
* Select level
* Draw a Circle.
*Go to 3D view.
*Select circle.
* create Form.
*Select upper face.

* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Cone in the list.
* Change parameters:
Top Circular Radius>More than 0.
Top angle.
*Click OK.
* Click anywhere in the view.

*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Perspective view.
*Click on Cone icon in toolbar.
*Specify the center of the cone.
*Specify the radius of the cone.
*Specify the height of the cone.
*Activate Top view.
*Select Surface menu>Plane> Corner to Corner.
*Draw a rectangular plane that surround the cone.
*Select the plane.
*Activate the Left view.
*Click on Move icon.
*Move the plane vertically to the middle of the cone.
*Click on Rotate icon.
*Specify the first point of rotation.
*Specify the second point of rotation.
*Rotate the plane about 300.
*Click on Boolean Split icon.
*Select the cone as the surface to be split.
*Press Enter.
*Select the plane as the cutting surface.
*Click Enter.
*Select the upper part of the cone and the plane.
*Press Delete.

26
- Create an oblique Cylinder:
*Go to Level
*create a circle
*go to elevation
*Draw an oblique line
*Go to 3D
* move the line to center of circle
*Select the line
*set an oblique work plane??
*Draw an oblique circle
*Select the circle.
*Create Form
- Create a semi cone 11
* Move the oblique cylinder over the semi cone dependent on what RC cone the designer like.
*dissolve command doesn't work
*Select Cylinder
*In properties, change it to Void.
*Cut Geometry

* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Cone in the list.
* Change parameters:
Editing Mode" Angle-Length
Bottom Angle.
*Click OK.
* Click anywhere in the view.
* Create levels only work in elevations or sections.
* Difficulties with creating work plane, it takes long time to
create it.
*Cutting the geometry without change it to void, doesn't work,
because it will still appear and connect with the other geometry,
and if deleted it the cut geometry process will be cancelled.
*Boolean operations in Revit only limited in Join and Cut.

MM

MM

Oblique Circular
cylinder

Right Circular Cone
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09.11.2010 00:02:46

ArchiCAD

Rhino

Revit
Architecture

Software

Comparison
Factor

Create two
pyramids and
connect them to
Anti-Prism
geometry.

00:14:21D

Create AntiPrism.

16.11.2010 00:09:05D

Create two
pyramids and
connect them to
Anti-Prism
geometry.

00:21:04U

Create AntiPrism.

2nd Time

00:02:11D

Time

1st Time
01.02.2011 00:31:43D

Date

c. Complex Solids:

09.11.2010

Rhino

682

526

Clicks

141

*Open Rhinoceros.
*Choose Meter/inch file.
*Select Line icon.
*Go to Top view.
*Select Polygon: Edge icon.
*Write 5 as Number of polygon's sides.
*Select point on the view to start create the polygon.
*Write 10 meter in Command bar to specify the length of polygon's side.
*Press on Shift and select the end point of polygon's side.

Create Anti-Prism:

Steps

* Click on Object in Toolbox.
*Click on Object icon in the tool bar of Object.
*In Folder list select: ArchiCAD Library 14> Special construction> Basic shapes.
* Select Cylinder in the list.
* Change parameters:
End mode: Custom.
Bottom Angle.
Top angle.
*Click OK.
* Click anywhere in the view.

*Open Rhinoceros.
*Choose Meter/inch file.
*Select Line icon.
*Activate Top view.
*Click on Circle; Center, Radius icon.
*Specify the center and the radius of the circle on the view.
*Activate Left view.
*Click on Line icon.
*Draw a vertical slope line that starts from a point on the circumscribe of the circle.
*Activate Perspective view.
*Select the circle
*Select Surface>Planar curves.
*Click on Extrude Surface Along Curve icon.
*Select the circle as the surface to extrude.
*Press Enter.
*Select the line as the path of extrusion.
*Click enter.

*Move it.

Difficulties

Notes

Icosahedron

Geometries

Comparison Factor

188

*Select Polygon: Edge icon.
*Write 5 as Number of polygon's sides.
*Select point on the view to start create the polygon.
*Write 10 meter in Command bar to specify the length of polygon's side.
*Press on Shift and select the end point of polygon's side.
*Select Line icon.
*Draw lines that connect each corner point of the polygon with its opposite midpoint.
*Select Distance icon.
*Calculate the distance between the any corner point with the center point.
*Try to use Pythagoras theorem to calculate the height of the pyramid.
*Select Line icon.
*Draw a vertical line that present the height of the pyramid which starts from the center point of
the polygon.
*Select Line icon again.
*Draw lines connect between the end point of the vertical line with the corner points of the
polygon.
*Click on Surface in menu bar>Planar Curves.
*Select the polygon.
*Click Enter.
*Do the previous steps to create the sides of the anti-prism.
*Write Join in Command bar.
*Select the sides of the anti-prism.
*Press Enter.
*Select Move icon.
*Select the pyramid.
Drag it to be applicable on the ant-prism.
*Activate Front view.
*Select Mirror icon.
*Select the pyramid again.
*Draw a horizontal line that represents the mirror axis.
*Select move icon.
**Select the resulted pyramid.
*Drag it to be applicable on the other side of the ant- prism.
*Write Join in Command bar.
*Select the ant-prism + pyramids.
*Press Enter.

Create Icosahedron:

*click on Copy icon.
*Select the polygon.
*Drag a copy.
*Select the polygon again.
*Click on Move icon.
*Drag the new polygon to be applicable on the original one.
*Click on Rotate icon.
*Select the polygon.
*Click on the center of the polygon to rotate 450.
*Activate Front view.
*Click on Move icon.
*Drag the polygon vertically (try to drag the new polygon to achieve a distance 10 meter as the
vertical side of the anti-prism).
*Click on Distance icon.
*Calculate the distance between the points that create the vertical side of the anti-prism, make
sure it equals 10 meter.
*Click on Line icon.
*Draw lines that represent the sides of Anti-prism.
*Click on Surface in menu bar>Planar Curves.
*Select the polygon.
*Click Enter.
*Do the previous steps to create the sides of the anti-prism.
*Write Join in Command bar.
*Select the sides of the anti-prism.
*Press Enter.

189

Revit
Architecture

Software

Comparison
Factor

526

15.11.2010 00:15:04D

2nd Time

Clicks

1912

1st Time
00:25:00

Time

15.11.2010 00:43:40D

19.9.2010

Date

a. Preliminary Surfaces:

Surfaces:

13
*Go to level
*Create a Circle.
*duplicate level in Project browser.
*Rename level to level2
*Go to elevation.
*Duplicate level1
*Create an oblique line
*Go to 3D view
*Select line
*Set the work plane??
*Draw a circle on the oblique plane.
*Select two circles
*Create Form
Creating Hyperbola curves:
*Open Revit Architecture.
*Choose New Conceptual Mass in families’ files.
*Choose Mass in the dialog.
*Select Manage tab.
*Click on Project Units icon.
*Modify the units depending on what you want.
*Activate Level 1.
*Click on Home tab.
*Select Line icon.
*Draw Line represent X axis.
*Draw perpendicular line represent Y axis.
*Select Point Element icon in draw panel.
*Use Point element icon on Draw panel to divide axis lines to specific distance represent the
coordinates of axis.
*Calculate the coordinates of Hyperbola curve.
*Select Point Element icon.
*Draw points that represent the coordinates of hyperbola curve on the axis.
*Select Spline Through points icon in Draw panel.
*Draw a spline that connects the points to create hyperbola curve.
*Select the resulted curve.
*Select Mirror-Draw Axis icon in modify panel.
*Check Copy box.
*Draw the mirror axes following X axis.
*Select the resulted curve.
*Select Mirror-Draw Axis icon.
*Draw mirror axis following the line that represents the infinity point of hyperbola curve ( 
* Select Line icon.
*Draw a line that connects the two curves in peek point,
*Draw a perpendicular line to the previous line starting with its midpoint to create a symmetrical
axis to two curves.
*Select one of the curves and the axis line.
*click on Create Form> Solid Form.
*choose hyperboloid option that Revit offers.

Steps

MM

*There is a lot of calculation operations which takes time.
*I look tired in that experiment and did a lot of calculation
mistakes that is why it took long time to work.

MM

MM

* Work Plane setting take longer time than considered as one
step, sometimes it takes 3 or 4 steps to set it.

Difficulties

Notes

One Sheet
Hyperboloid

Geometries

Comparison Factor
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Revit
Architecture

Rhino

15.11.2010 00:06:36D

474

*Create hyperbola curves.

*Open Rhinoceros.
*Choose Meter/Inch file.
*Click on Curve (menu)> Hyperbola>Center, Focus.
*Select a point in Top view.
*Select another point on Top view.
*Choose the appropriate shape for the Hyperbola curve and click Enter.
*Select the curve again.
*click on Mirror icon.
*Draw the axis of mirror operation.
*Select Line icon.
*Draw a line connect between the peek points of the two curves.
*Select Line icon.
*Click on Midpoint of the connected line.
*Draw perpendicular line.
*Select Line icon.'
*Draw a line at the other side of the perpendicular line.
*Select Extend Curve icon.
*Select the random line.
*Click on the perpendicular line.
*Select the random line.
*Press Delete.
*Go to Front view
*Select Rotate icon.
*select the point of one side of axis line.
*Select the other point from the other side.
*Rotate vertically (900).
*Go to perspective view.
*Select the curves and axis line.
*Select Surface on menu>Revolve.
*Select one curve.
*Press Enter.
*Draw the axis of Revolve operation.
*Press Enter.
*Revolve (3600).
*Press Enter.

03.02.2011 00:14:14

114

*Go to Left view.
*Open Curve menu.
*Select Hyperbola (Center, Focus).
*Draw the hyperbola on the view.
*Go to Perspective view.
*Select the circle from the toolbar.
*Draw a circle connected to the end of hyperbola.
*Select the circle.
*Select copy command.
*Drag a copy of the circle to the other end of Hyperbola.
*Open surface menu.
*Select Planar curve.
*Select the first sphere.
*Select Planar curve again.
*Select the other circle.
*Open surface menu again.
*Select Sweep 2 trail.
*Select first surface.
*Select second surface.
*Select hyperbola.
*Click Enter.
*Click OK.
*Write Join in Command bar.
Select the surfaces.
*Click Enter to make the Hyperboloid a volume.

09.11.2010 00:03:35

Two Sheets
Hyperboloid

191

Create Paraboloid

00:05:30D

226

317

02.02.2011 00:10:29D

Revit
Architecture

Create Parabola
curve

140

03.02.2011 00:10:19

Rhino

Create Paraboloid:

Create Parabola curve:
1. Open Revit Architecture.
2. Choose New Conceptual Mass in families’ files.
3. Choose Mass in the dialog.
4. Select Manage tab.
5. Click on Project Units icon.
6. Modify the units depending on what you want.
7. Activate Level 1.
8. Click on Home tab.
9. Select Line icon.
10. Draw Line represent X axis.
11. Draw perpendicular line represent Y axis.
12. Select Point Element icon in draw panel.
13. Divide axis lines to specific distance represent the coordinates of axis.
14. Calculate the coordinates of Parabola curve.
15. Select Point Element icon.
16. Draw points that represent the coordinates of parabola curve on the axis.
17. Select Spline Through points icon in Draw panel.
18. Draw a spline that connects the points to create parabola curve.

*Click on line icon in Draw bar.
*Draw line connect between the midpoint of hyperbola curves and perpendicular to the axis of
hyperbola curves. This line is the perpendicular axis for hyperbola curves.
*Select one of hyperbola and the perpendicular axis.
*Click on Create form> Solid Form.
*Select other hyperbola.
*Select the axis.
*Click on Create Form> Solid Form.
*Open Rhinoceros.
*Choose Meter/Inch file.
*Click on Curve (menu)> Hyperbola>Center, Focus.
*Select a point in Top view.
*Select another point on Top view.
*Choose the appropriate shape for the Hyperbola curve and click Enter.
*Select the curve again.
*click on Mirror icon.
*Draw the axis of mirror operation.
*Select Line icon.
*Draw a line connect between the peek points of the two curves.
*Select Line icon.
* Draw a line at the side of Hyperbola curves.
*Select Line icon.
*Draw a line on the opposite side of the curves.
*Select Extend Curve icon.
*Select the lines on the sides.
*Click Enter.
*Click on the line that connect between curves,
*Click again to extent the line.
*Select the lines on the sides.
*Press Delete.
*Select the curves and axis line.
*Go to Front view.
*Select Rotate icon.
*Select the point on one side of the axis.
*Select on the point of the other side of the axis.
*Rotate the line vertically.
*Go to Perspective view.
*Select Surface from the menu>Revolve.
*Select two curves.
*Press Enter.
*Draw the axis for Revolve.
*Press Enter.
*Follow Revolve for 3600.
*Press Enter.

Paraboloid
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09.11.2010 00:00:12D

Revit
Architecture

Rhino

Revit
Architecture

Software

Comparison
Factor

Time

Create Parabolic
Cylinder

00:00:11 D

Create Parabola
curve

02.02.2011 00:10:29D

Create Hyperbola
CylinderD

00:01:04

Create Hyperbola
curveD

03.02.2011 00:02:58

1st Time
15.11.2010 00:07:14D

Date

b. Secondary Surfaces:

Rhino

2nd Time

6

317

28

57

571

Clicks

22

Create Paraboloid Cylinder:
*Activate 3D view.
*Select the spline.
*Click on Create Form>Solid Form.

Create Parabola curve.

*Open Rhinoceros.
*Choose Meter/inch file.
*Click on Curve (menu)> Hyperbola>Center, Focus.
*Select a point in Top view.
*Select another point on Top view.
*Choose the appropriate shape for the Hyperbola curve and click Enter.
*Select the curve again.
*click on Mirror icon.
*Draw the axis of mirror operation.
*Select both curves.
*Click on Extrude Closed Planar Curve icon.
*Select the height of the extrusion.

*Select two hyperbola curves.
*Click on Create Form> Solid Form.

*Create hyperbola curve.

Steps

*Select the spline.
*Click on Copy icon.
*Drag a copy of the spline.
*Select Line icon.
*Draw a line that divide the parabola curve to two identical parts.
*Activate 3D view.
*Select the curve and the line.
*Click on Create Form>Solid Form.
*Open Rhinoceros.
*Choose Meter/inch file.
*Activate Perspective view.
*Click on Paraboloid icon.
*Specify the paraboloid focus point.
*specify paraboloid direction.
*specify paraboloid radius.

Difficulties

Notes

Parabolic Cylinder

Hyperbolic Cylinder

Geometries

Comparison Factor

193

Rhino

Revit
Architecture

Rhino

Create Elliptic
Paraboloid

00:12:27D

Create Parabola
curve

03.02.2011 00:00:27D

Create Elliptic
Paraboloid.

00:13:28 D

Create Parabola
curve

02.02.2011 00:10:29D

Create Paraboloid
Cylinder

00:01:59D

Create Parabola
curve

03.02.2011 00:00:27D

401

7

599

90

7

Click Reference in Draw panel.
Select Line icon in Draw panel.
Draw a line that connect the end points of parabola curve.
Select the line.
Click on Set in Work Plane panel.
Click on Show in Work Plane panel.
Select Ellipse icon in draw panel.
Draw an ellipse that its center the midpoint of reference line, and its first diameter is the
length of the line.
9. Specify the second diameter which it can be longest than the first diameter.
10. Click on Spilt element in Modify panel.
11. Split the ellipse from the points that connect it with parabola curve.
12. Select half of the ellipse and the reference line.
13. Press Delete.
14. Select the half ellipse and parabola curve.
15. Click on Create Form>Solid Form.
16. Activate elevation view.
17. Select the created surface.
18. Click on Mirror - Draw Axis icon in Modify panel.
19. Check Copy box in Modify bar.
20. Draw the axis of mirror operation.
*Open Rhinoceros.
*Choose Meter/inch file.
*Click on Curve (menu)> Parabola>Focus, Direction.
*Select a point in Top view.
*Select another point on Top view.
*Choose the appropriate shape for the Parabola curve and click Enter.
Select Line icon.
*Draw a Line that can be the axis of parabola curve.
*Select the curve and the axis in Top view.
*Select Rotate icon.
*Go to Front view.
*Select the point at the side of axis.
*Select the other point at the other side of the axis.
*Rotate vertically.
*Go to Top view.
*Select Ellipse: From Center icon.
*Select the center of the ellipse on the axis of the parabola.
*Specify the first diameter.
*Specify the second diameter.
*Select Line icon.
*Draw a line connect between the end points of parabola.
*Select Split icon.
*Select the ellipse to split it.
*Select the line as cutting object.
*Click Enter.

1.
2.
3.
4.
5.
6.
7.
8.

Create Elliptic Paraboloid:

Create Parabola curve.

*Open Rhinoceros.
*Choose Meter/inch file.
*Click on Curve (menu)> Parabola>Focus, Direction.
*Select a point in Top view.
*Select another point on Top view.
*Choose the appropriate shape for the Parabola curve and click Enter.
*Select Line icon.
*Draw a Line that can be the axis of parabola curve.
*Select the curve and the axis in Top view.
*Select Rotate icon.
*Go to Front view.
*Select the point at the side of axis.
*Select the other point at the other side of the axis.
*Rotate vertically.
*Go to Perspective view.
*Select the curve.
*Select Extrude Closed Planar Curve icon.
*Specify the distance of extrusion.
*Click Enter.
*Ellipse can be drawn only by specify the center, there is no
other option to draw it by specify its diameter first.

Elliptic Paraboloid
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03.02.2011 00:31:58U
03.02.2011 00:05:19D
18.02.2011
00:07:27D
605

*Open Rhinoceros.
*Choose Meter/inch file.
*Select Ellipse: Diameter icon.
*Specify the first diameter of the ellipse in Top view.
*Specify the second diameter of the ellipse.
*Select Line icon.
*Draw a line connect between the points that specify the first diameter of the ellipse,
*Select Split icon.
*Select the ellipse to split it.
*Select the line as the cutting object.
*Select one of the half sided of the ellipse.
*Select Copy icon.
*Drag a copy of the half ellipse.
*Go to Perspective view.
*Selected the copied half ellipse.

16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.
32.
33.

Open Revit Architecture.
Choose New Conceptual Mass in families’ files.
Choose Mass in the dialog.
Select Manage tab.
Click on Project Units icon.
Modify the units depending on what you want.
Activate Level 1.
Click on Home tab.
Select Ellipse icon.
Specify the center of the ellipse on the view.
Specify the first radius of the ellipse.
Specify the second ellipse.
Select Line icon.
Check 3D snapping in Modify/ Place Lines tab.
Draw a line that connects between the quads that connect the shortest radius of the
ellipse.
Select Split Element icon in Modify Lines tab.
Split the ellipse in the end point of the line.
Select the upper part of the ellipse.
Activate 3D view.
Click on Create Form> Solid Form
Activate Level 1 view.
Select the created form.
Select Mirror-Draw axis in Modify panel.
Activate 3D view.
Select the line that presents the edge of one of the created surfaces.
Activate Elevation view.
Select Rotate icon in Modify panel.
Specify the center of rotation in the center of the line.
Rotate the line 1100 clockwise.
Select the opposite edge in the second surface.
Select Rotate icon.
Specify the center of rotation in the center of the line.
Rotate the line 700 anticlockwise or connect it with the other edge of the first surface.

Notes

Comparison Factor

Geometries
1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.

Difficulties

Mobuis Strip

1629

Steps

2nd Time

Clicks

00:21:14D

Rhino

1st Time

Time

18.02.2011

Date

Revit
Architecture

Software

Comparison
Factor

c. Complex Surfaces:

*Select one side of cut ellipse.
*Press Delete.
*Go to Perspective view.
*Select Curve menu>Rail Revolve.
*Select curves as rail curves.
*click Enter.
*Specify the Revolve axis.
*click Enter.

195

*Select Extrude Closed Planar Curve icon.
*Specify the height of the extrusion.
*Select the resulted surface.
*Select Controls Points On icon.
*Switch the places of the points on the edge of the surface.
*Select the curve again.
*Select Copy icon.
*Drag a copy of the curve.
*Go to Top view.
*Select Mirror icon.
*Mirror the copied curve.
*Select Move icon.
*Drag the curve and connect it to the surface.
*Go to Perspective view.
*Select Extrude Closed Planar Curve icon.
*Extrude the curve to same height of other surface.
*Select the new surface.
*Select Control points On icon.
*try to connect the two surfaces together.

196

17
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18.02.2011 00:03:13D

2nd Time

Clicks

1st Time
18.02.2011 00:00:28D

Date

* Mass Model (MM) * Generic Model (GM)
*Successful try D*Failed try U

Rhino

Revit
Architecture

Software

Comparison
Factor

Time
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18.02.2011 00:10:04D

2nd Time

Clicks
1104

Time

1st Time
18.02.2011 00:18:32D

Date

Load & Export Process:

Revit
Architecture
Rhino

Software

Comparison
Factor

Configuration & Transformation Stage:

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
10.
11.
12.
13.
14.
15.
16.
17.
18.

1.
2.
3.
4.
5.
6.
7.
8.
9.
Select all the created mass in Rhinoceros.
Click on File>Export Selected...
Click on Save as Type list to select the extension of the file.
Select ACIS (*.sat).
Write the name in File name box.
Click OK in the dialog.
Click OK again for the next dialog.
Open Revit Architecture.
Choose New Conceptual Mass in families’ files.
Choose Mass in the dialog.
Select Manage tab.
Click on Project Units icon.
Modify the units depending on what you want.
Click Insert tab>Import CAD.
Select the export SAT file from Rhinoceros.
Click Open.
Click Open icon> New> Project.
Click OK in the diagram.
Open Revit Architecture.
Select Manage tab.
Click on Project Units icon.
Modify the units depending on what you want.
Go back to Mass file.
Click on Load into Project icon in Modify tab.
In Project file, click on Place on work Place icon in Placement panel in Modify tab.

Click Open icon> New> Project.
Click OK in the diagram.
Open Revit Architecture.
Select Manage tab.
Click on Project Units icon.
Modify the units depending on what you want.
Go back to Mass file.
Click on Load into Project icon in Modify tab.
In Project file, click on Place on work Place icon in Placement panel in Modify tab.

Steps

Steps

Difficulties

Difficulties

Notes

Notes

Geometries

Comparison Factor

Geometries

Comparison Factor
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Appendix C.1
Researcher IndVs
The Analysis Strategy of the Main Method

199

200

Appendix C.2
Students IndVs
The Analysis Strategy of the Confirmation Method
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Is the wording familiar?

movement?

Is the control of cursor compatible with

menu option used to request that display.

* The title of a display should be identical to the

* There is no ambiguity.

should incorporate familiar term.

* The wording of displayed data and labels

Wording Familiarity:

Control of cursor is compatible with movement.

(Lin et al. 1997, 276-277)

Compability

Explanation
(Smith and Moiser)

Usability Evaluation Questions

toolbars to be matched.

9Revit Architecture has Tabs and panels. It doesn't include menus and separated

-Marcus

-Inquiry

-Datum

- Work Plane

understand them after practicing Revit.

Some expressions in Revit interface are not clear to beginners. the user will

Rhinoceros

has menus and floating toolbars. the options in the menus and
toolbars are identical.

9Rhinoceros

The expressions in Rhinoceros are clear: Curve, surface, Mesh ......

9Yes

9Yes

9Yes
Not all
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menu options?

Is the coding consistent across displays,

* The harder it is for a user to identify a displayed

conventional?

columns and three rows.

Single-Column List format:

and incorporate some consistent distinguishing

* locate menu options consistently in the display

information:

Menu Distinction from other displayed

some other acknowledgment of that entry.

option from a menu, the computer should display

* When a user has selected and entered a control

Feed back of menu selection:

*format the list as a single column.

* display each option on a new line.

8*Tabs has multi panels. Each panel includes several icons are displayed in

9*Each tab permit only one selection by the user.

Revit Architecture has Tabs and panels. It doesn't include menus.

And sub-menus has the same properties too.

9*The menus are displayed in one column and each option on a new line.

9*Each menu permit only one selection.

9Rhinoceros

has menus and floating toolbars.

9Rhino has Select color option. it includes both color code and displayed

No color selection in mass file in Revit Architecture.
samples.

17.59

209

Comment.

selection by the user.

* Each menu display should permit only one

Single Selection per menu:

Menu:

reliably than from a list of color names.

vision can choose from displayed samples more

* If many colors are available, users with normal

colors used.

there will be a special need to limit the number of

angles, which makes color perception difficult,

applied to symbols that subtend small visual

and harder to discriminate. If color coding is

many colors are used, colors will be closer in hue

color, the less useful will be the color code. If

Color selection:

Is the assignment of color codes

CONSISTENCY

203

Is the display format consistent?

* Data display refers to computer output of data

return to the general menu at the top level.

* users can take only one simple key action to

Fast return to General Menu:

consistent starting point for control entries.

top level.

9*Revit has main tab called "Home tab". One click on "Home" take user to the

9* The tabs can be distinguished from the icons and the panels.

takes the user to the top level.

9*Rhinoceros has general menu called " File menu". One click on that menu

9* The menus can be distinguished from the icons and the toolbars.

what the result until the user finish all the steps.

base" to which a user can always return as a

provides the user of the steps of the command one by one. But you can't know

the name of the command appears. In command bar at the bottom, the software

8* There is no full explanation of the option when point at it or click on. Only

top level in a hierarchic menu structure, a "home

the icon and instruction bar at the bottom display acknowledgment of that option.

9* When user select an icon in the panels, there is information box appears beside

* Provide a general menu of basic options as the

General Menu:

feature to indicate their special function.

204

Is the label location consistent?

dedicated to display of control options,

data output by the computer, and other areas

display title, another area might be reserved for

* One location might be used consistently for a

types of data in a display.

* Format refers to the organization of different

Display Format:

be used for prompts and advisory messages.

needed, in which case the line just above it could

should be reserved for command entries, where

upper left corner. The bottom line of the display

display, with display identification codes at the

* Display titles might be centered at the top of the

units.

of measurement, do not display data in English

negative example, if users work with metric units

conventions familiar to users. Example: As a

* Display data consistently with standards and

meters or feet, then display both values.

Example: If altitude might be required in either

* do not make users convert displayed data.

information).

confuse a user and hinder assimilation of needed

extraneous data (Display of extraneous data may

any transaction; do not overload displays with

only necessary and immediately usable data for

*Tailor displayed data to user needs, providing

transaction will be available for display.

* Ensure that whatever data a user needs for any

http://hcibib.org/sam/2.html

such outputs.

to a user, and assimilation of information from

9*Command bar at the bottom.
9*Error messages appear in the command bar.

9*Error messages appear at the bottom right corner of the screen.

9* Display titles in Rhinoceros are the upper left corner.

converting.

display data is consisted with the standards and conventions. and there is no need for

9*There is consistency between the displayed data and usable data. In addition the

the interface by the user. The interface will be crowded and confused.

8*The command are available on floating toolbars. If all the toolbars were displayed in

the right command.

*Menus in Rhinoceros includes all command of rhino which make it difficult to find

9*Instruction bar at the bottom.

9* Display titles in Revit Architecture are the upper left corner.

If that system changed to other one, also displayed data will be changed automatically.

9*No need for converting the data. The default units in Revit Architecture is feet system.

interface is not overloaded with extraneous data.

9*Revit has constant interface, all necessary option are available on the interface. and the

9* The interface of Revit Architecture includes all necessary options and data.
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Are symbols for graphic data standard?

* Panning will permit users to move continuously

are more difficult to focus.

* Blue symbols appear dimmer than others, and

background areas in graphic displays.

* Saturated blue might be used for shading

in a display, and not for critical data.

* Use saturated blue only for background features

yellow and white.

somewhat desaturated red, green and blue, plus

on a dark background, good colors might be a

might be red, dark yellow, green, blue and black;

* On a light background, a good choice of colors

Back ground color of icons:

Icon design

distinguish the various curves in some way.

labeling, an acceptable alternative might be to

* Where displayed curves are too close for direct

and gathered together:

Icons with similar features have adjacent label

basis of display framing.

panning rather than scrolling as the conceptual

freely about a page of displayed data, adopt

* In applications where a user can move a cursor

predefined display framing.

encountering any internal boundaries imposed by

over a map in any desired direction, without

Panning:

panning vs. scrolling.

markers.

format/placement as well as special fonts and

including consistent differences in display

*distinguish different types of labeled material,

Is the display orientation consistent? --

Is the label format consistent?

entry.

instructions, error messages, and user command

9Panning is available in Rhinoceros.

9Panning option is available in Revit Architecture.

9* Blue used for shading icons which are pointed or clicked.

icon's graphic. Red used for deleting, erasing and cutting commands.

icons which make user is confused about the icon that he/she selected.

8*Blue color is used to shade pointed icons only. No specific color for clicked

ions indicate to specific functions as layers, properties and analyzing.

9*Rhino's icons has grey background with blue and black icons. some colorful

floating toolbars. most of them has short and clear labels.

9*Revit Architecture has white background for the icons with blue and black

toolbars can be shown by the user. Right click on the mouse shows the list of all

function of the icons very well.

9*Icons in Rhinoceros are gathered in the floating toolbars. The floating

is used for scrolling.

Architecture. But the labels of these panels are not standard and not present the

*Icons with similar features are gathered together in one panel in Revit

and can be used for Scrolling by scrolling the wheel.

9* Right button is used for panning option in Rhinoceros. While middle wheel

graphics.

9*Middle wheel of the mouse can be used for panning by pressing on the wheel,

labeled in the interface. Floating toolbars are not labeled and distinguished by

and size is the same with all commands.

9Label format can be distinguished easily in Revit because menus are the only

Each category such as tab, panel, and icons has different grey colors. Fonts color

9Label format can be distinguished in Revit with the color of the background.
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flexibly?

Can the display be controlled by user

* An example of direct-manipulation is resizing a

capability?

_interface

http://en.wikipedia.org/wiki/Direct_manipulation

its corners or edges with a mouse.

graphical shape, such as a rectangle, by dragging

Direct Manipulation capability:

Does it have direct manipulation

FLEXIBILITY

represent the control options.

* providing graphic menus which display icons to

Iconic Menus:

might be used for this purpose.

on each display. The top left corner of the display

selection in a prominent and consistent location

* Place the identifying label used for display

separately.

descriptive title. The full title would be displayed

* The label does not take the place of a full,

remembered easily.

unique, short, but meaningful enough to be

* The display identification label should be

Icon labels:

*Revit includes short and long label for its icons. the shortest one
are clearer

customized.

9*Rhino's display can be customized and controlled.

9*Rhino has direct manipulation capability.

9*Revit has direct manipulation capability.

8*Revit 's display can't be controlled. it has fixed display and can't be

9.59

9*Revit includes iconic floating toolbars.

9*All icons and labels are displayed et the upper left corner of the interface.

8*There is no descriptive titles for the commands and icons in Revit.

icon.

8*The icons are not labeled. The labels only appears when pointing on the

8.59

9* Revit includes iconic panels.

9*all icons and labels are displayed at the upper left corner of the display.

clicking on the icons.

9* Revit includes a descriptive tiltes which they are appear only when pointing or

than the long ones which they are complicated and ambiguis.
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* Sequence control refers to user actions and

control?

* provide an on-line training capability to

different users?

introduce new users to system capabilities

On-Line training:

Does it provide good training for

compatible with user expectations.

* Ensure that the results of any control entry are

Compatibility with User Expectations:

by LEFT; IN by OUT; etc.

PUSH; FORWARD by BACKWARD; RIGHT

opposite function; PULL should be reversed by

than LOWER, say) should accomplish an

* If one function name is UP, then DOWN (rather

Congruent Names of Control Functions:

command entry by experienced users.

beginners, but permitting more complex

* Permitting simple step-by-step actions by

Control Matched to User Skill:

number of actions consistent with user abilities.

of a transaction sequence with the minimum

Example: control logic should permit completion

of actions consistent with user abilities.

transaction sequence with the minimum number

* control logic should permit completion of a

Minimal User Action:

the transition from one transaction to the next.

terminate transactions. Sequence control governs

computer logic that initiate, interrupt, or

Sequence Control:

Does it provide flexible sequence

9*Autodesk provide users with free online documents for Training.

9*Most of command are compatible with user's expectations.

and Form& Void.

9*Revit includes some congruent names of control functions such as Cut & Join,

commands.

bottom bar of the display. It also include API for experts to script more complex

9*Beginners in Revit can work step by step following the instructions in the

need big number. that depends on the command.

*some of sequence control in Revit need small number of actions and others

*some of sequence control in Rhinoceros need small number of actions and

9*Rhinoceros website provide online training documents.

9*Most of commands are compatible with user's expectations.

8*No congruent names.

experts to script more complex commands such as Monkey and Grasshopper.

the bottom bar of the display. It also include additional attached applications for

9*Beginners in rhinoceros can work step by step following the instructions in

others need big number. that depends on the command.
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2

*View menu>Zoom ( Provide zooming options).

9*Right side of Revit screen provide the user with zooming options.

zooming options.

9*Right click provide the user with floating toolbar View which includes all

9* Right button of the mouse.

9*Middle wheel of the mouse can be used for zooming by scrolling the wheel.

9*Rhino's display can be customized and controlled.

9*Shift+alt + Middle button/Right button of the mouse.

9*Middle wheel of the mouse can be used for zooming by scrolling the wheel.

customized.

8*Revit 's display can't be controlled. it has fixed display and can't be

Autodesk, “Training,” 2011, http://usa.autodesk.com/revit-architecture/training/?preview=1
Rhinoceros, “Using Rhino with Autodesk Inventor - Rhinoceros - Related Products and Services,” 2011, http://www.rhino3d.com/resources/display.asp?language=en&listing=469

*Zooming capabilities.

expansion?

1

Zooming:

Does it provide zooming for display

windows?

Are users allowed to customize

1

2

209

interface.

Is the shifting among windows easy?

* If several window overlays are displayed at

Easy Shifting among Windows:

values to speed data entry.

entries in a particular task, offer those default

9*The shifting process among different views in the same file is easy. It can be

Default values can be found in components and annotations options.

9*The shifting process in Revit is easy and flexible. It provides the user with a

9*Rhinoceros has default values in most of its options and commands.

*Mass file in Revit Architecture doesn't include options need default values.

* default values can be defined for the data

Default Values:

Does it provide default values?

*All the options in the menus can be used in the command bar.

69

8No command language.

5.59

SEND.

be something like TRANSFER, MOVE, or

* To transfer a file, the assigned command should

* Choose command names that are meaningful.

Command's familiar wording:

bottom.

location on every display, preferably at the

* command entry area should be in a consistent

Location of Command bar:

system frequently.

users may be highly trained and will use the

involving a wide range of control entries, where

* Command-language dialogues for tasks

MINIMAL ACTION

Are the command names meaningful?

Is the ordering of menu options logical?

9*The command language is available, it's located at the bottom of the

9*The grouping and ordering of menus options are logical.

*The grouping of tabs options are logical, but the panels are not clear and not

Is the grouping of menu options logical?

Availability of Command Language:

9The command language is layered.

8No command language.

Is the command language layered?

logical.

39
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capability?

Does it provide global search and replace

currently active.

among them to select which window shall be

once, provide some easy means for a user to shift

9Revit provides global search.

the user until he/she minimizes the windows.

know which windows belong to specific file, and the opened files are not visible to

8*The problem that the shifting process between files is difficult. The user can't

done using Project Browser dialogue in the left side of the display.

9*Provides command search.

another Rhinoceros will be launched or close the current file to open another one.

8*Rhino can't open more than one file in the software. To open other file,

them to maximize it.

screen is divided to four different views. The user can click on the title of one of

211

* Choose wording for user guidance that speaks

Speaking directly to users:

be used for prompts and advisory messages.

needed, in which case the line just above it could

should be reserved for command entries, where

upper left corner. The bottom line of the display

display, with display identification codes at the

available and speaks directly to the user.

9*The user guidance in Rhino is presented in the command bar which is always

9*Error messages appear in the command bar.

9*Error messages appear at the bottom right corner of the screen.

9*User guidance is available and speaks directly to the user.

9*Command bar at the bottom.

9*Instruction bar at the bottom.

9* Display titles in Rhinoceros are the upper left corner.

9* Display titles in Revit Architecture are the upper left corner.

* Display titles might be centered at the top of the

Is the guidance information always available?

9Yes.

the menus and icons are provided with a key shortcut.

59

Consistent Format of User Guidance:

can be controlled by keyed entry. Pressing alt key will provide
the user the ability to control Rhino using keyboard. In addition, Each option in

9*Rhinoceros

9*Yes.

59

9Yes.

the ability to control Revit using keyboard.

9*Revit can be controlled by keyed entry. Pressing alt key will provide the user

9* Yes.

MINIMAL MEMORY LOAD

simple key action?

Is the return to general menu required only one

secondary means of control entry.

Is the menu selection by keyed entry? --

means of sequence control.

Is the menu selection by pointing? -- primary

212

Does it provide index of commands?

Are selected data highlighted?

command language.

related commands and learning the overall

generally helpful as a reference for discovering

phrase a particular command, and will also be

* Such a command index may help a user to

Index of Commands:

was selected.

misunderstood or perhaps forgotten which item

* This practice will help avoid error, if a user has

contrast it with other bars.

shaded differently to call attention to it and to

out-of-tolerance condition might be textured or

Example: On a bar chart, one bar representing an

High light graphic displays are provided:

make errors.

and without guidance users can be expected to

action to take next. Human memory is unreliable,

to remember what actions are available, or what

not currently displayed. The user should not have

*Do not require a user to remember information

Guidance information always available:

| The user should press ENTER to continue. |

(Bad)

| Press ENTER to continue. |

(Good)

Example

directly to a user, rather than talking about users.

8No index of Commands.

9* Blue used for shading icons which are pointed or clicked.

Help>Command List...

9*Rhino provides Command List. It can be entered by clicking on

icons which make user is confused about the icon that he/she selected.

8*Blue color is used to shade pointed icons only. No specific color for clicked

213

Is the spelling distinctive for commands?

PERCEPTUAL LIMITATION

49

than the long ones which they are complicated and ambiguous.

*Revit includes short and long label for its icons. the shortest one

icons very well.

are clearer

icon.

8*The icons are not labeled. The labels only appears when pointing on the

clear labels.

8*The labels of these panels are not standard and not present the function of the 9*Most of menus options, icons and commands in Rhinoceros has short and

4.59
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9Label format can be distinguished easily in Revit because menus are the only

9Label format can be distinguished in Revit with the color of the background.

Are menus distinct from other displayed

information?

9Yes. They are activated with blue bar.

ions indicate to specific functions as layers, properties and analyzing.

9Yes. They are activated with blue bar and bold font in Project Browser.

black icon's graphic. Red used for deleting, erasing and cutting commands.

9*Yes, Revit Architecture has white background for the icons with blue and

9*Rhino's icons has grey background with blue and black icons. some colorful

8*There is no descriptive titles for the commands and icons in Revit.

Is the active window indicated?

Does it provide easily distinguished colours?

clicking on the icons.

9* Revit includes a descriptive tiltes which they are appear only when pointing or
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Is HELP provided?

Does it provide CANCEL option?

standard system terminology. Example: If a

topic, the computer should accept synonyms for

* When a user requests HELP on a particular

Synonyms of Standard Terminology:

by requesting HELP.

* Permit users to obtain further on-line guidance

On-Line help:

Manual Help:

Help:

current display to its previous version.

changes just made by the user and restoring the

* CANCEL option have the effect of erasing any

Cancel option:

is wrong and what can be done about it.

display an error message to the user stating what

* When the computer detects an entry error,

what functions are appropriate at that point.

except display of an advisory message indicating

a particular transaction, no action should result

* If a user selects a function key that is invalid for

correct those errors that do occur.

* Error messages help prevent user errors and

9*Revit provides on-line help.

9*Escape key cancels any ongoing process in Revit.

the mistake. It sometimes make the user more confused.

messages are not useful sometimes and doesn't provide the solution of the error or

9*Rhinoceros' help accept synonyms of Standard terminology.

9*Rhino provides help documents and online help.

9*Escape key cancels any ongoing process in Revit.

provide the solution of the error or the mistake.

9*Rhino provides error messages in the command bars. They are helpful. They

*Revit provides Error messages in the right bottom corner of the display.

System feedback: How helpful is the error
The

59
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USER GUIDANCE

Error Messages:

graphics.

and size is the same with all commands.

message?

labeled in the interface. Floating toolbars are not labeled and distinguished by

Each category such as tab, panel, and icons has different grey colors. Fonts color

216

Other Options

* Ensure that any user action can be immediately

actions?

Resize(Scale) option:

appropriate constraints during line drawing.

and horizontal lines, allow users to specify

When graphic elements are created with vertical

Ortho feature:

to intersect the already-displayed line.

cursor's new line will be extended automatically

line-drawing cursor is moved within that field the

field" surrounding each line segment, so that if a

connection is to provide a so-called "gravity

* An effective computer logic to aid line

Snapping points:

Distance option.

reversed by an UNDO command.

Undo option:

Does it provide UNDO to reverse control

requests HELP for ERASE.

that command might be displayed when a user

DELETE command exists, then an explanation of

9*Rhinoceros provides snapping and 9Ortho options.

9*Distance option is provided in Rhinoceros.

9*Distance option is provided by Revit.

9*Revit provides snapping option. It's called Snaps.

139

9*Yes.

13.59

9*Yes.

8*Revit' help doesn't accept synonyms of Standard terminology.

217

merging those elements by boolean combination.

graphic elements, provide computer aids for

created by the junction or disjunction of other

* In the special case when a drawn object can be

Boolean option:

in common.

which graphic editing operations will be applied

* Allow users to designate a group of elements to

Group option:

reflection (mirror image) of existing elements.

elements, provide a means for specifying a

* When users must create symmetric graphic

Mirror option:

orientations.

display, in order to show it in different

allow users to rotate a selected element on the

* When editing graphic data that depict objects,

Rotate option:

Comment

repeating pattern.

in order to duplicate it elsewhere or create a

* Allow users to copy a selected graphic element

Copy option:

display.

change the size of any selected element on the

* When editing graphic data, allow users to

tab>Modify panel.

9*Scale, Copy, Rotate and Mirror options are provided by Revit in Modify

9*Revit provides Ortho option.

9*Scale, Copy, Rotate, and Mirror options are provided by Rhinoceros.

218

designating its starting point and then simply

a line segment rapidly and with confidence by

* This technique permits users to enter or change

Rubber banding feature:

elements.

type, cross-hatching, color -- for selected graphic

users to change display attributes -- e.g., line

* When entering or editing graphic data, allow

Changing Attributes:

displayed within 2-4 seconds.

be within 2.0 seconds; error messages should be

second; response to other simple entries should

such as NEXT PAGE, should be within 0.5-1.0

* Computer response to a likely control entry,

feedback should not exceed 0.2 seconds.

entry actions rapidly. Delays in displayed

* Ensure that the computer will acknowledge data

Fast Response to commands:

9*Revit provides a property dialogue for selected objects.

9Yes.

9*Join Geometry option presents Boolean operation in Revit MMF.

available in PF.

*In Mass file in Revit, there is no Group option. Model Group option only

9*Rhino provides with Properties dialogue for selected objects.

9Yes.

9*Group and 9Boolean operations are provided in Rhinoceros.
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entering appropriate parameters.

* allow users to create particular instances by

Parametric option:

radius.

fixing its center and changing the extension of its

circle might be rubberbanded to desired size by

one corner and moving the opposite corner. A

*.A rectangle might be rubberbanded by fixing

moving the cursor to the desired end-point.

9*Revit has the ability to create parametric form.

9*Revit has the ability to change the parameters of any shape or geometry.

9*Revit include Rubber banding feature.

as Grasshopper applications.

9*Rhinoceros has some plug-ings tha supprot it to craete parametric forms such

`

9*Rhino has the ability to enter the parameters of any shape or geometry.

9*Rhino has Rubber banding feature.
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via function keys.

novice user to learn the control options available

explaining the various key functions might help a

representation of keypad layout with notes

* A guidance display providing a graphic

Graphic guidance and explanation of icons:

*They need not be included in displayed menus.

etc.

PRINT, NEXT PAGE, PREV PAGE, OPTIONS,

* Commonly used function keys include ENTER,

Function Keys for Frequent Control Entries:

instruction bar at the bottom display acknowledgment of that option.

select an icon in the panels, there is information box appears beside the icon and

9* Yes. Revit includes graphic guidance and explanation of icons. When the user

9*functions keys for frequent control entries are used in Revit.

what the result until the user finish all the steps.

provides the user of the steps of the command one by one. But you can't know

the name of the command appears. In command bar at the bottom, the software

8* There is no full explanation of the option when point at it or click on. Only

9*functions keys for frequent control entries are used in Rhino.
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named "macro" for subsequent command entry.

defined series of control entries, and then use that

* Allowing users to assign a single name to a

Macro option:

9*Yes, it includes Macro option in Macros panel in Manage tab.

.

9*Yes, it includes Macro option in Tools>Options.

222

04.12.20
010 00:01:330D
18.02.20
011

09.11.20
010

26.10.20
010 00:01:116D

Rev
vit
Arcchitecture

Rhiino

Rev
vit
Arcchitecture

11.11.20
010

09.11.20
010

Rhiino

1st T
Time

26.10.20
010

Date

Rev
vit
Arcchitecture

Software

Comparison
Factor

a. Preliminarry solids:

Solids:

Clicks

00
0:00:42D

00:0
00:10D

00:0
02:22D

00:0
00:43D

34

15

47
136

23

2n
nd Time
00
0:00:53D 37

Time

14

7

17

7

14

Steps

Difficu
ulties

The Ressults of the
t Main Method

Appen
ndix E

Seecond Tim
me

-Tired (Baad mood)
- Optimisstic

- Good M
Mood
- Optimisstic

- Good M
Mood
- Optimisstic

Defaault Parametric Sphere

- Good M
Mood
- Optimisstic

Succcessful exper
riment

Seecond Tim
me

MM
M

MM
M

Succcessful exper
riment

*Deefault Parametric Cone.

Succcessful exper
riment

Seecond Tim
me

Notes

- Good M
Mood
- Optimisstic

Variables

Prism

Cone

Sphere

Geometrie
es

C
Comparison Fa
actor

Resultt

223

00:35:000U

01:17:000D

27.9.201
10

27.9.201
10

Rev
vit
Arcchitecture

26.10.20
010

09.11.20
010

19.9.201
10

Rev
vit
Arcchitecture

Rhiino

Rev
vit
Arcchitecture

00:17:000U

15.11.20
010 00:01:110U

09.11.20
010

Rhiino

04.02.20
011 00:40:444D
18.02.20
011

09.11.20
010 00:00:220

Rhiino

00:0
00:17D

0::00:24D

00:0
00:11D

00:10:46D

00:0
00:19D

11

21

15

682

28

7

14

9

61

26

9

- Good M
Mood
- Optimisstic

- Good M
Mood
- Optimisstic

- Good M
Mood
- Optimisstic

Succcessful exper
riment

Seecond Tim
me

Succcessful exper
riment

Seecond Tim
me

MM
M

Seecond Tim
me

-O
One Successful
Exp
periment.

Seecond Tim
me

Thrree tries to ac
chieve a
succcessful exper
riment.

MM
M
- Faccet Pyramid
- 3D
D snapping option
n

* Only
y could create faccet Pyramid ...nott
volum
me one.

-Tired (Baad mood)
- Optimisstic

GM

Succcessful exper
riment

* No 3D
3 snapping, makke it difficult to
snap vertical
v
line to thee horizontal ones..

- Good M
Mood
- Optimisstic

d
Ellipsoid

Cylinderr

Pyramid
d
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09.11.20
010

06.02.20
011 00:02:009D
18.02.20
011

09.11.20
010

28.10.20
010 00:11:004U
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Rhiino

Rev
vit
Arcchitecture

00:0
00:06D

00:0
01:09D

00:0
00:13D

00:0
01:35D

15.11.20
010 00:03:229U
15.11.20
010 00:00:332D
18.02.20
011

Rhiino

118

00:0
01:09D

15.11.20
010 00:02:554D

10

114
1
1
120

11

22
112

43

253

15.11.20
010 00:07:119D

7

24

8

15

*Prism
m Deformation annd NURBS
operattions.

*The problem
p
of Generric Model that it
should
d be loaded to Maass. File then to
Projecct. File to work onn it. If it load
directlly to Project. Filee then it can be
consid
dered there as Genneric model famiily
not as a Mass. Thereforre, Floors can't bee
added to the geometry..

- Good M
Mood
- Optimisstic

-Tired (Baad mood)
- Optimisstic

- Good M
Mood
- Optimisstic

-Tired (Baad mood)
- Optimisstic

MM
M

Succcessful exper
riment

-Seecond Tim
me

Succcessful exper
riment

-Seecond Tim
me

-Seecond Tim
me

-On
ne try to achieve a
succcessful exper
riment.

*Deefault Parametric Cone.

Seecond Tim
me

Sixx tries to achie
eve a
succcessful exper
riment.

MM
M

GM

MM
M

Tetrahedrron

Torus
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00:30:003U
00:29:554U
00:20:334U
00:05:220U

06.12.20
010 00:02:222D

09.11.20
010 00:06:559D

03.11.20
010 00:15:338D

02.11.20
010
02.11.20
010
03.11.20
010
03.11.20
010

02.11.20
010 00:08:226U

02.11.20
010 00:44:556U

02.11.20
010 00:36:554U

00:20:337D

00:11:25D

135

843

19

44

MM
M
MM
M

*Use Add
A Edge optionn and NURBS
operattion.
*Divid
ding the tetrahedrron to three
connected pyramids.
*I wassted a lot of time in repeating the
same steps
s
in creating eeach geometry
instead
d of creating one and copy it to other
two co
opies and connectt them.

- Tired (B
Bad Mood)
- Optimisstic

MM
M

*subtrract Prism again.

- Discomffort (Bad Mood)
- Pessimisstic

GM

*Revo
olve profile arounnd triangular prism
m.

-Su
eriment
uccessful expe

-FiirstTime

-Tw
wo successful tries.

*Diffferent way of cre
eating >
longg method.
*Deefault Parametric

-Su
eriment
uccessful expe

-FiirstTime

-Teen tries to ach
hieve a
succcessful exper
riment.

MM
M

MM
M

MM
M

MM
M
Surfface Tetrahedron
MM
M

*That is tetrahedron wiith surfaces doesn
n't
work to
t create floor plaans inside it.
*Try create
c
Tetrahedroon with subtractin
ng
3 trian
ngular prism of m
main triangular
prism..
*You have to set Workk plane for each step
which
h has difficulties tto set it.
*Try to
t subtract 3 pyraamids from
triangu
ular prism.
*Try to
t create Tetra usiing lines and creaate
form.
*Try to
t use Forms operration (Revolve).
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Time

03.11.20
010 00:26:229U

Rev
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08.11.20
010 02:01:007U

Rev
vit
Arcchitecture

01.02.20
011 00:40:002U

16.11.20
010 00:14:110

Rhiino

08.11.20
010 01:17:440U



03.11.20
010 01:00:441U

16.11.20
010 00:09:224D

Create
octahedroon by
connectinng the
two pyram
mids

00:42:119U

Create tw
wo
pyramids.

1st T
Time
04.02.20
011 00:40:444

Date

Rhiino

Rev
vit
Arcchitecture

Software

Comparison
Factor

b. Secondary
y Solids:

2n
nd Time

727

362

---

1640

Clicks

15

29

Steps

* Connecting two hexaagon with Create
Form command.
*NUR
RBS operations foor Prism.
*Divid
ding Anti-Prism tto small pyramids
*Subtrracting pyramids from Prism by
using Void forms.

*Used
d Sphere with divviding its surface,
but co
ouldn't find pentaggonal system.
*Try to
t create the pentaagonal system by
y
creatin
ng new curtain paanel.
*Try dividing
d
the dodeecahedron to many
small pyramids and connnect them to
biggerr pyramids to connnect them which
will crreate dodecahedroon.
*Start with cube and addding pyramids to
o
differeent faces of the cuube.

*Void
d solids appear whhen two geometriies
have void
v solids are coonnected to each
other which
w
make the ffinal geometry looks
bad.

Difficu
ulties

-Th
hree tries
-Faailed experiment.

-Su
eriment
uccessful expe
-Firrst time.

- Good M
Mood
- Optimisstic

-Su
uccessful expe
eriment

-Tw
wo tries
-Faailed experiment
beccause of Void
prooblem.

Notes

- Good M
Mood
- Optimisstic

- Good M
Mood
- Optimisstic

- Tired (B
Bad Mood)
- Optimiistic because I created
Pyramidss before, and thought
that will w
work.

Variables

Anti-Prism

D
dron
Dodecahed

Octahedro
on

Geometrie
es

C
Comparison Fa
actor

Result
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09.11.20
010

19.9.201
10 00:11:000
18.02.20
011

09.11.20
010

26.10.20
010

Rhiino

Rev
vit
Arcchitecture

Rhiino

Rev
vit

27.10.20
010

19.9.201
10

Rev
vit
Arcchitecture

00:14:000D

16.11.20
011 00:08:557D

Rhiino

01.02.20
011 00:31:443D
18.02.20
011

00:0
00:40

00:0
03:42D

00:0
02:03D

00:0
00:06D

184

--163

15

95

601

00
0:02:00D

348

Creatte Anti-prism
with equilateral
triang
gles faces.

1382
1429

00:13:08D

00:2
20:15D

5

13

33

7

25

36

57

*To Draw
D
a polygon inn Revit with
speciffic side length, yoou should know th
he
diameter first which neeed calculations and
a
take tiime.
*All th
he sides of Anti pprism has same
length
h, therefore you shhould calculate th
he
heightt of Ant-prism to achieve that.

- Good M
Mood
- Optimisstic.

MM
M
- Good M
Mood
- Optimisstic.

-Seecond try

MM
M

-Seecond try
-Su
eriment.
uccessful expe

-Seecond try
-Su
eriment.
uccessful expe

-Seecond try.
-Su
eriment.
uccessful expe

-Seecond try
-Su
uccessful expe
eriment.

MM
M

- Good M
Mood
- Optimisstic

- Good M
Mood
- Optimisstic

-Seecond try.
-Su
uccessful expe
eriment.

- Good M
Mood
- Optimisstic

MM
M

-Th
hree tries to achieve
a
a su
uccessful experiment
-Seecond try
-Su
uccessful expe
eriment.

- Tired (B
Bad Mood)
- Optimisstic.

al
Elliptica

S
Semi. Ellipttical
Cone

T
Truncated Cone
C

228

00:0
02:20D

186
201

28

25

* Creaate levels only woork in elevations or
section
ns.
* Diffficulties with creaating work plane, it
takes long
l
time to creatte it.
*Cuttiing the geometry without change it
i
to void
d, doesn't work, bbecause it will still
appearr and connect witth the other
geomeetry, and if deleteed it the cut
geomeetry process will bbe cancelled.
*Boollean operations inn Revit only limitted
in Join
n and Cut.

- Tired (B
Bad Mood)
- Optimisstic.

- Good M
Mood
- Optimisstic.

- Tired (B
Bad Mood)
- Optimisstic.

-Seecond try
-Su
eriment.
uccessful expe

MM
M

-Seecond try
-Su
eriment.
uccessful expe

-Seecond try
-Su
uccessful expe
eriment.

GM
MM
M

19.9.201
10 02:11:000
18.02.20
011 00:01:553D
19.02.20
011

206

* 22 steps is the minim
mum steps, the steps
can bee more due to placcing process.
* Afteer Cut Geometry pprocess, if we sellect
the Ob
blique Cone, the vvoid geometry will
appearr in x ray mode. T
That's mean that the
t
void geometry
g
will be aalways connected
d to
the ressulted geometry aand if deleted the
original geometry will appear again.
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00:0
04:33D

22

09.11.20
010

347

Rhiino

00:0
03:40D

20.9.201
10 00:44:000U
18.02.20
011 00:42:000D

Rev
vit
Arcchitecture

14

-Seecond try
-Su
uccessful expe
eriment.

63

09.11.20
010

Rhiino

00:0
00:40D

-Su
uccessful expe
eriment.

Arcchitecture

R
ular
Right Circu
Cone

O
Oblique Circ
cular
Cone

Cylinderr
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09.11.20
010

26.10.20
010
18.02.20
011

09.11.20
010

Rhiino
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Rhiino

00:0
02:11D

00:0
01:40
00:0
00:50D

00:0
04:33D

141

67

206

17

21

25

- Good M
Mood
- Optimisstic.

MM
M

- Tired (B
Bad Mood)
- Optimisstic.

-Seecond try
-Su
uccessful expe
eriment.

-Seecond try
-Su
uccessful expe
eriment.

-Seecond try
-Su
uccessful expe
eriment.

- Good M
Mood
- Optimisstic.

O
Oblique Circ
cular
cylinderr

230

Rhiino













Rev
vit
Arcchitecture

Software

Comparison
Factor

Time

Create tw
wo
pyramids and
connect thhem to
Anti-Prism
m
geometry.

00:14:221D

Create AnntiPrism.

16.11.20
010 00:09:005D

Create tw
wo
pyramids and
connect thhem to
Anti-Prism
m
geometry.

00:21:004U

Create AnntiPrism.

1st T
Time
01.02.20
011 00:31:443D

Date

c. Complex Solids:
S

2n
nd Time

682

526

Clicks

34

Create Icosahedron:

32

Create Anti-Prrism:

Steps
*Void
d solids appear whhen two geometriies
have void
v solids are coonnected to each
other which
w
make the ffinal geometry looks
bad.

Difficu
ulties

- Tired (B
Bad Mood)
- Optimisstic.

- Tired (B
Bad Mood)
- Optimiistic because I created
Pyramidss before, and thought
that will w
work.

Variables

-On
ne try
-Su
uccessful expe
eriment.

-On
ne try
-Faailed experiment
beccause of Void
prooblem.

Notes

Icosahedrron

Geometrie
es

C
Comparison Fa
actor

Resultss
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3
317

02.02.20
011 00:10:229D

Rev
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Create Paaraboloid

00:05:330D

Create Paarabola
curve

140

03.02.20
011 00:10:119

Rhiino

2
226

474

15.11.20
010 00:06:336D

Rev
vit
Arcchitecture

114

03.02.20
011 00:14:114

526

15.11.20
010 00:15:004D

2n
nd Time

Clicks

1912

Time

1st T
Time
15.11.20
010 00:43:440D

Date

Rhiino

Rev
vit
Arcchitecture

Software

Comparison
Factor

a. Preliminarry Surfacess:

Surfacces:

8

C
Create
Paraboloiid:

18

C
Create
Parabola curve:

32

7

25

*Create hyperbola curves.

35

6

25

Creating Hyperrbola curves:

Steps
*There is a lot of calcuulation operationss
which
h takes time.
*I look tired in that expperiment and did a
lot of calculation mistaakes that is why itt
took lo
ong time to workk.

Difficu
ulties

- Tired (B
Bad Mood)
- Optimisstic.

- Tired (B
Bad Mood)
- Optimisstic.

- Good M
Mood
- Optimisstic.

- Tired (B
Bad Mood)
- Optimisstic.

- Good M
Mood
- Optimisstic.

Variables

-Firrst time.
-Su
eriment.
uccessful expe

-Su
eriment.
uccessful expe

-Su
eriment.
uccessful expe

-Su
uccessful expe
eriment.

-Su
uccessful expe
eriment.

MM
M

MM
M

Notes

Paraboloid

ets
Two Shee
oid
Hyperbolo

One Shee
et
Hyperbolo
oid

Geometrie
es

C
Comparison Fa
actor

Results
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Rev
vit
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Software

Rev
vit
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Rhiino

09.11.20
010 00:00:112D

Time

Create Paarabolic
Cylinder

00:00:111 D

Create Paarabola
curve

02.02.20
011 00:10:229D

Create Hyyperbola
CylinderD

00:01:004

Create Hyyperbola
curveD

03.02.20
011 00:02:558

1st T
Time
15.11.20
010 00:07:114D

Date

b. Secondary
y Surfaces:

Comparison
Factor

Rhiino

2n
nd Time

6

3
317

28

57

571

Clicks

22

Steps

3

C
Create
Paraboloiid Cylinder:

18

C
Create
Parabola curve.

12

2

25

*Create hyperbola curve.

7

Difficu
ulties

- Tired (B
Bad Mood)
- Optimisstic.

- Tired (B
Bad Mood)
- Optimisstic.

- Good M
Mood
- Optimisstic.

Variables

- Good M
Mood
- Optimisstic.

-Firrst time.
-Su
eriment.
uccessful expe

-Firrst time.
-Su
eriment.
uccessful expe

-Firrst time.
-Su
eriment.
uccessful expe

Notes

-Firrst time.
-Su
uccessful expe
eriment.

Cylinderr

Paraboliic

Hyperbollic
Cylinderr

es
Geometrie

C
actor
Comparison Fa

Results
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Create Ellliptic
Paraboloiid

00:12:227D

Create Paarabola
curve

03.02.20
011 00:00:227D

Create Ellliptic
Paraboloiid.

18.02.20
011

03.02.20
011 00:31:558U
03.02.20
011 00:05:119D
18.02.20
011

Rhiino

1st T
Time

Rev
vit
Arcchitecture

Software

Date

Difficu
ulties

Variables

- Tired (B
Bad Mood)
- Optimisstic.

- Tired (B
Bad Mood)
- Optimisstic.

Notes

-Firrst time.
-Su
uccessful expe
eriment.

-Firrst time.
-Su
uccessful expe
eriment.

-Firrst time.
-Su
uccessful expe
eriment.

C
actor
Comparison Fa

Elliptic
Paraboloid

00:0
07:27D
605

1629

34

- Tired (B
Bad Mood)
- Optimisstic.

- Tired (B
Bad Mood)
- Optimisstic.

-Tw
hieve
wo tries to ach
succcessful exper
riment.
-Seecond time.
-Su
eriment.
uccessful expe

-Seecond time.
-Su
eriment.
uccessful expe

Mobuis Sttrip

33

Steps

*Ellipse can be drawn only by specify th
he
centerr, there is no otherr option to draw it
i
by speecify its diameterr first.

- Tired (B
Bad Mood)
- Optimisstic.

00:2
21:14D

33

20

C
Create
Elliptic Pa
araboloid:

18

C
Create
Parabola curve.

19

es
Geometrie

Clicks

401

7

5
599

90

7

2n
nd Time

Time

00:13:228 D

Create Paarabola
curve

02.02.20
011 00:10:229D

Create Paaraboloid
Cylinder

00:01:559D

Create Paarabola
curve

03.02.20
011 00:00:227D

c. Complex Surfaces:
S

Comparison
Factor

Rhiino

Rev
vit
Arcchitecture

Rhiino

Results

234

Time



120

18.02.20
011 00:03:113D

Rhiino

2n
nd Time

17

1st T
Time

Clicks

18.02.20
011 00:00:228D

Date

Rev
vit
Arcchitecture

Software

Comparison
Factor



Load & Export Prrocess:



677

18.02.20
011 00:10:004D

Rhiino

2n
nd Time

Clicks

1104

1st T
Time

Time

18.02.20
011 00:18:332D

Date

Rev
vit
Arcchitecture

Software

Comparison
Factor



Configu
uration & Transform
T
mation Stagee:

18

9

Stepss

Stepss

*Rhiinoceros has no ccomponents. It is not
a BIM
M application. Thherefore, the
resullted geometry is eexported to a BIM
M
softw
ware to make a reeal building.

Difficu
ulties

Difficu
ulties

- Tired (B
Bad Mood)
- Optimisstic.

- Tired (B
Bad Mood)
- Optimisstic.

Variables

- Tired (B
Bad Mood)
- Optimisstic.

- Tired (B
Bad Mood)
- Optimisstic.

Variables

Notes

-Firrst time.
-Su
uccessful expe
eriment.

-Firrst time.
-Su
uccessful expe
eriment.

Notes

es
Geometrie

C
actor
Comparison Fa

Geometrie
es

C
Comparison Fa
actor

Results

Results
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7

32

16

25.02.2011 00:12:22D

25.02.2011 00:01:04D

Revit
Architecture

Rhino

12

25.02.2011 00:01:01D

2nd Time


Clicks

Rhino

1st Time

Time

25.02.2011 00:01:43D

Date

Revit
Architecture

Software

Comparison
Factor

Computer 3 Experiments:
Steps

* Move items in Elevation view.
*Rotate items in elevation View.

Difficulties
Good Experience
Bad Mood
Conceptual Design(Not
Geometry)
Optimistic
Poor Attitude

Good Experience
Bad Mood
Conceptual Design
(Geometric).
Optimistic
Good Attitude

One Negative variable

Two to three Negative
variables

One Negative variable

x
x

x
x
x

Two to three Negative
variables

x
x

x
x
x

Variables

The collected data and the results of the Confirmation Method

Appendix F

-First time.
-Successful experiment.

-First time.
-Successful experiment.

PF

-First time.
-Successful experiment.

-First time.
-Successful experiment.

PF

Notes

Right Circular
Cone

Prism

Geometries

Comparison Factor

Result
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25.02.2011 00:14:33U

Rhino



25.02.2011 00:26:07U

Revit
Architecture

One Negative variable

Two to three Negative
variables
-One time.
-Failed experiment.
-One time.
-Failed experiment.

PF

Mobuis Strip

237

34

15

25.02.2011 00:03:02D

25.02.2011 00:00:45D

25.02.2011 00:09:07U

Revit
Architecture

Rhino

Revit
Architecture

Good Experience
Bad Mood
Conceptual Design(No
Geometry).
Optimistic
Poor Attitude

Good Experience
Bad Mood
Conceptual Design
(Geometry).
Optimistic
Good Attitude

Good Experience
Bad Mood
Conceptual Design(No
Geometry).
Pessimistic.
Poor Attitude

-Failed try.

PF

-First time.
-Successful experiment.

-First time.
-Semi-Successful
experiment.

PF

-First time.
-Successful experiment.

-First time.
-Successful experiment.

PF

Notes

00:14:36D

Two to three Negative
variables

x
x

-Fourth time.
-Semi-Successful
experiment.

-Failed try.
x
x
x

One Negative variable

Two to three Negative
variables

One Negative variable

x
x

x
x
x

Two to three Negative
variables

x
x

x
x
x

Variables

00:05:43U

Difficulties

-Failed try.

Steps

00:09:00U

36

11

11

25.02.2011 00:00:34D

2nd Time


Clicks

Rhino

1st Time

Time

25.02.2011 00:00:57D

Date

Revit
Architecture

Software

Comparison
Factor

Computer 5 Experiments Analysis:

Mobuis Strip

Right Circular
Cone

Prism

Geometries

Comparison Factor

Result
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Rhino

25.02.2011 00:03:12D
29
Two to three Negative
variables

-One time.
-Semi-Successful
experiment.

239

25.02.2011 00:33:27U

Revit
Architecture

Rhino

12

25.02.2011 00:00:58D

Rhino

00:06:50 D

25.02.2011 00:07:23U

00:10:23D

----

25.02.2011 00:02:39U

13

33

6

Revit
Architecture

11

25.02.2011 00:00:20D

2nd Time


Clicks

Rhino

1st Time

Time

25.02.2011 00:02:28D

Date

Revit
Architecture

Software

Comparison
Factor

Computer 6 Experiments Analysis:
Steps

*Problems with Mirror option.

Difficulties
Poor Experience
Good Mood
Conceptual
Design(Geometry).
Optimistic
Poor Attitude.

All variables are
Positive

Good Experience
Good Mood
Conceptual
Design(Geometry).
Optimistic
Good Attitude.

All variables are
Positive

Two to three Negative
variables

All variables are
Positive

Two to three Negative
variables

x
x

x
x
x

Two to three Negative
variables

x
x

x
x
x

Variables

-Second time.
-Successful experiment.

-Failed try.

-Fourth time.
-Semi-Successful
Experiment.

-Failed try.

PF

-First time.
-Successful experiment.

-First time.
-Failed experiment.

PF

-First time.
-Successful experiment.

-First time.
-Successful experiment.

PF

Notes

Mobuis Strip

Right Circular
Cone

Prism

Geometries

Comparison Factor

Result
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00:04:26D
17

-Third time.
-Successful experiment.
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26.02.2011 00:00:53D

26.02.2011 --------------

26.02.2011 00:13:12U

Rhino

Revit
Architecture

Rhino




26.02.2011 00:09:10U

Revit
Architecture

00:14:31U

00:04:04D

26.02.2011 00:02:12D

Rhino

1st Time

26.02.2011 00:03:23D

Date

Revit
Architecture

Software

Comparison
Factor

2nd Time


00:05:31D

Time

Computer 65 Experiments Analysis:
Clicks

18

24

9

11

Steps

Difficulties
Poor Experience
Bad Mood
No Conceptual
Design(Geometry).
Optimistic
Poor Attitude.

Good Experience
Bad Mood
Conceptual
Design(Geometry).
Optimistic
Good Attitude.

All variables are
Negative

Poor Experience
Bad Mood
No Conceptual
Design(Geometry).
Pessimistic.
Poor Attitude.

One Negative variable

x
x

x
x
x

One Negative variable

Four or more Negative
variables

One Negative variable

x
x

x
x
x

Four or more Negative
variables

x
x

x
x
x

Variables

-Second time.
-Successful experiment.

-No experiment.

-First time.
-Successful experiment.

-First time.
-Failed experiment.

PF

-First time.
-Successful experiment.

PF
-First time.
-Successful experiment.

Notes

Mobuis Strip

Right Circular
Cone

Prism

Geometries

Comparison Factor

Result
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Appendix G.1
Pre-Questionnaire

Pre- Questionnaire
Hi everyone,
Thank you for your coming today to participate in the experiment.
Please fill out this questionnaire before starting work on the experiment.
1)

Please write down the number of your computer:

2)

How do you feel today? (Calderon et al. 2000, 5)
Enthusiastic

Comfort

Tired

Sleepy

Discomfort

Other (Please Specify):

3)

Did you work on Autodesk Revit Architecture before?

Please select

4)

When did you learn using Revit Architecture?

dd
mm
*yyyy
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5)

How did you learn Revit Architecture?

College course

Private training

Friend helped me

Training books

Training videos

By myself

Other (Please Specify):

6)

How often do you use Revit Architecture?

Always

Sometimes

Rarely

Never

7)

Do you use Revit Architecture for.....

College assignment

Job

Fun

Everything

NA

Other (Please Specify):

8) How many hours do you work on Revit Architecture weekly? (Calderon

et al. 2000, 5)
0

2

4

6

8

10

More...

9) How do you consider your experience in Revit Architecture?
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Beginner
Moderate
Expert

10) Do you use Revit Architecture in architectural design?
Please select

11) Have you worked on Revit Architecture in creating concepts for design

project?
Please select

12) If yes, your previous experiments in creating concepts in Revit

Architecture were....

Successful
Successful to some extent
Had some difficulties
Failed

13)

If you faced some difficulties in using Revit Architecture, what
are those difficulties? Please list them....

14)

Have you ever created a pure geometry in Revit Architecture?
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such as Sphere, Cube, Octagon, pyramid... etc?
Please select

15)

If yes, What geometries did you create before in Revit
Architecture? (Please list the geometries that you created)

16)

Did you create this/those geometry/ies for design concept?

Please select

17)

If you answered NO, why did you create it/them?

18) Do you expect Revit Architecture is able to create those geometries?

Sphere

Paraboloid

Mobius Strip
Right Circular
Cone

Easy to create

Sphere
Paraboloid
Right Circular Cone

Moderate

Difficult

Truncated
Icosahedron
Never

247

Mobius Strip
Truncated Icosahedron

19) Did you work on Rhinoceros before?
Please select

20)

When did you learn using Rhinoceros?

dd
mm
*yyyy

21)

How did you learn Rhinoceros?
College course

Private training

Friend helped me

Training books

Training videos

By myself

Other (Please Specify):

22)

How often do you use Rhinoceros?

Always

Sometimes

Rarely

Never

23)

Do you use Rhinoceros for.....
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College assignment

Job

Fun

Everything

NA

Other (Please Specify):

24) How many hours do you work on Rhinoceros weekly?

0

2

4

6

8

10

More...

25) How do you consider your experience in Rhinoceros?

Beginner
Moderate
Expert

26) Do you use Rhinoceros in architectural design?
Please select

27) Have you worked on Rhinoceros in creating concepts for design

project?
Please select

28) If yes, your previous experiments in creating concepts

in Rhinoceros were....
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Successful
Successful to some extent
Had some difficulties
Failed

29)

If you faced some difficulties in using Rhinoceros what are those
difficulties? Please list them....

30)

Have you ever created a pure geometry in Rhinoceros? Such as
Sphere, Cube, Octagon, pyramid... etc?

Please select

31)

If yes, What geometries did you create before in Rhinoceros?
(Please list the geometries that you created)

32)

Did you create this/those geometry/ies for design concept?

Please select

33)

If you answered NO, why did you create it/them?
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34 Do you expect Rhinoceros is able to create those geometries?
)

Sphere

Paraboloid

Right Circular Mobius Strip
Cone

Easy to create

Sphere
Paraboloid
Right Circular Cone
Mobius Strip
Truncated Icosahedron

Moderate

Difficult

Truncated
Icosahedron

Never
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Appendix G.2
The Results of Pre-Questionnaire
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Appendix G.3
Post-Questionnaire

Post-Questionnaire
Thank you for working on the experiment.
Please answer this evaluation of your experience with Revit Architecture...

1)

Please write down the number of your computer....

2)

Please note that All questions in this questionnaire are only about your
experiment with Autodesk Revit Architecture...
Disagree

Undecided

Agree

I felt comfortable during
using Revit Architecture in
this task.
I enjoyed the experiment
with Revit Architecture.63
I think this software has
made me have a headache
on occasion.63
The information (such as
online help, on-screen
messages, and other
documentation) provided
with this system is clear. 64

63

Software Usability Measurement Inventory, “Software Usability Measurement Inventory (SUMI),”
http://sumi.ucc.ie/index.html. (Accessed January 15, 2011).
64
James Lewis, “IBM computer usability satisfaction questionnaires: Psychometric evaluation and instructions for use,”
International Journal of Human-Computer Interaction 7, no. 1 (January 1995): 57-78.
http://www.informaworld.com/openurl?genre=article&doi=10.1080/10447319509526110&magic=crossref||D404A21C
5BB053405B1A640AFFD44AE3, 31.
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The organization of the
menus or information lists
seems quite logical.65
The software allows the
user to be economical of
keystrokes.63
Shifting among the views
is easy.
The symbols of interface's
icons are related to their
tasks.
I sometimes wonder if I'm
using the right command.63
It is easy to forget how to
do things with this
software.63
Tasks can be performed in
a straight-forward
manner.63
I have to look for
assistance most times
when I use this software.63
I find that the online help
information given by this
software is useful.63
I used other online help
during my work (web site,
videos....etc.).
Error message are
helpful. 66
65

Chin, John P et al.," Development of an instrument measuring user satisfaction of the human-computer interface,"
(Paper presented at SIGCHI conference on Human factors in computing systems (CHI '88),New York, NY, USA,
1988), 213-218, http://doi.acm.org/10.1145/57167.57203
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I like using the interface of
this system. 66
Overall, I am satisfied with
how easy it is to use Revit
in creating the geometry.66

Revit is easy to model any
geometry.
It is fun to use.67
I would not like to use this
software every day.
I would recommend it to a
friend. 67
I expected that Revit was
able to create that
geometry.
I would find it easy to get
Revit to do what I want it
to do. 67
It requires the fewest steps
possible to accomplish
what I want to do with it. 67
The software hasn’t always
done what I was
expecting.

Revit has all the functions
and capabilities I expect it
to have to create the
geometry.
66

James Lewis, “IBM computer usability satisfaction questionnaires: Psychometric evaluation and instructions for use,”
International Journal of Human-Computer Interaction 7, no. 1 (January 1995)
http://www.informaworld.com/openurl?genre=article&doi=10.1080/10447319509526110&magic=crossref||D404A21C
5BB053405B1A640AFFD44AE3, 31.
67
Arnold M. Lund, “Measuring Usability with the USE Questionnaire,” STC Usability SIG Newsletter 8, no. 2,
(October, 2001), http://www.stcsig.org/usability/newsletter/0110_measuring_with_use.html.
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I think I can use it
successfully every time. 67
Revit acts with my action.
I sometimes don't know
what to do next with this
software.
It saves me time when I
use Revit in creating
geometries.67
Using Revit in future
would improve my job
performance.

3)

If you have any additional comments about using Revit
Architecture in creating geometries such as (advantages,
difficulties that you faced during the task, disadvantages, future
recommendations.... etc.), please write them down.
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Appendix G.4
The Results of Post-Questionnaire
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Appendix H.1
Informed Consent
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Appendix H.2
The Announcement Script for the Experiment

Hi everyone, it is nice to meet you today.
My name is Sara; I'm a graduate student in college of architecture.
I came here today to announce my need for volunteers to work on an experiment that is part of my master
thesis.
Let me first ask you: "who of you has an experience in working on Rhinoceros and Revit Architecture
softwares? Please raise your hand". (I ask this question to know how many students have the experience to
work on my experiment).
The experiment that I ask you to participate in is an essential part of my master thesis as I mentioned
before. In my master thesis, I study how BIM applications can work on conceptual design phase which is
an important phase in the entire design process. Knowing the abilities of those applications in that phase
will give designers and architects a clear picture about the appropriate software that is suitable for their
generative design approaches.
This experiment will last about 2 hours and a half. Half an hour for answering two questionnaires, and
other two hours for working on two tasks. In the first task, the participants will work on Rhino, and in the
second task they will work on Revit Architecture.
The volunteers of this experiment should be 19 years of age or over, and they should have an experience in
using Rhinoceros and Revit Architecture. The volunteers can be beginners to experts in using those
softwares. It doesn't matter the level of your experience. The most important thing is that you can use both
softwares. During the experiment, you will be videotaped and your work will be recorded to study your
generative design approaches in using the softwares.
The experiment is voluntary, and the participants have the right to refuse or withdraw their participations
any time which will not affect your grades or your relationship with the professors.
Your participation is important to achieve the goals of that thesis, and it will be a good opportunity to you
to try something that you might not try before.
So, if you have any questions about the experiment, don't hesitate to ask me.... (Try to answer any questions
they may ask.).
(If there are no more questions) Finally, if you want to participate just sign this sheet with your contact
information, and I will contact you soon to arrange the day and time of the experiment.
Thank you so much for your listening and I would like to thank the professor (...) for his/her collaboration
and for giving me this opportunity to talk to you all.
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Appendix H.3
The Email to the Participants

Dear All,
I was pleasure to speak to you the other day, and thank you for your willingness to
participate in the experiment of my master thesis. I am looking forward to meeting with
you on [Date, ex. February 5] at [Time, ex. 11:00 a.m.] in room [Room Number, ex.212]
in Architecture Hall building to work on the project's experiment.
As I mentioned before in my announcement, the experiment includes two tasks. You will
work on Rhino and Revit Architecture softwares in those two tasks. In addition, you will
answer two questionnaires (Pre-questionnaire and Post-Questionnaire). The experiment is
open-book and you may use any written materials, books, websites, online help,
software's help, and videos. You may not use any of your previous Revit or Rhino files or
any stored files on computer, flash drive or any electronic device.
As a reminder again, you will be videotaped during the experiment, and your computer
screen will be recorded. The entire process will last about three hours.
Your attendance and participation are vital to the success of that thesis. However, if you
are unable to attend or you want to withdraw your participation, just email me back. Your
participation is voluntary and you have the right to refuse or withdraw at any time which
will not negatively affect your grades.
I look forward to meeting you. I am certain that you participation will prove productive
results to thesis's goals.
Sincerely,
Sara Ben Lashihar
Graduate Student
College of Architecture
University of Nebraska-Lincoln
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Appendix H.4
IRB Project Approval Email

From: ……..@unl.edu (………@unl.edu)
To: …….@yahoo.com; …….@unl.edu;
Date: Tue, February 15, 2011 9:45:13 AM
Cc:
Subject: NUgrant Message - IRB Project Approved
Your project has been approved by the IRB.
Project Title: BIM Applications in Conceptual Design Phase: Exploring the Abilities and
Limitations of Revit by applying Generative Geometric Design Approach
Approvers Comments:
Ms. Ben Lashihar and Dr. Hemsath,
Your project has been approved. You are authorized to begin data collection.
1. The approved informed consent form has been uploaded to NUgrant (file with Approved.pdf in the file name). Please use this form to distribute to participants. If you
need to make changes to the informed consent form, please submit the revised form to the
IRB for review and approval prior to using it.
Your official approval letter will be emailed to you and uploaded to NUgrant shortly.
Good luck with your research!
Becky Freeman
000-0000
…….@unl.edu
===============================================================
This message has been sent to you through NUgrant. To view project/form you can click the link
below.
If you have any NUgrant questions you can contact nugrant@unl.edu for help.
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Appendix H.5
The Instructions of the Experiment in the Confirmation Method

Experiment duration: 2 hours
________________________________________________________________________
Instructions to Participants
Please read carefully these instructions and the tasks' requirements:
•
•

•
•

•
•
•

Please don't communicate with other participants during the experiment.
If you wish to leave the room temporarily or leave the examination early you must
indicate this to the supervisor.
If you have any question about the experiment or any technical problem in the
computer, please ask the supervisor.
The experiment is open-book and you may use any written materials, books,
websites, online help, software's help, and videos. You may not use any of your
previous Revit or Rhino files or any stored files on computer, flash drive or any
electronic device.
Please don't turn off Camtasia or Mouse torn softwares during the experiment.
You can use this paper for your manual sketches or calculations.
Please try to work on real building scale.

This experiment is two pages long. It consists of two main tasks; the first task will be
done by Rhinoceros, and the second task will be done by Revit Architecture 2011. Your
job is to create the listed geometry in each task by using the indicated softwares. If you
need any information about the instructions and the tasks please ask the instructor.
You will not be penalized if you did not complete the task or did not create the required
geometry. It is not an examination, it is study's experiment.
At the end of the experiment, please save your file at folder: Computer>Thawspace.
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Rhinoceros Task:
- The used software: Rhinoceros 5.0
- The maximum time of this task duration: 60 min
Please try to create the geometries that are pictured below using Rhinoceros. The
provided information will help you to understand the mathematical rules of that
geometry.

68

Triangular Prism
Prism is consisted of two identical
shape parallel sides (triangular,
circle, or irregular shape). "A
prism is called triangular,
rectangular, etc., depending on
whether the bases are triangular,
rectangular, etc.”(SpringerLink
2001)

Right Circular Cone
Right circular cone is a part of
Cone geometry. Any oblique
plane can cut the cone into
other geometries; the upper
part is called Oblique Circular
Cone, and the lower part is
called right Circular Cone.

Mobius Strip
The Mobius strip, also
called the twisted cylinder,
is a onesided nonorientable
surface obtained by
cutting a closed band into
a single strip, giving one of
the two ends thus
produced a half twist, and
then reattaching the two
ends.

70

71

69

72

68

"Hair Band clip art," Clker, http://www.clker.com/clipart-24184.html (accessed December 11,2010).
“Prism,” iCoachMath, 2011, http://www.icoachmath.com/SiteMap/Prism.html
70
Florida Center for Instructional Technology, “Conic Section Showing An Ellipse,” Clipart ETC,
http://etc.usf.edu/clipart/47200/47257/47257_conics_1.htm
71
Eric Weisstein, "Mobius Strip," Wolfram MathWorld, 2011, http://mathworld.wolfram.com/MoebiusStrip.html
69
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Autodesk Revit Architecture task:
- The used software: Autodesk Revit Architecture 2011.
- The maximum time of this task duration: 60 min.
Please try to create the geometry that pictured below using Rhinoceros. The provided
information will help you to understand the mathematical rules of that geometry.

68

Triangular Prism
Prism is consisted of two identical
shape parallel sides (triangular,
circle, or irregular shape). "A
prism is called triangular,
rectangular, etc., depending on
whether the bases are triangular,
rectangular, etc.”(SpringerLink
2001)

Right Circular Cone
Right circular cone is a part of
Cone geometry. Any oblique
plane can cut the cone into
other geometries; the upper
part is called Oblique Circular
Cone, and the lower part is
called right Circular Cone.

70

Mobius Strip
The Mobius strip, also
called the twisted cylinder,
is a onesided nonorientable
surface obtained by
cutting a closed band into
a single strip, giving one of
the two ends thus
produced a half twist, and
then reattaching the two
ends.

71

69

72

72

“Mobius ladder on Mobius strip,” Wikipedia,
http://en.wikipedia.org/wiki/File:M%C3%B6bius_ladder_on_M%C3%B6bius_strip.svg

